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Using this Manual: Begin reading here!

Don’t let this User Manual’s size intimidate you. It is not bad as it might first appear!

Start out by reading these very short sections. They will save time and confusion when first using LandStar:

Operating System Optimizations 13
Keyboard tricks 13
Entering distances 14
Entering Azimuths/Bearings 14

General System and program settings like display formats, units, significant decimal places, GNSS survey and stakeout
default settings:

LandStar 8 System settings 19
While the Tool tray icons meanings are not obvious, they are important for many survey functions like offset staking and .
hidden point measurements:
Tool tray 43
Next read the task oriented How To Quick Guides in the back:
How to: Install, Update and Provision LandStar 223
How to: Moving data to the data collector 227
How to: GNSS Network Rover Internal Cell Modem 229
How To: GNSS Network Rover PDA Modem 234
How to: GNSS Internal UHF Base 238
How to: GNSS Internal UHF Rover 242
Detailed references for the four Main menu tabs are color coded:
Project 63
Survey 95 -
Config 167
Tools 183 e

These functions are often needed, but hard to find:

Plot Deed enter a metes-and-bounds survey description convert to points and lines:
Details: Tools (tab): Plot Deed 201

CORS and Base shift functions adjust autonomously surveyed points to an OPUS solution:
Details: Survey (tab): Base shift and CORS shift 151

Backup everything (settings, profiles, projects, geoids) to a single file, transfer to new device:
Deployment backup and restore 20
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Installing and Activating LandStar8

LandStar 8 is a 64-bit Android application.

It should run on any Android device with Operating System Android version 7 or higher, however users may be
disappointed with Android OS versions older than version 10.

The LandStar application should automatically adjust to most screen sizes.

For use with a visual receiver, like the CHC i89 and i93, verify Visual Survey operation prior to deployment with a new
device or use dealer recommended hardware. Visual survey functions require 5 GHz Wi-Fi and are enhanced by high
resolution displays and high-speed processors.

Downloading and Deployment

LandStar 8 is too large to distribute in Google Play.

A distribution manager is used to distribute LandStar. The distribution manager will also update LandStar to the latest
version.

It is also possible to download the program APK from a trusted source. See [ Direct download from iGage.com
] on Page 223 for an example.

In Google Play, search for CHCNav. Look for the CHCNav Installation Manager:

B This devion »

<

The publisher’s name will be ‘Shanghai Huace Navigation Technology Ltd.’
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Once the manager is installed, open the CHCNAYV Installation Manager:

4" LandSiar }

= GNSSTool s
Wi ST
N R e
PEE J
[ T ] T Ay
Wmpd lyimash s g
Click on the LandStar button and follow the onscreen instructions.

If LandStar is already installed but a newer version is available, an update to the latest version will be suggested.

Once the download and installation has completed, start LandStar. The desktop icon:

Should be available on one of the device screens. If not, swipe up, find LandStar, click-and-hold then place a shortcut
anywhere on the device desktop.

When LandStar runs the first time, the following permissions may be requested:

Camera needed to read QR codes containing projection information. Required to take pictures to attach to
points as media.

Files needed to store projects, import/export files.
Location needed to use the internal data controller GPS for position.

Music, audio  needed to voice information during collection (Fixed, Float, Connection lost).
Nearby devices needed to connect to GNSS receivers by Bluetooth and Wi-Fi.

Notifications  needed to notify when running in the background.

Phone the IMEI number of the cellular radio is used for device identification.
Photos, Videos needed to store and attach media to measurements.
LandStar may not be able to run if any of the requested permissions are denied.

When LandStar runs the first time, it will notify you that there are no localization files in use. Click on the appropriate
package (in the USA select ‘United States’) to download and install one. The localization packages include projections
and Geoids.

LandStar 8 Licensing

LandStar 8 will run in demo mode until it is activated. Most functions other than connection to a GNSS receiver or Total
Station are available in the unlicensed Demo mode. It is possible to use an unlicensed demo copy to process Visual
surveys and import and export work products.
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30-day trial licenses are also available by self-service, see [ Self Service demo activation ] on Page 9 for step-by-step
instructions.

To permanently activate LandStar 8, buy a Registration Code (formally called a Precode) from an authorized dealer. The
Registration Code can only be used on one device at a time. A Registration Code can only be deployed on a lifetime total
of 5 devices; however, the code can be freely transferred between these 5 devices an unlimited number of times. The
Deployment Backup and Restore tool [ Deployment backup and restore ] described on Page 20 makes transferring
entire deployments by a single file possible.

Click on the profile head D at the top-left corner to display the System settings panel. Drag the panel up and click on
Activate software/About at the bottom of the left menu:

ik 1o kogen

ok ST & OO

Warn il Hase
pharges ﬂ'

£
[ (L]
.-'l'n
T LoraMaation jLscs s =
Herond b
asies g
=3
FWalin) hell L apsry
SR wiien feelp
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Finz ot Eaurs
Hnl-\.@
=
Aitin e rzfw e Al I.: ——
TRA—
Click on the Inactive link:
s
iut s b
AcTivutu
fielonre naotey >
Check for wpdmn >
N e alisTal

If you have an existing account, click on Existing account at the screen bottom, you need only enter your email address
there is no need to fill in details.

If LandStar has not previously been registered, click on Activate by email, fill the requested information, then click on
Register:
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If registering a new account, after clicking on Register:

Succesziul registration
Check your emal o sotivale
oiar BCrount.

Check your email, click on the link in the email to complete the account activation process.

An email address is needed so that notices of license transfers can be sent when a license is released. Your Company
name and Phone number are needed to aid in troubleshooting license transfer issues.
Activating a Permanent Registration code

After activating by email, enter the Registration Code (previously called PreCode):

Click on the Apply button to the right of Permanent registration code:
Peiffiiienl Do |: I:.:-l: :l

Then enter the Registration code:

Efilisi & pasiiiafviHil iegiatsalioe
oo

Cance

Click OK. If the code is not installed on another device, LandStar will be activated.

Self Service demo activation

LandStar8 Demos expire after 30-days.

After activating by email, click the apply button to the right of Temporary code:
Fiitiecauiiy il

LandStar will contact the server and bind a 30-day demo code for your device.

Don’t neglect evaluating the demo as it is VERY difficult to extend a demo on a device and it is difficult to do multiple
demos associated with the same email address.
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Transferring a registration code license to another device

A LandStar license can only be activated on one device at a time. A purchased license can be transferred to a total of 5
(five) devices over the registration code’s lifetime. Please be careful when using transfers to not needlessly waste them,
only five are possible.

Consider using a demo code to evaluate new devices.

IMPORTANT

Before transferring LandStar to a new device, consider backing up EVERYTHING to a single Deployment backup

file. These Deployment backups include all settings, instrument profiles, existing jobs.
See [ Deployment backup and restore ] on Page 20.

To transfer a license to a new device, on the device that currently holds the license, verify that it has internet

connectivity, then go to the side menu by sliding the menus all the way to the right:

-

I Click io login
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Click on Activate software/About
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|

ctrvate software/ Abost

CHiwN

| Hebeasn mates >

| Chack o updats >

CHCHN.AV
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Click on Activated. The license dialog is shown:
& TORALE7 - AcllvEls ahip

Pafiringi oo

| Tempany cos

Click on the Unbind license button, then wait.

After a few seconds you will see Unbind successful.
Job- 202307270545

Temporary code

Permanent coce { peree >

The license server will send an email with a copy of the Registration code, verifying that the license is available to move
to another device. The Registration code can now be transferred to another device.

If a device is destroyed or lost while a Registration code is bound to the device, get a picture of the damaged device
showing the device’s serial number, and a copy of a police report if available. Then contact your dealer. You will need to
fill out a certification that the device is lost, retired and will never be in service again. The factory will need the original
Registration code and the email it was associated with. It may take a day or two for the license to be released.
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Operating System Optimizations

After installing LandStar, make the following operating system changes to prevent LandStar from freezing or losing
permissions when running in the background, or after a few weeks of non-use.

infao

Click and hold on the program icon on the desktop, then click the @ App App info button:

Under Permissions, disable Pause app activity if unused:

Fause 00 sctvity If

unusad

a»

This will prevent the operating system from automatically removing permissions and cached files if LandStar is not used
regularly. The removal of some permissions may result in LandStar being unable to start.

Under Mobile data & Wi-Fi enable background usage of mobile Background data and Unrestricted data usage:

Background aata

Unrestricted data usage

«©

Under App battery usage change battery usage to Unrestricted. This allows LandStar to continue to communicate with

receivers and devices when another application is opened or while using the phone:
- Apo battery umage

LandStar

Unrestrictad

Optimized

Hestncted

Keyboard tricks

The Google keyboard GBoard is highly recommended for use with LandStar. GBoard can be downloaded and installed from
the Google PlayStore if the device has GMS (Google Mobile Services).
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When entering a field that is primarily numeric, a numeric keyboard like this may be shown:
1 2 3 -
4 5 & s
7 8 9 &
' 0 -

If you need to click a letter (like ‘m’ to switch a measurement to Meters), click on the space button:

o

and the keyboard will expand to alphanumeric entry:
B P oo 5 ¢ ¢ ¢

Unit override is commonly required when the Project Horizontal distance units are set to Feet to enter a metric survey rod
height like “2m”.
3-button navigation
Enabling soft buttons on the bottom of the screen:
¥ L ]
will help navigation through large entry forms as there will be a dedicated key to collapse the keyboard.

Turn on the bottom navigation buttons from the Android setup by searching for 3-button navigation which is under System
> Gestures > System navigation.

Entering distances

A project always has current Horizontal and Vertical distance unit settings. (Some USA states define Horizontal distance as
US Survey Feet and Vertical distance as International Feet.)

Override the current default units by appending a letter to a distance:

2642.54i force International Feet
2642.54f force US Survey Feet
2.06m meters
20.14c 20 chains 14 links
Distance can also be entered as the inverse horizontal distance between two points. For example:
1001,1002 the distance from point 1001 to 1002
1001,1002/4 Y% the distance from point 1001 to 1002

Entering Azimuths/Bearings

In the USA, for both rectangular and metes-and-bounds surveys it is common to describe courses by Quadrant Bearing
angle and distance.

Because it is difficult to compute the reciprocal of azimuth angles in Deg-Min-Sec.sss, Quadrant Bearings are commonly
used where the angle is described as the angle East or West of North or South. This has the benefit of just exchanging the
N/S and E/W to describe a line ‘going the other way.’

CHCHN &Y 14 LandStar 8 User Manual



HW:\ | NE
L

3 2
W SE

The blue vector above describes a course:

336 536.11 degrees 423.542 feet
In the United States this course is described as:

N 023:54:23.89 W 423.542 feet
Reversing the direction is simple, just exchange the first direction N with S and the trailing W with E:

$023:54:23.89 E 423.542 feet

Note: most users specify bearings to the nearest arc-second; however, when working with long distances or many courses,
many significant digits of seconds will be needed to carry angular resolution to exactly match distant coordinates.

If Bearing is selected under Software settings, then Quadrant Shortcuts can be used:
NE=1 SE=2 SW=3 NW =4
to enter a bearing. For example:
entering: 423.542389 results in: N 023:54:23.89000 W
The first character”4” is the quadrant shortcut.

If Bearings are selected in the System Settings for direction entry, you can override bearing entry with an Azimuth by
adding an ‘a’ for azimuth:

274.4512a => N 085:14:48.0000 W

Direction from Existing Points

When entering an Azimuth or Bearing, use any two points as a direction reference by putting a ‘,' comma between the
point numbers:

1001,1002 bearing from PN 1001 to PN 1002

It is also possible to include simple math operators * / + - to build angular equations:
1001,1002+90 add a right-angle turn right to the bearing from 1001 to 1002
1001,1002-90 add a right-angle turn left to the bearing from 1001 to 1002

Entering / Viewing Geographic and Projected Coordinates

The following discussion is intended for users in the Unites States of America. It will have limited application to users in
other regions.

Geographic coordinates are unprojected coordinates, typically expressed in Latitude Longitude Height or Earth-centered-
earth-fixed (ECEF) coordinates. Coordinates also have a reference frame realization with an EPOCH date.

NADS&3 2010.0000 is a plate fixed realization for North America. For NAD83 we express a point’s Geographic coordinates as
the point’s position on a specific date (EPOCH January 1, 2010) which is in the past. Even if the point moves because of
crustal motion, the position is constant because it expressed on a date before the motion occurred.

WGS84 is a general grouping of several realizations. ITRF 2014 (EPOCH:xxxx.xxxx) is the current realization of WGS84 used
in the USA and is generally expressed with a fractional year measurement-date making the coordinates dynamic. In other
words: WGS84 / ITRF dynamic coordinates change slightly every day.

An example of a fractional year EPOCH date is August 19, 2023 12:40 which translates to 2023.6315.

Prior to the NGS using ITRF2014, IGS08 was a commonly used realization in the USA. There have been many other
reference frames in widespread use over the years and by different geospatial communities.

There is a variable offset between ITRF2014 and NADS83 based on location and time. In the USA, the NGS tool HTDP
(Horizontal Time Dependent Position) tool is used to approximate the difference at a location, for a specific time. (See
https://geodesy.noaa.gov/TOOLS/Htdp/HTDP-user-guide.pdf for additional information on HTDP.)
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https://geodesy.noaa.gov/TOOLS/Htdp/HTDP-user-guide.pdf

You have probably seen both Latitude-Longitude-Height and Earth-center-earth-fixed coordinates, with both fixed plate
NAD83 coordinates and dynamic ITRF coordinates on NGS OPUS solution reports. Here is an example:

REF FRAME: NAD_83(2011)(EPOCH:2010.0000) ITRF2014 (EPOCH:2023.6315)
X: -1587260.290(m)  ©.004(m) -1587261.270(m)  ©.004(m)
Y: -4561961.646(m)  ©.014(m) -4561960.346(m)  ©.014(m)
z: 4153956.508(m)  ©.600(m) 4153956.384(m)  ©.800(m)
LAT: 40 53 8.48450 0.008(m) 40 53 8.50067 0.008(m)
E LON: 250 48 55.76674 0.008(m) 250 48 55.70899 0.008(m)
W LON: 109 11 4.23326 0.008(m) 109 11 4.29101 0.008(m)
EL HGT: 1714.481(m)  ©.010(m) 1713.716(m)  ©.010(m)
ORTHO HGT: 1728.614(m)  ©.065(m) [NAVD88 (Computed using GEOID18)]

The left-hand column has NAD83 plate fixed coordinates, the right-hand column has ITRF2014 EPOCH 2023.6315 dynamic
WGS84 coordinates. The top 3-lines have ECEF coordinates, the bottom 4-lines have Latitude-Longitude Height
coordinates.

Two heights are shown for the NAD83 position: an Ellipsoid Height and an Orthometric Height. Only an Ellipsoid height is
shown for the right-hand column ITRF2014 coordinate. Ellipsoid heights are generally combined with Latitude Longitude
coordinates. GNSS receivers measure and report Ellipsoid heights.

Orthometric heights are derived from GNSS collected Ellipsoid heights using a GEOID separation file. Orthometric heights
also have an associated vertical datum. In the example above GEOID18 was used to compute the Orthometric height and
the result is a NAVD88 approximation.

It is important to remember that in Ellipsoid space, water does not necessarily flow downhill. The GEOID separation file
includes the effects of gravity so that in Orthometric space, water will flow downhill.

In LandStar, projected coordinates (Northing and Eastings) are always entered, grouped, and shown with Orthometric
heights:

Fie=mnisin R ROE 1N

Geographic coordinates (Latitude and Longitude) are always entered and shown with Ellipsoid heights:

e Lt A0S20% B30 N

o QAITTOW

20 747 \mN
rlagmaced)

GNSS Base receivers are always loaded with the Ellipsoid height of the antenna L1 phase center.

Because the transformation between Ellipsoid and Orthometric heights requires a Geoid difference, LandStar will request
that a Geoid file be selected if an attempt to load a coordinate system is made without a Geoid:

ookl

N U “

=

When presented with this question, always pick the current GEOID file applicable to the project location (GEOID18). Do not
proceed without loading a GEOID or LandStar will be unable to convert from Orthometric heights to Ellipsoid heights and
Orthometric heights will be replaced by the Ellipsoid value. No additional warning will be given.

In the USA, because CORS Servers and local bases are nearly always configured with NAD83 2010.0 coordinates, there is no
difference between WGS84 and NADS83 Local coordinates.
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There is no ‘built-in” datum transformation in any of the USA predefined coordinate systems:

i Tesid-Coordinmie sysism

e CLk IRALCINT LEgh Fisi G009
Prigeciion oy sfusir
Ty &in irAsaSoraanm -

Trorm

] Fapmt S5EF KXY T -

P

=T T EH

In other (non-USA) locations, there may be 7-parameter or Helmert translations defined in the coordinate system
definitions. For these areas, GNSS Bases are initialized with WGS84 coordinates, and the coordinate definition includes a
transformation to place the Rover coordinates on a local datum or reference frame.

When using LandStar in the USA, there is no difference between the Local and WGS84 coordinates. Thus, WGS84
Lat/Lon/H coordinates will EXACTLY match the Local Lat/Lon/H coordinates.

When looking at a surveyed point or entering a base position several possible formats are available:

i aae ] Looml KTy -

LY

WGS84 Lat/Lon/H Ellipsoid Height
WGS84 ECEF X/Y/Z Ellipsoid Height
Local Lat/Lon/H Ellipsoid Height
Local ECEF X/Y/Z Ellipsoid Height
Local N/E/Elev Orthometric Height

Normally Local Northing, Easting, Orthometric elevations will be best for Storing and Staking points:

Guditp  Afribrien Bl

Gl b | [+ ] “

Format  Loabe WAL By
hoim o) BBHGEE 29 LG
East [F]  TAEO0D A L)
Elmantion Bkl 0 LEIT

GNSS bases are best configured with Local Latitude, Longitude, Ellipsoid Height coordinates.
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Using OPUS Solution positions to start a Base
If starting from a NGS OPUS solution, favor a Geodetic (Latitude, Longitude, Ellipsoid Height) position:

REF FRAME: MAD 83{2001){EPOCH: 2810, Ho0d) 4§
X: -1587260, T68(s)  0.811(w) -1587
¥: H561961.616(m)  0.815(m) 8561
) 4153956 649(m)  @.B1E(m) 4153
LAT: 4@ 53 B.48522 a.eezimifa) 4@
E LDN: 2358 &8 55%.74704 a.88%(m) 258 48 5
WLONW: 189 11 4.25296 a.005(m (b)) 189 11
EL MGT: [c) 1rid.671im) @.023(m) 1
ORTHD HGT: 1728.884(m) @.87%(m) [NAVDEE (Compu

The best measurement entry format is:

] Vi Brt] T e [oad i

Aersena type
s bl -
LRt PR =y ]

B BT L -
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| P
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Lol L

|
|
|
||_..,_
|
|
L

=i s m ez i @)
-l S TeTT

Lot L
1o Fwew )

L ATTH R

Lirsat H {wfhpmmet
irdarin ] o

If working in US Feet or International Feet be sure to enter an “M” after the Ellipsoid Height, as shown above, Elevations
are always in Meters on an NGS OPUS solution.
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LandStar 8 Program folders

LandStar stores program data in two places on the Android device. The primary folders are:
\Internal shared storage\CHCNAV
\Internal shared storage\system_prj_backup

Within these folders there are several addition folders:

\Internal shared storage\CHCNAV
\Cache OEM, Mainboard firmware for GNSS devices
\Config Fonts, Codes, Geoids, Prisms, Working modes, Coordinate systems
A\Download files downloaded from the Cloud
\Projects  Projects, each project is stored in a folder

Projects can be continuously backed up to the folder:

\Internal shared storage\system_prj_backup
within this folder there will be a separate folder for each job. Within the job folder there may be multiple ZIP files
containing snapshots of the job. These previous versions can be restored from the Project menu. See [ Project backups ] on
Page 64 for additional information on Project backups.

LandStar 8 System settings

From the Main menu click on the Side barD button in the upper-left corner. This shortcut button allows quick access to
System and Software Settings from any of the main menu tabs.

b kg

It is also possible to directly view the Side-bar by clicking the Tool tray (&) Gk access Quick access button allowing access
to System settings without leaving most survey menus.

The System settings panel provides access to Software settings (a sub-set of the System settings), interface styles and
program defaults.

Side-bar details

See [ Software settings ] on Page 28 for details on Software settings.
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Deployment backup and restore

= Depioyren backup and
" rERioim

Deployment backup archives all the:
e  project groups
e  projects
e  landStar settings
e  Device and Instrument profiles
e Menu item positions
e Import and Export profiles
e GEOID Files
e defaults
e map tiles
e  pictures
e  Visual survey jobs
e  Plus everything else...

to a single compressed file. This single file can then be moved to a different device and restored.

If provisioning a new device, read about License transfer here [ Transferring a registration code license to another
device ] on Page 10.

From the Side-Bar click on Deployment backup and restore.

L, [k 1o fagin
|
Ty gt opEerl e
Heipili
= Solwals wEtngs

= Debphoyveuind Dathay Sl |

{ "= rasnare -

g Mmiarloce Gyl

Llaiaa e Fowtts

The Backup list of existing deployment backups will be shown:
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Click New to build a new backup:

Hama

AT T [ ]
EA Lk mE{ias arire aetinge '

B kup peojects [ |

Give the backup a descriptive Name, choose to Backup application settings, choose to Backup projects.
Then click Next.

wiluites- Backup
E Sebae wi
| Evifaialy AL
14 3= Lo mE Rt |
LRalfar 1t SSALD% |G

. BN
franesesia -

Check all of the Project groups to backup or Select all to include all Project groups.
Finally click Start backup:

J

Hacking up

Depending on the size of the projects the compression could take a long time (over five minutes.)

After the backup completes, it will be listed in the Backup list:

LandStar 8 User Manual 21 CHC W&



Slide the backup entry to the right:
% soame-Backup [ 1]

to reveal: m Delete, Information, Cloud, Eshare, L Restore.
When the backup is complete, the resulting file will be placed in the folder:
.\Internal shared storage\system_prj_backup

It will be named:

settings07212023-20230921125156-Config-Projects.szip
the entered Name followed by a hyphen and the date, time and included components. The file will have an .szip extension,
however it is a standard ZIP compressed file.

Use the m Restore from file button to open a backup that has been transferred to a random location on the
device, typically the Download folder.

Interface style

o it Tca wiyls

midd dlim

LandStar has two interface styles:

e
E 8 ¥ 8 = =
oty Courtmats Srgw ot Fromcts Cormecton  lrmtrume
sytern reLateaton
YoluIme
‘ e ©
r
s <~ 4 Dats Survey
Poeens Crades Lisyors
- =
“« @ % e |
v
mpon Capan fartaces o
. o Export
- = @’ Stakeout
Fratares Lires Aoy mages N
cAD
4
] - ¢
Rros More X Tools
= Loordingle Viedurm
= Vi -
Halem = wrurees
Classic Simple

The Classic style has 4 tabs: Project, Survey, Config and Tools. Menu buttons can be hidden under the — More button. The
Simple style has one primary menu which expands primary functions to lists of functions. Both menu styles can be further
customized by modifying button positions and hiding entire functions.

This User Manual shows only the Classic style interface.
Audio prompt

) Audic promgl

o=
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Audio prompts for events like Fix, Float, Autonomous, Connection, Disconnection, Receiving NTRIP data can be disabled,
announced with a Ding or Voiced:

£ s

St

Warn if Base changes

Vawrn i Base
PR .:

Enable to issue a warning if the broadcast position of the current Base changes. This can happen if there are two bases on
the same UHF frequency, or if the network generates a new base after a GNSS rover makes a substantial location change.

My cloud disk

by cleud disk

Collaborative functions in LandStar 8

The CHC Cloud is a cloud based, collaborative work group and storage function. Operation relies on communication with a
selectable server based in Europe or Asia. The services are SSL encrypted; however unencrypted files are stored on the
endpoint servers. For this reason, cloud services may not be suitable for confidential work.

If LandStar is not currently logged into the CHC Cloud, clicking on any collaborative function:

Ry ol gk
| @ Collsbomove work
¥ Gazas
Uplond pomton
HET L]

will request a login to the cloud service:
Liigin i SWS verildabion coils

<A

Click on Change server:

Change serves
e
Lirisim Savved -

[ ]

ci L Ch Mg Eom
Poorif

il

Cancal
- 1 a

Change the server to the European server. Then click OK.

Click to Login and use Cloud services.
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Storage

The following predefined storage locations are available from the CHC Cloud:
& wburese- My chooed dlek

Projects ¥
Imepart files >
Enpcet files »
Cocrdinale syslama 3
Coates liemry

Hoad filen ¥
Hane astegs

e wetlings ¥

I
Web interface to CHC Cloud

Login to the CHC Cloud web interface for access to files from a desktop:
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Crew mapping:

Collaborative work Group using CHC Cloud

5 Cobaboratien work

Ciemm

Once logged into the cloud, LandStar Workgroups can be created or joined.

Workgroups share a common file repository where Projects, imported files, exported files, custom Coordinate systems,

Code libraries, Roading files, and Base / Rover configuration files can be stored and shared.

Workgroups are assigned a unique Group ID by the server when they are created and are protected by a Password:

S in

Upload position to CHC Cloud

o Ul pegrinn
BaiiTe]

Uploads GNSS position By Distance or By Time to the CHC Cloud:
ECH e D [

| m@yrma [ By damanoe
neraal

T Gerered

|
Canical

The uploaded position can be viewed in real-time via the web interface.

LandStar must be logged into the CHC Cloud to use this functionality.

Localization packages

B | scallzaisn paciapes

Localization packages can hold region specific Geoids, profiles, and projections.
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15 Localization pookages

i e
- l'-'-':ll"-ulri
= J_l.|_|-_‘|!..
- Scatupal
m| T

[ ] Ry

For the USA:
‘ imdl Sanes

Click on t_h_e . ___I_D_O\{\_/rll_c_J_a_c_I_t_)ytton, then confirm YES:

Lrre-iaad the Lo cabion
Far Lage !

Pl

Depending on the speed of the
Crirmenhosisiang

i

= -

internet connection it could take a while for the download to complete:

When the download is complete, the package file will automatically be decompressed and installed.

Record track

s« NMrecied Tace
= e——

Enable to continuously record the GNSS position to the local device:

f
R 11k L

| i frm i By ritrwrey

niioreal
E G
|

Cancal
k

A .CSV file named with the year, month day, hour, minute:

YYYY-MM-DD HH-MM-SS.

is created in the project folder:

csv

/storage/emulated/0/CHCNav/Projects/_projectname_/

Each line entry includes:

no., latitude, longitude, H, East, North, elevation, time

The first line of the file includes

CHCNAY

a header description of the file contents.

26 LandStar 8 User Manual



Video Help, show video help button
B Video help

B widen help
= T Mzl Basllinh

In some regional markets, extensive recorded video collections are available for context sensitive video help.

When Show video help for float button is enabled, one of these icons will be shown on most screens:

od
Feedback

Feadback

Click on Feedback to send suggestions directly to the LandStar developers:

Remote support
o Remote suppor

Allows access to the built-in remote support application.

Activate software / About

1 At tbeirhe wert e bl

Displays the current software version and allows access to the licensing activation and transfer tools. See [ LandStar 8
Licensing ] on Page 7 for more information.
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Software settings

Click on Software settings. The device settings menu is shown:

jebs- IO BOT 1810370

Keyhicard shor=i b ]
s e ¥
i [
LS

Demtarriid i b ]
Cogdtinghes b ]
M= »
T

Thegdey perenge. >

Each of these setting items is described below.
After making changes to the settings, click Save as default if you would like the modified settings to be used when new
projects are created.

Keyboard shortcut

[T
Laam _
Prewimun paink

Fitital [ 1]
Maad poamd

3

If a device has hardware buttons, functions can be assigned to them. The assignable buttons will be a subset of these:
NONE, Enter/OK, Volume Up, Volume Down, Left, Right

Share method

Sragrr metiinad

Shuss pn Aewrci syme b tan '

Set the Share method to Share by Android system function unless the CHC Cloud will be used.

See [ Collaborative functions in LandStar 8 ] on Page 23 for additional information.

Auto Ok

Mgt Ok L |

Enable Auto Ok to save keystrokes as you use LandStar. If you have difficulties with accidental tapping, or want to manually
approve all changes, disable Auto Ok.
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Units

Controls the display, accepted input and units used in LandStar:
Woluimalemo-Unis

Aregie

a1l I B wNERANE

A pirvagth dinpday mede
FBaarng
Bgrradit gt s
2] AR
LEULO g el
3l ridtmanEes
Litilon disphdy misie
Sl ritm e EEEw
thirtroetad detance
Pl L sey
Veriical divtenrs
Team (LIRS sy )

LILLES

Errey

Wilusie unil

Tubare W

Slatiom

5000 N

Angle
Sets the display of Angle values:
Angis

e “rroming. ey |

ORIV N NNEEEES |

Tl | o

Set to dd:mm:ss.ssssss for operation in the USA. The GONS alternative is used in Europe.

Azimuth display mode
Set the method for directional display. When set to Bearing allows the use of Quadrant bearings.
Azimuth dsplay mosde

Farmal

Tearng

Set to Bearing = Quadrant Bearings (USA and Canada); Normal = Azimuth.

Azimuth input mode

Set the method for directional inputs:
Aximuth input mode
di e w8 EREE

AN R T T

dd.mmssssss (USA) allows quick entry with a single decimal point. If Azimuth display mode = Bearing, then also accepts
Quadrant shortcuts. See [ Entering Azimuths/Bearings ] on Page 14.
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Lat/Lon input mode
Determines the required entry type for Latitude and Longitude:
: LatiLon input mode ]
] PP R NN

il TR
Use dd.mmssssss (USA), DD:MM:SS.ssss requires the inclusion of " separators.

Lat/Lon display mode
Set trhe method for display of Latitude and Longitude:

LatrLon display moda
g TR |
ihill FSTL N ek |

LSSk

[= -

Either dd°mm’ss.ssss” or dd:mm:ss.sss are typical in the USA.

Horizontal Distance

Sets the default units for horizontal distance measurements:
Hortmotsl distance 1
WAEETE (Wi |
bl ABusery| |

Ve Oirdiemalianall
& 4

When entering distances, the default units can be overridden with:
i international feet
f  USSurvey feet
m  meters
¢ chains

Vertical Distance
Sets the default units for vertical distance measurements.
: Vartical distenca ]
WS (M) |
Fusat OLEurvey| |

Fosni Oirrimmalicnall
1 - |

Note: Many US States use US Survey feet for Horizontal and International feet for Vertical distances.
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Area unit

Sets the default units for area measurements:
dirma unil
5], WnEts
) Walaw
T LEHH
5 Fu
horen
L]
Eay Wanda
5 1Yt

=l
Typically, Acres or Square Yards for the USA.

Volume unit
Sets the default units for volume measurements:
Wil L unin 1
Lol Msims
Cubhic F1
Cubie LEH
Cube Faitly
Lty L Yairy
et

LIS Alia-lael

Typically, Cubic Feet, Cubic Yards or Acre-feet are used in the US.

Note: the difference between cubic International Feet and cubic US Feet is very small:

10,000.000 cubic Meters = 353.144.55 cubic USFeet = 13,079.428 cubic USYards =
353,146.67 cubic iFeet = 13,079.506 cubic iYards
Station
Sets the default display for alignment stationing, sometimes called ‘chainage’:
Staton

Uwes statian pwetts

K

4

Farmat
000

Cancel
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Where the Format can be:
r
[ TR
o1 B
ML i
(11 1]
HEF] [{EE)
1K

WEE O8

= —

In the USA, stationing is typically shown as 100-foot increments with format K+00.00:
12,345.67 feet is shown as: K123+45.67

Decimals

- Wl Lirres Dhiaim o - Duei mal s

Rraple | fd e BL g aEaE|
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These settings control the number of decimal places used to display values. The settings shown above should be
reasonable for most applications in the US.

Coordinates

Sor
Mash (4, Eatd [E) _

Set the Coordinate order to North, East for use in the US and Canada.
Most other countries and most CAD packages use East (E), North (N).
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GNSS settings

Sraipwn  Sortsos suaked R
Funvery method .
Topograghin Pl sensey -
| Aecarsoy chack
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CAFF age

1 Beend

MAK PDOP

A.000

Enoie Toosd S0ILGHLNS iy [

&gin incremen! name nleosl

Pabirvura i it

These GNSS settings are also accessible from most of the survey menus by clicking the e
separate settings for Topographic point survey, Continuous survey, Control point survey and Verified survey.

Setup button. There are

The available tabs are dependent on the survey method from where Settings is launched from. For example, if you enter

from Map survey then these tabs are available:
Cingley Tosts ikl E-Hubisle

while when entering from Point stakeout an additional Stakeout tab is available:
Stwiwout  Display  Tooks 1M F-Bshible

entering Settings from Surface stakeout adds an additional Surface stakeout tab:

Sk Turfeor ciabdow  Dhpiay  Tesls ) E-Bubbls

finally, entering from the Side menu, Software settings, GNSS:

Highaind  Tuiteee alakwot Bogd  OoresoaeRion pereey

Settings are organized on tabs.
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Survey (tab of GNSS settings)

Topographic point survey settings

i jobe T2 T102F0RT 4 - Seifings
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Topographic points are non-critical GNSS measurements. Typically, speed of acquisition is favored over long averages.
Control survey and Verified survey methods provide for long averages with multiple device resets to generate high
confidence coordinates. See [ Details: Survey (tab): Control survey ] on Page 113, and [ Details: Survey (tab): Verified survey
] on Page 115 for additional information for taking critical GNSS measurements.

i %
LandStar8 has two topographic modes: ¥ Quick (1 epoch) and ¥ Topographic (length set by Measurements) controlled
by the Survey type button on the survey screen. The Quick mode shares tolerance settings with the Topographic mode,
except for the Measurements time.

Horizontal tolerance (HRMS): the highest receiver reported HRMS that is allowed to be stored without user override.
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Vertical tolerance (VRMS): the highest receiver reported VRMS that is allowed to be stored without user override.

Diff age: the longest allowed correction latency allowed without operator override. Normally the latency will be 1 or 2
seconds for UHF and network servers. Values higher than 10 indicate that the communication link is down.

MAX PDOP: the highest allowed PDOP. Usually PDOP’s are less than 2.5, PDOP higher than 3 is worrisome.
Store fixed solutions only: only allow FIXED RTK solutions. Reject FLOAT, DGPS and Autonomous solutions.

Auto increment name interval: after a topographic measurement is made, the point name increments by this value.
Usually, 1 or 10.

Measurements: sets the measurement averaging time in seconds for Topographic mode, typically 5-seconds. Quick mode is
1-epoch.

Pole stability warning: while measurements epochs are collected, if the horizontal range of measurements exceeds this
tolerance, the user will be given a warning and the opportunity to escape and not store the measurement.

Confirm before saving: a measurement summary will be shown at the conclusion of averaging. The user can confirm and
store or escape without storing the measurement.

Use quick codes enables/ disables the Quick code portion of the surveying and stakeout menus.
Quick codes disabled:

1]} |:-
=
Quick codes enabled with 6 Quick code pages:

Fok 2= o

Drich ozde pagrn

Results in this Survey screen with room for 54 code buttons:

4] L)
u i
o

Long-press and hold on a Code button to assign a code. Then click on a quick code button to automatically set the Code
and take a measurement. See [ Quick code panel ] on Page 97 for additional information.

Add matching CAD layer when a new code is entered: when enabled creates a new CAD layer with a matching name to the
new Code, assigned to the measurement.

Prompt when using a new line code will confirm when the code assigned to a line is changed to the previous line code:

B
-4

Log PPK data when enabled assigns start and stop flags at the beginning and end of RTK average measurements, with the
RTK point name, in recorded observation files (RINEX) for subsequent post-processing.
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Show average report after measure displays a measurement report after each measurement that averages more than one
epoch of data:

il Rearge e

Log epoch coordinate adds detailed epoch data for all averaged measurements to the file average-result.avr located
in the Project folder.

Show E-Bubble displays the receiver’s electronic bubble on survey screens. This is only applicable to receivers with an e-
Bubble or an IMU like the i50, i80, i70. 190, 93, i73, i70, i83, iG8 or iG9.

Automatic photographing records a forward-facing photograph and downward-facing photograph using the built-in
cameras on the Visual receiver for every measurement (Survey and Stakeout) attaching the photographs to the stored
point as Multimedia:

Ferreal ity Albh&ains

Depending on the [ Multimedia settings ] see Page 78; the stored photographs will include the Name, Latitude, Longitude,
Northing, Easting, Date and Time superimposed on the lower right corner of the image:

N 349082 MOk LS

F im0 e oo

T30 29 125834
Automatic photographing is only available on Visual receivers like the i89 and i93. The Visual receiver must be connected
by Wi-Fi to the Android device.

Record GNSS Vector adds ECEF Base to Rover deltas, variances, and covariances to stored measurements when enabled.
Enabled this option if you plan to export Trimble .JXL files or RWS5 files. Enabling this option may result in slightly increased
power consumption on the Android device.
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Continuous survey settings
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Continuous surveying stores measurements continuously based on time interval or distance traveled. This can be useful for
storing the centerline of a road from a moving vehicle.
Store fixed solutions only: only allow FIXED RTK solutions. Reject FLOAT, DGPS and Autonomous solutions.

Auto increment name interval: after a topographic measurement is made, the point name increments by this value.
Usually, 1 is used for continuous surveying.

Mode: the trigger condition for taking another measurement.
Time: time interval in seconds.
Distance 2D: Horizontal distance of travel.
Distance 3D: 3D distance of travel.

Distance 2D or delta H: 2D horizontal or delta H triggers.

Control point survey settings
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The Control point survey takes repeated measurements averages, resetting the receiver between groups, waiting for a new
fixed solution. If HRMS/VRMS and group range tolerances are not met, the control survey waits for better conditions. See [
Details: Survey (tab): Control survey ] on Page 113 for more information on Control point surveying.

Control point survey is intended to be used in open canopy on important points. A tripod or bipod must be used for a
control survey as the measurement acquisition will not finish if the receiver moves during the relatively long acquisition
period.

Verified point survey is like the Control point survey, except the Verified survey will continue to run when tolerances are
not met and points can be observed during multiple sessions, on multiple days. The Verified survey allows the user to reject
averaged groups after collection, while Control survey requires that all groups meeting the tolerance limits be included in
the results. See [ Details: Survey (tab): Verified survey ] on Page 115 for more information on Verified point surveying.

A measurement group is comprised of several point averages that are themselves averaged epochs.

Number of passing measurements: measurement groups will continue to be collected until this number of groups passes
all tolerance settings.

Points per measurement group: the number of multi-epoch averaged points per group.

Number of epochs per point: the number of epochs averaged to make a point in the group.

Group harizontal range tolerance: the horizontal range of multi-epoch points in a group must be less than this tolerance.
Group vertical range tolerance: the vertical range of multi-epoch points in a group must be less than this tolerance.
Epoch maximum HRMS: the receiver reported HRMS must be less than this tolerance for epochs to be accumulated.
Epoch maximum VRMS: the receiver reported VRMS must be less than this tolerance for epochs to be accumulated.

Wait after fixed: the receiver’s OEM engine will be reset between each group. The survey will wait for the receiver to fix,
plus this additional time for the receiver to settle down. A minimum of 15 seconds is recommended.

Max PDOP: epochs will not be stored if this PDOP is exceeded. Normal PDOP’s are less than 2.5, so a setting of 3 may be
reasonable.

Percent of Pass: the minimum number of passing points.

Common GNSS Survey settings

All of the GNSS Survey methods share these additional settings.

AUt Inormmant nene Dtervs

nEnw wpe

g PN uts

Dohtie

Auto increment name interval: after a topographic measurement is made, the point name increments by this value.
Usually, 1 or 10.

Create a new code with the same name layer: if the user types in a new code and stores a measurement with the code,
enabling this option will create a matching layer and place the point on the layer.

Log PPK data: write Time Tagging data (the point name) into the static observation file that is being recorded in the
receiver’'s memory.

Show E-Bubble: enables the E-Bubble on the display screen. This is only applicable to receivers with an e-Bubble or an IMU
like the i50, i80, i70. 190, i93, i73, i70, i83, iG8 or iG9.
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Stakeout (tab of GNSS settings)
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The settings on the Stakeout tab of GNSS settings control the operation of the stakeout screens: Point stakeout, Line/Arc
stakeout, Surface stakeout, Road stakeout, Sideslope stakeout.

Point name prefix: prepended to the staked point name. For example, when staking a point name 1001, the stored
measurement after staking the default name for the new point will be “STK1001”. See [ Auto description for staked points ]
on Page 125 for additional information.

Target station as a point name: if staking a line or polyline, use the station along the line as the point name: “K1+12.345”

Display point name, code input box: disable to hide the point Name and Code boxes from the map screen. This results in a
larger map area.

Stakeout tolerance 1, 2, 3: There are three circles displayed around the staked point:

} "fnoclrcn 3

A rieame

-—lvimrwve |
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The outside ring is tolerance 3, the middle ring is tolerance 2 and the solid inside ring is tolerance 1. When storing a staked
measurement, if the current position is outside of the center ring (tolerance 1) a warning message is displayed.

Distance to switch to Visual Stakeout (Near): using a receiver with visual stakeout cameras (for example the i93), when
staking a feature, when closer than the Near tolerance, visual stakeout will automatically switch to the bottom camera on
the receiver.

Distance to switch to Visual Stakeout (Far): using a receiver with visual stakeout cameras (for example the i93), when
staking a feature, when within the Far tolerance, but further than the Near tolerance, visual stakeout will automatically
switch to the forward-facing camera on the receiver.

Auto zoom: the map image will automatically zoom in closer as the measurement approaches the staked point.

Use PDA compass: uses the internal compass of the PDA (tablet) to compute the direction to the target point when
enabled. If disabled, use the GPS track to determine the direction to the target point.

Remove staked points from list after staking: When staking points, it is possible to stake from the Points to stake list, which
is the right-hand column of the Point list:

EXS S i

Enable Remove staked points from list after staking to automatically remove points from the Points to stake list so that
they are only staked once.

Previous/Next skip staked points: all the points in the Point list have an internal Staked attribute. When you stake a point,
the point is marked as staked. Enabling this option will skip staked points when using the Next, Last and Auto nearest

buttons: - . You can still select staked points by manually typing in the point name or selecting from
the Point list.

Stakeout survey points: when disabled only points in the Points to stake may be staked. When enabled all points are
eligible for staking.

Search for the nearest point from the stakeout list only: when enabled, only points in the Points to stake list are considered
when looking for the nearest point. Disable to consider all known points.

Navigation text size: select the smallest size that is comfortable to read, this will maximize the remaining screen available
for map display.

Use auto description controls automatically populated descriptions for staked points. See [ Auto description for staked
points ] on Page 125 for additional information.
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Display settings

ps B =
L o] |
| B Ed
Bash o] Colg [
[Hmjiary | vim malth L1
[ pey o giyks |:-|'_
ligpery ke nodle
= ']
a1 1 mp'pn naswarpmed R T reper—
A e "I.|||"-1'|
P Hiagilion jmasti s b kil
]
i
gl i
AT BT
LTS 1
Liree
Tt i
[bwppitery oy sien whier pois 1

These settings are found under Software settings: Display settings:

Snap Settings: enable snap modes for picking points, lines, centers. These snaps are used in CAD, storing and staking points
from survey menus:

Node: snap to a point

End: snap to the end of a line or vertices of a polyline.
Midpoint: snap to the middle of a line segment.
Center: snap to the center of a circle.

Intersection: snap to the intersection of two lines.
Nearest: snap to the nearest point on a line.
Perpendicular: The point at a 90-degree angle.

Any: allows snapping to an open location anywhere on the map.
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The TwE tool is useful for picking with the Any snap. Click-and-hold on the T

settings. See [ Snap ] on Page 46.

~ tool to quickly modify the Snap

CAD settings

Background color: choose dark or light background colors on the CAD and map staking screens.

Display line width: when enabled the layer or drawing’s line width is honored. If disabled, lines are drawn 1-pixel wide.
Display line style: when enabled the layer or drawing’s line style is honored. if disabled, lines are drawn sold.

Display line nodes: enable to show polyline vertices.

Layers: click on the line to view the Layer list. Additional information is available in the next section.

Display surveyed points: uncheck to hide measured points.

Display entered points: uncheck to hide points that have no GNSS or TS measurement data. These are typically imported,
hand entered or calculated points.

Display points to be staked: disable to hide points in the Stake list.

Points size (without code): display size for points that do not have a known code.

Points color (without code): display color for points that do not have a known code.

Point name: show point names in CAD and map survey. Click the color box to set the color.

Point elevation: show point elevation in CAD and map survey. Click the color box to set the color.

Point code: show point codes in CAD and map survey. Click the color box to set the color.

Line name: show Line names in CAD and map survey. Click the color box to set the color.

Text size: the size of text in Text boxes drawn on maps and CAD.

Display coordinates after point selection: show the N, E, Z of points when they are selected in CAD or for stakeout:
Disabled:

Enabled

GNSS position symbol and color: choose the symbol type, size and color. Click on the symbol to select from these symbols
and sizes:

[
o

Click on the color bar to select a color for the GNSS position display.
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Tool tray

The Map survey, Point survey, Control survey, Verified
survey, Point stakeout, Surface stakeout, Sideslope
stakeout, Area survey and Hydro survey all have a user
defined tool tray that aligns to the left side of the map
panel:
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[ |
b

i © -

The tools in the Tool tray and the tool ordering are fully
programable by the user.
The only permanent tool is the Setup button s .

Clicking the bottom tray button collapses the tray

to the top of the map area. Once collapsed, clicking
restores the tool tray.

If the tray has more tools than can be displayed, drag the
tool tray up or down to view hidden tools.

To configure the tray, click on the Setup button b then
select the Tools tab:
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To add an Unselected tool, click on it in the left Unselected
tray, then click the button to move it to the Selected

tray. The button will move the highlighted icon from
the Selected tray to the Unselected tray.

The tools in the Selected tray can be reordered by click-
holding and dragging them up or down.

Not all the tools are available in all the survey menus, and
some of the tools are always shown when in specific survey
methods.

Add text to map
Ak text

Click on the map, then enter a text screen to add a text
note on the map. The size of the added text is dependent
on the zoom level when the text is added.

Attributes
Aftnbuies

View the attributes of the currently selected object (point,
line, polyline, alignment.)

CAD view
E:J CAL vl

Switch directly to the CAD view. This is the same action as
clicking the CAD view main Survey menu icon:

2

ALY whivi

After using CAD view, clicking back will return to the
previous survey menu.

Center GPS position
;::Cel-r.nr

Continuously centers the map at the current GPS position,
when enabled (orange colored.)

Delete

E Dt abyect
Delete the currently selected object from the map.
Delete last point

B Detede Gt poar

Delete the last measurement. This is useful for quickly
removing the last measured point and perhaps replacing it

with a new measurement, = might also be useful
for just changing a few attributes of the last measurement.
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Edit last point
IE:;I Edit lagl point

Allows direct editing of the last surveyed point’s properties:
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Useful for adding Multimedia (Pictures, Video, Audio)
resources to measurements. See also [ Point properties and
attributes ] on Page 77 for additional information.

Enter a point (to stakeout)
P;. EnDad i peinit

This tool is available in both Point, Line/Arc stakeout and
Road stakeout.

Point stakeout
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Enter a new point, then stake it out. Optionally add the
newly staked point to the Point list.

CHCNAY

Check Save to Point list to add the newly entered point into
the Point list. The point is not added to the Stakeout list.

Line stakeout
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When staking a line or polyline from Line/Arc stakeout, click
the Enter point tool to stake a station along the current
line.

Roading Stakeout

When staking a line from Road stakeout, clicking the Insert
point tool allows manually entering or staking a random
point, or to enter/stakeout a station and offset from the
current centerline.

Entering a point with coordinates:
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Entering a point at a Station + Offset:
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Quick access
EI'.-J-'H NCCESE

Opens the side panel for Quick access to Software settings
and system settings

= SoNMware semings

o eertace style

Click the Quick access button again to collapse back to Map
survey.

The Quick access button and the staking from survey ability
makes it possible to use LandStar as a single menu
application.

Explode Block
{9 Eaplode

If an imported DXF with blocks exists Explode will break
every block into the original, ungrouped entities.

Export DXF
E Enpirt DOOF

LandStar 8 User Manual

Exports all the points, lines, objects in the current project to
a DXF file.

Export Surface staked report
(=
Export surface staked report

This tool is automatically added to the Tool tray when in
Surface stakeout mode. Clicking it writes two files:

.csv containing: Name, Northing, Easting, Design
elevation, elevation, DeltaH, Date_time

.txt containing: Name, Northing, Easting, Design
elevation, elevation, DeltaH, Date_time

Follow (rotate)

W Foliow .

Continuously rotate the map alignment to match the PDA’s
internal compass direction. When disabled, grid North is
always up.

Full view

Ll |
L Frill wagray

Zoom to the full extent of the drawing and points.
Import DXF
E rripart DEF

Import a DXF drawing into the current project. The drawing
should have the same projected coordinate system and
units as the current project. Also available from the Project
(Main menu tab) > Import function.

Invert line direction

T_‘ll bnneEr]
Invert the direction of the selected line.
Layers

@I AVErE

Displays the Layers dialog. See [ Work layers, Map files,
Online map ] on Page 49 for additional information.

Nodes list
H= modes list

Available from the Line/Arc stakeout menu, lists the nodes
of the currently staked line/polyline. Each segment
endpoint and center are listed.
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Select a node then click Stakeout to immediately stake the
node.

Select a node then click Save to save the node or all nodes.

Online map
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Control the map screen background map:
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Read about the Map files and Online map tools in the Layer
manager. See [ Work layers (tab) ] on Page 82.

It is possible to download project map coverage for offline
use and control the map transparency for better visibility.

See [ Online map (tab) ] on Page 84 for details.
Region list
E Region list

CHCNAY

Always added to the Tool tray when using the Area survey.
Allows deletion and export of defined areas and regions.
See [ Details: Survey (tab): Area survey ] on Page 139 for
additional information.

Snap
ﬁ.ﬂnau

Allows selection of points, object endpoints, midpoints,
random locations by using the large circle to move the
arrow using your fingertip, with the small arrow point
picking features that would be difficult to click on directly
with your finger.

' ]

Long press on the Snap tool » (on the Toolbar) to directly
display the Snap to object menu:

Eridp 1o objeed

- =1

Snap settings are also available from Settings > Display:
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Offset stakeout

P oftset stakeout

Available from Point stakeout. Allows the stakeout of a
location that is not in the Point list, but that can be
described by an offset from an existing point or object.

See the Point stakeout section of this manual for details on
Offset stakeout.

Offset survey (hidden point survey)

=
: Drhime! suirvay
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Available in Map Survey and Point survey. Allows storing a
measurement that cannot directly occupied.

See Map survey for additional information.
Open road (project) file
3 Open road file
Open a saved roading project.
Pan to (center map at)

Boranw

Center the map at a position from the Point list
manually entered Northing and Easting.

,ora

Pan o

Figrith (W)

Eani (1]

Comcel |

Panel (surface stakeout)

5] Panel

Displays a large balloon window with the Cut/Fill to the
current stakeout surface. Available in Surface stakeout. See
[Details: Survey (tab): Surface stakeout ] on Page 137 for
additional information.

Fill, within Surface Stakeout Tolerance

Fill, outside of Surface Stakeout Tolerance

The background color will be green for FILL and red for
CUT.

LandStar 8 User Manual

47

The bar color will be l red if the Surface stakeout >

Tolerance is exceeded and ' white if the tolerance is met.

Point list

** Ponts

Switch to the Point List:

i Pedirin B Ak

SR EEEERERF B,

Select a point in the list, then slide it right to reveal Delete,
Map, Stakeout and Edit functions:

Pl hi ilihia

Click on the stake button: n to begin a stake operation
on the selected point.

See [ Details: Project (tab) > Point list ] on Page 70 for
additional information.

Point Survey
B= Paind survey

Switch directly to the text-based Point Survey tool. This is
the same action as clicking the Point survey main Survey
menu icon:

Burwiiy
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Redraw
Regenerate the current map view.
Regions

i Hegeang

Shows the list of regions in the current project. Part of the
Area survey tool. Regions can be defined by taking a series
of measurements around an area feature. The 2D & 3D
area, 2D & 3D perimeter and a description of the area are
shown in the region with a colored boundary and
transparent interior color.

Reverse line

— Reverse line

Clicking ™ reverses the direction of the active line, this
tool is automatically added to the Tool tray when staking a
Line, arc or polyline.

Save object

(o] Save object

IMU settings and status

Select a drawing line or polyline object, save it to the Line
list with a name. Selecting a point, then Sav object will
duplicate it to a new point.

Survey boundary
{:! Survey boundary

Allows the description of a polyline boundary around the
project.

Once defined, a voice warning will announce when the
receiver leaves the project boundary.

Zoom In
%) #ap Zoam in

Zooms in to 50% of the current map coverage at the center
location.

Zoom Out
E:'_ Minp Doom Ot

Zooms out to double the coverage at the center location.

On survey screens that have a possibility of using IMU Tilt correction, if the connected receiver supports IMU an IMU

Settings screen will be available.
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Use IMU enables and disables the IMU (Tilt correction). The IMU (Tilt Correction) is always disabled for the Control survey
and Verified survey method. The IMU adds additional measurement uncertainty, and it is reasonable to disable the IMU
when storing and staking important boundary or control monuments for higher accuracy.

ar
Show IMU button turns the survey menu screen IMU control button: on an off.

Frequency of output will be automatically set to the highest frequency supported by the receiver and the connection
method.

The Info section includes detailed information on the tilt, tilt direction and the compensated Pole-tip location in
Lat/Lon/Ellipsoid height and Northing/Easting which is derived from:
Receiver Phase Center + L1 offset + Instrument Height + Tilt + Direction

Work layers, Map files, Online map

Controls Layer visibility, color, fill, line type; background map layers, online maps, downloads cached maps from online
sources.

See [ Work layers, Map files, Online map ] on Page 49 for more information.

Instrument Select & Status information

A Status line is included at the top of most LandStar screens:

The E Instrument select button allows quick instrument selection.
Each of the other icons is clickable and links to additional detailed instrument status information.

Instrument select

The top line of most menus and functions includes the Instrument select button:

S
(3>

Click t_he_ﬂ [nstrument sele_ct button:

1
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Then choose from GNSS Rover, GNSS base or TPS (Total Station).

Finally select the desired Instrument profile from the profile list and click Accept.

Instrument status

Clicking icons on the top receiver information bar

displays status information about the
currently connected receiver. Each of these screens are
also available from the main menu Config (tab) >
Instrument info tool.

LandStar 8 User Manual 49 CHC W&



Instrument information Click . to show the detailed Sky Plot information screen:

Click - to display detailed instrument information:
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Each constellation is shown on separate tabs at the bottom
“ with colored bars indicating relative signal to noise values.
Higher is better. The color mapping for each constellation
is:

These icons link to additional functions:

add registration information to the receiver.

. . GPS | GLONASS | BDS | Galileo | QZSS
update the receiver or OEM board firmware.

BLUE L1 L1 B1 El L1

- L2 L2 B2 E2 L2
Sky Plot and Satellites information

. RED L5 L3 B3 E5 L5

Click the next column to display the satellite
information in table format:

link to the receiver configuration menu.

This icon continuously displays the number of satellites In
Use / Tracked.
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H is the ellipsoid height. Elevation is the projected

m orthometric height (assuming a GEOID is loaded).

oo T T - i Accuracy is a computed mathematical 1-sigma error
B LICHID PN 1 estimation for the Horizontal and Vertical positions.
Bagn i rirmasi Wil =
DIFF age is the age of received corrections and typically
it e T i R i should be 0, 1 or 2 seconds.
o = GNSS Base information
N L stk Click the M55 Ba%# G55 1ase tab to show the current
o 4 2 I position of the base in use.
i B b | Rt Wk Basb03-1-lnmlruime infa
oy ©dl LEw d i 5 i dudiey Gk plal  Saisliies
lH 1 1
G T
SO .
LRSS N
Quality
Click . or - to display the receiver solution quality
status:
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Main menus and program functions

LandStar has many functions grouped into four tabs of Main menu items:
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Project menu tab Survey menu tab Configuration menu tab Tools (COGO) menu tab:

Click and hold on function buttons, then drag them to change the button positions and order.

Not all the functions will be needed for most users. Hide the unneeded functions under the = More button by clicking-

and-holding the unneeded function button until red minus signs = appear in the function button corners.

Then click the minus circles of all the functions you want to hide:
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To add the hidden function buttons back to the main menu tab, click the = More button:
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Then click the n button of the functions to move them back to the primary screen.

Each of the available functions is summarized in the following section with links to additional, detailed information.

Project (tab)

The main menu Project tab holds the project data related functions.

E

Projects

L

Coordinme
Eyuf

il

Single poira
|ocaleaiion

Open an existing project or make a New project. Existing projects can be used as a Reference base for
Coordinate system, Codes library, Project settings, Control points, Entered points, and Stakeout points.
See [ Details: Project (tab) > Projects ] on Page 63.

Select or modify the Coordinate system that is used to convert Lat/Lon/Ellipsoid Height to projected
Northing, Easting and Orthometric heights. The coordinate system includes the Ellipsoid, Projection
type and parameters, Transformation (7-parameters, 3-parameters, Hemert, Datum Grid), Horizontal
adjustment (Plane, Single point), and a Vertical adjustment (GEOID + Constand, Surface or Inclined
plane.) LandStar includes predefined coordinate systems for 1,000’s of worldwide projections or you
can enter a new projection manually.

See [ Details: Project (tab) > Coordinate system ] on Page 64.

Allows projected coordinates at the Grid base elevation to be moved up to Ground using a Combined
Scale Factor comprised of a Projection Grid Scale Factor and Ellipsoidal reduction factor and a rotation
about a base Reference point. Arbitrary Ground coordinates (like 10,000, 10,000) can be associated
with the base point. The resulting basis-of-bearings can match the underlying coordinate system (State
Plane Coordinates), align the reference axis with Geodetic (True) North, or be manually set to an
arbitrary alignment.

See [ Details: Project (tab) > Singe point localization ] on Page 68.
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Displays the Point list which itemizes all Entered, Control, Reference points in the project. The Points to
stake list is an itemized list of points that need to be staked.
See Details: Project (tab) > Point list ] on Page 70.

Manage the Code list. Codes are used to classify points and include a Code Name; Type: Point, Line;
Description; Display symbol, size; Layer; Line type, width, fill, and transparency. Codes are intertwined
with Layers and new Codes can optionally generate a matching Layer. Codes can have specific drawing
attributes or inherit the attributes from their associated Layer. Tools are available to import, save and
share the Code list.

See [ Details: Project (tab) > Codes ] on Page 80.

Manage the drawing layers. Points, lines and other objects are all associated with a drawing Layer.
Layers can be ON-visible or OFF-hidden, which allows the CAD view to be simplified for specific tasks.
Layers attributes include Color, Line width, Fill color, Opacity, and Line type. The Layer manager also
includes the stack of background maps (Map files) and the Online map manager. See [ Details: Project
(tab) > Layers > Work layers, Map files, Online map ] on Page 82.

Import data in a variety of formats (Text, DXF, DWG, SHP, KML, KMZ, TIFF, MBTILES (Global Mapper),
Jmtitles (CHCNav), WFSDB (CHCNav), JPG, INS) to the Entered Point list, Control point list, Points to
stake list and the CAD view.

The Text file importer allows the generation of custom file formats containing: Name, Code, Northing,
Easting, (orthometric) Elevation, Longitude, Latitude, (ellipsoid) Height, Description, and skipped items.
The text file importer understands: .CSV, .TXT, .DAT, .XLS and .XLSX file formats with comma, semicolon,
space and multi-space delimiters.

The format ‘USA: P,N,E,Z,D’ is the correct format for 99% of applications in the USA.

See [ Details: Project (tab) > Import ] on Page 85 for details.

Export data writes output files in text or standard formats in a variety of styles. The formats ‘USA FULL:
P,N,E,Z,C,D’" or ‘USA: P,N,E,Z,D’ are the correct format for 99% of applications in the USA.
See [ Details: Project (tab) > Export ] on Page 86 for details.

Surfaces can be used in Volume calculations and staked for Cut/Fill. The Surfaces manager allows direct
import from CASS triangulation files, HC triangulations files, 3D DXF (.dxf) files and LandXML (.xml) files
or surfaces can be created from a single point or a list of points that define a surface. Breaklines and
boundaries are also supported for developed surfaces. The Surface manager allows granular control of
the triangle networks used to approximate a surface. See [ Details: Project (tab) > Surfaces ] on Page 90
for detailed information.

Once a surface is defined or imported, use the Survey: Stake surface tool to stake them. See [ Details:
Survey (tab): Surface stakeout ] on Page 137 for more information.

The Features list shows all Points, Lines and Polygons in the current project that have GIS attributes.
Assign GIS features to a Code, then when a point or line is collected with the matching Code, attribute
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entry will be enforced. The Features list allows editing the associated data, directly from the listing. See
[ Building GIS Datasets in LandStar ] on Page 219 for help adding GIS features to Codes.

=

Lt Arca Lines / Arc list shows all the named lines and polylines in the current project. Stake these objects by

sliding the line to the right, then clicking on the l blue stake button. Editing an object will display
starting + ending coordinates, 2D + 3D length, AElevation, bearing/azimuth, and slope. Manually enter
line segments using the Add button at the bottom of the list.

L]
Images This is a list of the recorded Visual survey tasks. Use this function to process the images and to snap

additional target points.
See the [ Visual survey Images list ] section on Page 112.

Fals The Roads tool allows import of Centerline and Cross-section definitions. Roads list catalogs the
available Roads and allows one road file to be activated. Each Road can have Station numbering
equations, Horizontal alignments, Vertical alighments, Cross-section templates, Cross-section template
positions, Super-elevations, Width lists, Side slope templates, and Side slope template positions.

Roads is covered in a separate User Manual.

Survey (tab)

The main menu Survey tab organizes survey related tasks.

(& ¥
bl survey Survey (store) Point locations with direct or offset measurements and includes mapping backgrounds.

Optionally group Points into Line, Polyline and Arc objects.
See [ Details: Survey (tab) > Map Survey ] on Page 95.

T Point survey is like Survey point; however, the interface is greatly simplified for a text-based

representation. Fewer Tools are available.
See [ Details: Survey (tab) > Point (text) Survey ] on Page 108

oA
Wizisal tarvay Visual survey records pictures with the camera built into a receiver while moving along a path. The
resulting pictures can be processed in the data collector, then points can be picked and stored from the
images. A vision enabled receiver like the i93 is required.
See [ Details: Survey (tab): Visual survey ] on Page 108

sl The Control survey tool automates acquiring multiple groups-of-averages, automatically resetting the

GNSS engine between groups, and performing statistical combination of the measured epochs.
See [ Details: Survey (tab): Control survey ] on Page 113.

i

Vil sanry The Verified survey tool automates acquiring multiple groups-of-averages, automatically resetting the
GNSS engine between groups, performing statistical and graphical analysis of the results to reject bad-
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FIX and average good-FIXED measurements.

The intended use of the Verified survey tool is to acquire very reliable coordinates under extremely
heavy canopy where the receiver is expected to encounter many bad fixes.

See [ Details: Survey (tab): Verified survey ] on Page 115.

‘Staking out a point’: using assisted navigation to move to a point’s known coordinates so the location
can be marked by a stake, flagging, paint, whiskers, or other monument. Point stakeout provides a
horizontal position and the deviation (cut/fill) to a target elevation. After setting a monument, typically
the ‘set’ location is stored as an ‘as staked’ position for verification.

Offset staking allows staking a point that is offset from the selected point.

Visual staking displays the target point superimposed on a live picture from the receiver.

See [ Details: Survey (tab): Point Stakeout ] on Page 123.

Line/Arc stakeout allows the selection of a line, arc, polyline, object to stake. The line can then be
staked to the nearest point on the line, endpoints, node points, random and even stations along the
staked object. Offsets can be added by Left, Right, Ahead, and Behind. Visual staking is supported for
receivers with internal cameras (like the i93.)

See [ Details: Survey (tab): Line/Arc stakeout ] on Page 131.

Surface stakeout accepts a surface to stake, then displays the cut or fill required to move the receiver
up or down to the design surface. The delta is updated continuously as the receiver moves around.
Surfaces can be defined by a single point; by three or more points (technically two-points would work,
however an unintentional tilted-plane will result); importing a CASS triangulation file, a 3D DXF File or a
LandXML file.

See [ Details: Survey (tab): Surface stakeout ] on Page 137 for additional details.

Area survey allows the collection of polygons representing the edges of a region. During collection
either 2D or 3D area and 2D or 3D perimeter length are displayed. Once a region is complete, it will be
displayed with 2D/3D area and perimeter. The areas can be exported to a PDF report showing the area
and DXF drawing file.

See [ Details: Survey (tab): Area survey ] on Page 139 for additional information.

CAD View switches to a CAD style interface with a rich set of drawing, editing and measuring functions.
Also available from the Tool tray and called by viewing shortcuts throughout the LandStar program.
See [ Details: Survey (tab): CAD View ] on Page 142 for additional details.

Road stakeout is covered in a separate User Manual.

Site calibration allows modification of the underlying coordinate system so that Measurements (GNSS
points) best match record (Known point) data. Horizontal and vertical calibrations can be combined or
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handled separately. Site calibration makes the GPS receiver use local coordinates.
See [ Details: Survey (tab): Site calibration ] on Page 146 for additional information.

o Q
Ao ahil CORS shaft
Base shift and CORS shift are nearly identical functions. While Base shift works for a single base while
CORS shift works for all future bases and is targeted towards CORS network corrections where the
BaselD will change over time and distance.
See [ Details: Survey (tab): Base shift and CORS shift ] on Page 151 for additional information.

h

Sesiope
Stk Automates staking a vertical profile perpendicular along a centerline (line or polyline). The profile can
have multiple profile strings (segments with varying slope and width) and is mirrored on both sides of
the centerline. The centerline might also be used to grade a slope against a building foundation.
See [ Details: Survey (tab): Sideslope stakeout ] on Page 155 for additional information.
| beris

Frundagian

F—_ Foundation stakeout automates the design and staking of sloped pit walls around a foundation. At an
offset distance, a sloping surface is defined which intersects with the undisturbed ground surface. The
top edge of pit, wall slopes and building bottom can then be staked and excavated.

See [ Details: Survey (tab): Foundation stakeout ] on Page 157 for additional information.
=

RS Hydro survey is a map survey method that shows the current position with a Waypoint plan detailing
the desired hydrographic survey route. An Echosounder (Hydrolite DFX, Hydrolite TM, NMEA DPT,
MNEA DBT are supported) provides Depth which is combined with the receiver position and HI vertical
offset from the receiver to the sonar transponder to store derived bottom surface elevations at regular
intervals.

- é
Continiess
suryy Continuous survey allows automatic collection of measurements based on traveled distance or
incremental time. Measurements can be triggered by Time, 2D distance traveled, 3D distance travel or
2D delta and height delta.
See [ Details: Survey (tab): Continuous survey ] on Page 160 for additional information.

i
[T ]

STy Cross-section survey allows quick point survey at evenly or randomly spaced cross sections along a
centerline alignment. This survey tool displays the location relative to a cross-section station enabling
quick navigation to the left, centerline, and right offset points. Extra measurements along the cross-
section lines may also be stored.

In addition to the stored points, Station and offset information is available for all measurements
collected using the Cross-section survey, including points stored at random stations, along with a DXF
file that details every cross-section measurement.

See [ Details: Survey (tab) Cross-section survey ] on Page 162 for details.
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Instruments profile combines the Bluetooth/Wi-Fi Connection (Connect to instruments) with a Rover,
Base, TS/RTS instrument configuration (GNSS Rover, GNSS Base) to form a complete instrument
definition.

Instrument profiles can be quickly selected and applied using the m Instrument select button.
See [ Details: Config (tab): Instruments profile ] on Page 167 for more information.

LandStar connects to GNSS receivers, Total stations and Peripherals (Laser Rangefinder, Pipeline
detectors, Echosounders) by Bluetooth. Most modern GNSS receivers also support a Wi-Fi connection.
See [ Details: Config (tab): Connect to instruments ] on Page 169for details.

GNSS Rover configures the connected device as a Rover and includes the UHF Radio / Internal modem /
PDA connection settings to provide RTK corrections.
See [ Details: Config (tab): GNSS rover ] on Page 171 for details.

GNSS Base configures the connected device as a Base and includes Internal UHF Radio / External Radio
/ Receiver Cell Network settings to provide RTK corrections. Also does the Base setup putting a
coordinate in the receiver.

See [ Details: Config (tab): GNSS base ] on Page 174 for details.

Receivers can store static observation data for processing in desktop tools like CGO2, online tools like
NGS OPUS and be used for UAV post-processing. GNSS static recording allows control of the receiver’s
recording settings.

See [ Details: Config (tab): GNSS static observation recording ] on Page 178 for details.

The Instrument info tool provides extensive information about the currently connected receiver.
See [ Details: Config (tab): Instrument info ] on Page 179 for details.

Receivers can be temporarily activated or be geofenced with different options based on location.
Activate instrument allows the user to enter a new activation code.
See [ Details: Config (tab): Activate instrument ] on Page 179 for details.

Receivers have firmware sets for the main board, the OEM GNSS engine, the cellular modem, and the
UHF radio. It may be possible to automatically update a receiver using online resources.
See [ Details: Config (tab): Update ] on Page 180 for details.
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The Advanced functions include: configuring the NMEA output for the Bluetooth channel, the R$232
Serial port and a special Raw TELNET port (1212) accessible via the Wi-Fi port; the receiver Elevation
mask setting, the Position output frequency, an OEM GNSS engine reset, the APN for the cellular
modem and a NFC/Wi-Fi function that may allow connection to some receivers by Wi-Fi or Bluetooth
more easily.

See [ Details: Config (tab): Advanced ] on Page 180 for details.

Some receivers include NFC transponders. It may be possible to read the Bluetooth ID, MAC and PIN
and the Wi-Fi SSID, MAC and password via NFC.
See [ Details: Config (tab): NFC / Wi-Fi ] on Page 182 for details.

Map adjustment allows vector maps (DXF, DWG, SHP, KML and KMZ, WFSDB files) to be georeferenced
with multiple affine points. This function will not adjust raster images.
See [ Details: Tools (tab): Map adjustment ] on Page 183 for details.

Compute the Volume, Surface area and cut/fill balance of two surfaces or a surface and a reference
elevation, then and create a Volume report
See [ Details: Tools (tab): Volume computation ] on Page 185 for details.

Area accepts an ordered list of points and computes the area enclosed by them. The points can be
selected from the Point list, from the Map or entered as a range of points.
See [ Details: Tools (tab): Area computation ] on Page 188 for details.

The Inverse tool computes distance and bearing between two points or a series of points (Traverse
style).
See [ Details: Tools (tab): Inverse ] on Page 190 for details.

The Angle conversion tool is useful for converting Degrees Minutes Seconds to decimal degrees,
decimal minutes, decimal seconds, radians and Gons; and vice-versa.
See [ ] on Page 190 for details.

Parameter calculation accepts matched sets of GNSS points (with underlying Lat/Lon/Height data) and
Known points (projected values). After selecting a transformation style, verify residuals, and compute
best-fit translation coefficients, the translation can be entered into the current project’s coordinate
system.

See [ Details: Tools (tab): Parameter calculation, 3 or 7- parameter ] on Page 191 for details.
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Computes the nearest point on a line to a specified point. Returns the Station, the Offset distance left
or right, the nearest point can be saved to the Point list or directly staked out.
See [ Details: Tools (tab): Point to line distance ] on Page 193 for details.

Compute the angle of a point offset from the endpoint of a line to the line.
See [ Details: Tools (tab): Offset distance ] on Page 193 for details.

Compute the Deflection angle of a point offset from the endpoint of a line to the line.
See [ Details: Tools (tab): Deflection ] on Page 195 for details.

Rotate a point around another point, a specified angle. Create a new point at the new location.
See [ Details: Tools (tab): Rotation ] on Page 195 for details.

Intersection accepts point pairs defining two lines, the intersection of the lines between these points
are computed. If there is no direct intersection, the lines are extended.
See [ Details: Tools (tab): Intersection ] on Page 196 for details.

Place a point on the line bisecting an existing angle, specifying the offset from the center vertices.
See [ Details: Tools (tab): Bisect angle ] on Page 198 for details.

Divide line will divide the distance between two points into even segment lengths (By distance) or a
whole number of segments (By segments). Point protection can automatically Skip points that already
exist at the same location as the calculated points.

See [ Details: Tools (tab): Divide line ] on Page 199 for details.

Choose several existing points to average. Show the residuals for each added point and allow adding
and removing points from the average before storing a new Point average.
See [ Details: Tools (tab): Point average ] on Page 200 for details.

Directly enter a Metes and Bounds survey or a Bearing Distance traverse with lines and arcs. Plot deeds
from legal descriptions. Includes a Curve Calculator and provisions for arc tangent bearings or cord
bearings.

See [ Details: Tools (tab): Plot Deed ] on Page 201 for additional information.
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fransfcematsan  Translate, rotate, scale points and objects based on a multi-point alignment or manually entered offset,
rotation and scaling information.
See [ Details: Tools (tab): Transformation ] on Page 210 for additional information.

Arom
BUSKITNRON Subdivide an existing closed polygon into two parcels. Supports: parallel by two-points, perpendicular
by two-points and hinge-point.
See [ Details: Tools (tab): Area subdivision ] on Page 216 for additional information.
Caloutato A simple Calculator for simple computations.
See [ Details: Tools (tab): Calculator ] on Page 215 for details.
Foden Displays a ruler that shows centimeters only.

See [ Details: Tools (tab): Ruler ] on Page 218 for details.
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Function Details

Details: Project (tab) > Projects

Open an existing project from the Project list or make a
new project.

Available from the Project (tab) > Projects button:
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Click on Time ascending and Time

descending to sort by the time the project was last used,
not the creation time.

Click on to search for projects by name.

Initially new projects will be placed in the Default Project
group folder. Click on
>

| T
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to make a new Project group or select another group:
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Sharing Projects

From the Project list, slide a project entry to the right:

smoPmjecl 07-Projects |
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Click the E Share project button. If the project has Visual
survey images, image inclusion will be prompted:

Share

|: Sag wriud| ratery IMagh

L]

Check Share visual survey images to include image sets.
Enabling image inclusion will generate very large projects.

The current project will be compressed to a single ZIP file.
Share the file, typically by email or Google Drive if images

are included, to another device or user.
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On the receiving device, use the 3-Dot button in the project
list:
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Then click Load from file to browse for the project file and
restore it as a local project.

Project backups

LandStar automatically backs up projects at a defined
interval and optionally each time you exit. These backups
are ZIP compressed collections of project data and settings,
they are stored in a separate folder from the primary
project (to help protect against inadvertent deletion.)

Click the H 3-Dot button to change the automatic Backup
settings or to Restore a project:

Projecin
Pacmup =etEngs
Mniknie frosct oo sl
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Load from file allows browsing device memory for a shared
project file.

Backup settings:
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sets the automatic project backup interval. Backups are not
deleted, even if the job they are protecting is deleted, so if
you inadvertently delete a job, the backup should/will
remain. Restore project from local will restore a backup
into the currently selected project folder.

By default, project backups are stored in the root folder:
/system_prj_backup

outside of the normal CHCNav folder hierarchy. Within the

project backup folder there will be a subfolder for each job,

within the job subfolder there will be one or two

compressed .ZIP files holding the project’s files.

When making a New project:
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Enter a project Name and assign an Operator name.

Optionally pick a Reference project to inherit the
Coordinate System, Code library and Project settings,

Control points, Entered points, Stakeout points from:
e e o )
Famaru prrgnsi

T T T AT

e T [ S

i B A |

If a Reference project is not used, select a Coordinate
system for the new project. See the following entry [
Details: Project (tab) > Coordinate system ] for more
Coordinate system details.

Details: Project (tab) > Coordinate system

Select or modify the Coordinate system that is used to convert Lat/Lon/Ellipsoid Height to projected Northing, Easting and

Orthometric heights.

From the main menu Project (tab) click on the Coordinate system button:

L
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The Coordinate system dialog is shown with these 5 tabs:

CHCHN.AV
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LandStar has thousands of predefined coordinate systems. The default Area will be NAD83(2011):
There are too many to pick from a single list. Instead
LandStar maintains a Common coordinate system list that Aegon  Lisiied Siges [ |

you can copy systems to from the giant Pre-defined o S &8

coordinate systems list. You can also add User defined

systems to the Common coordinate system list. If you are looking for a special County zone,
chanrg_g the Area:

The predefined coordinate systems fully implement the
State Plane systems; however, they do not specify a Geoid. | hars
When you copy a predefined system to the Common list,
you should always specify the correct Geoid.

Click on From lib to access the Common
coordinate system list. Initially there will be no systems S SEUTTF
listed:

& Paslfl - Corenon oo : | ik T A0 A

Lancel

Click on Pre defined then set the Region to United
States.

Heror Irrter Sintas “
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A list of Area specific zones will be shown. If additional zones are regularly used, repeat as needed to
sedinals spsism add them into the Common coordinate list:
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Drag the list down and select the correct SPC Zone for the m m m

Project area: To add a Geoid into an existing Common coordinate system
Baald2-1-Phs ds
list entry, highlight one projection then click m
Iiirmam
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Finally click Select.
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Select the Vert adjustment tab:
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then use the dropdown to choose a Geoid file to use.
Currently Geoid2018US is appropriate for the continental
Unites States. If the Geoid you need is not available make
sure you have installed the localization package. See [
Localization packages ] on Page 25.

Change the Name of the system to include the Geoid:
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Click on m Save to lib to save the coordinate system
with the Geoid included as a Common coordinate system.

Finally click m Accept.
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The zone will be available, with the Geoid applied in the
Common coordinate system list:
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To delete a Common coordinate system, slide the Common
coordinate system to the right,

ﬂm.u[n.m

then click on the m Delete button to remove it.

Coordinate system utilities

From the coordinate definition screen, click on the H
button:

Fadiem LA K& Cromip OH cooe

Frapcll Sogn O rnds

Type GREEN  §jgp rowcdcari HICHW
i EA0A1 L
141 IOk 25
= pani Bl
rglies
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then Create QR code to display a QR code:
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fipsick- 1~ code

Which can be scanned by other devices using the Scan QR
code tool:

Use broadcast RTCM will wait for the next RTCM
transformation parameters broadcast as Message Type
1021 — 1028 and build a coordinate system. This option is
extremely uncommon.

Click Lock to freeze the coordinate system and password
protect it from inadvertent changes:

Leszhomd

Panyw

i FAdSE
sl

Cincl

Export writes the current coordinate system to a Trimble
.dc file. Most field software programs import Trimble .dc
files directly.

Load from file will import:
Trimble DC (.dc)
Trimble JXL (.jxI)
Trimble CAL (.cal)
Leica LOC (.loc)
coordinate system definition files.

Details: Project (tab) > Singe point localization

Allows projected coordinates at the Grid base elevation to be moved up to Ground using a Combined Scale Factor

comprised of a Projection Grid Scale Factor and Ellipsoidal reduction factor and a Rotation about a base Reference point.
Arbitrary Ground coordinates (like 10,000, 10,000) can be associated with the base point. The resulting basis-of-bearings
can match the underlying coordinate system (State Plane Coordinates), align the reference axis with Geodetic (True) North,

or be manually set to an arbitrary alignment.

Begin from the Project (tab) > Projects button:

Tingle poird

> lecaleation

Slide the Use single point localization to the right:

[T R—— - Ty T [ |

CHCNAY

68

LandStar 8 User Manual



A single menu will be shown:
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Define the Project BNSS Base Point by picking from CAD
with the ~ " CAD button, making a new measurement at

-
the current position with the Begin measurement
button, or select an existing GNSS measurement — from
the Point list.

Next enter the Project Base Local Coordinate that the

receiver should read when placed at the GNSS Base Point.

Either type the coordinate in, select a Known point from

CAD or, select a Known point from the ~ Point List.

Choose a Basis of Bearings from Geodetic (True North),
Grid North (matches the current Coordinate system
projected grid), or Manual entry.

If manual Rotation entry is used, extreme precision is
required to match distant coordinates. The:

i s

T B b (R ERHARER

i3 Ten g
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> button can be used to match the exact bearing between
two existing points in the project.

Click the m Calculate button to automatically
compute the Elevation Scale Factor, the Grid Scale Factor at
the GNSS Base Point, a Combined Scale Factor and an
appropriate Rotation.

Click m Accept,

Aroopt rewy pangla poinn
local laaiion parsressters T

Canzwl

then Apply to install the results into the current Coordinate
system.

Check-in on the GNSS Base point using Stake point, the
receiver’s coordinates should exactly match the Known
point entry.

The resulting Horizontal adjustment will be fully described
on the Project > Coordinate system > Horizontal
adjustment (tab);:
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The computed Vertical adjustment will be fully described
on the Project > Coordinate system > Vertical adjustment
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Clicking the n button from the Coordinate system allows
sharing, Locking, Exporting and Loading the complete

M P& MADAS LAk F TTH System:
jana P sfjueiment

4% ,*] [nramame wigpmne “ Creaie OH code

L1 e L L er PR PR Sean QR code
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To disable the Single point localization, return to the menu
ﬂ and slide the Use single point localization slider to he left:

i e LA o

When the coordinate system is changed, all projected
coordinates of points with underlying GNSS values will

m m m automatically be updated.

Details: Project (tab) > Point list

Available from the Project (tab) > Projects button:

The Point list organizes 3 types of points:
Survey points that are measured with GNSS or TS/RTS.
Enter  points that are imported, or hand entered.
Control points that are treated as high precision control points.
Base points that are associated with Base locations.

When entering the Point list screen, the Project name is shown at the top with the total number of points in parentheses
(19). There are two tabs, the Points tab contains all the points in the project, the Points to stake tab contains a list of points
to be staked. While it is not necessary to use the Points to stake list, it does help keep design points separate from
surveyed points.
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It is possible to drag-over rows in the Point list to select ranges of points. Click on the top or bottom item to select, hold,
then drag up or down.

The left-hand column has an icon representing the type of point:

b Entered
L
L Averaged

Base
Rover

Imported

Surveyed Control point

Staked

b
l?l
N
‘:: Entered Control point
'y
=
&8

COGO computation result.

Verified point survey, multiple measurement survey.

?‘ 10 LLAFERE L [ s '

The width of the list is usually wider than the screen, drag/slide it left and right to view all the columns.

Click the I 3-dot button in the upper right corner, then
select Switch list style to change to the paragraph display
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style for points:
Pt i stk

q himam 1

Click the H 3-dot button in the upper right corner to
change the displayed columns and their order. The default
columns are:

Name The point Name or Number, names can

contain spaces.

Code The Code associated with the point.
Codes can be coupled to Layers and

automatic drawing automation.

Descriptions can be any length. Most
survey screens do not have a dedicated
Description entry box, enter a Code
followed by a question mark ‘?’ (the
Code escape character’ and whatever
follows the “?” will be placed into the
Description.

Description

North The point Northing in the project units.
Can be modified by 3-dot > Coordinate

type.

East The point Easting in the project units.

Can be modified by 3-dot > Coordinate
type.
The point orthometric Elevation in the

project units. Can be modified by 3-dot
> Coordinate type.

Elevation

The type of point: Base, Survey,
Entered, or Control.

Type

The horizontal distance from the
current point to the next point in the
grid.

2D dist

3D dist The 3D distance from the current point

to the next point in the grid.

Time The Date - Time the point was entered

or acquired.
The following columns are also available for display:
Solution Fixed, Float, DGPS, Autonomous

The Vertical HI of the GNSS receiver or
prism.

Antenna Height

The elevation change, from the current
point to the next point in the list.

A Elevation

CHCNAY

Satellites The number of satellite vehicles used
for the measurement.
PDOP The PDOP while the measurement was
acquired.
Picture Displays the name of the picture.
Bearing The azimuth or bearing from the

current point to the next point in the
list.

When a line is slid to the left, additional options are shown
depending on the type of point:

EJ 4 Base

points can be shown in EI CAD view

Base

and they can be edited. Base
points cannot be deleted as they may
have Rover points associated with
them.

m Rover

points can be E deleted, shown in
n CAD view, immediately n

edited.

Rover

staked, and they can be

The m Import button launches the file import tool,
see [ Details: Project (tab) > Import ] on Page 85 for details.

The m Export button launches the file export tool,
see [ Details: Project (tab) > Export ] on Page 86 for details.

The n Add button allows manual entry of a new
point.
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3-dot button

At the top right corner of the screen there is a H 3-dot
button (the kebab menu):
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The items on the 3-dot menu are:
Coordinate type

Click the H 3-dot button, select Coordinate type
Coanfnale Tyge

RN | UL

e D WAL

|l L BT

| i 1 S

Change between Coordinate display types for the grid. See [
Entering / Viewing Geographic and Projected Coordinates ]
on Page 15 for additional information.

Multi-select

Click the H 3-dot button, select Multi-select to add
checkboxes to the left of every line, allowing multiple
points to be selected at once for Deletion or to Reset

LandStar 8 User Manual

stakeout state (see the 3-Dot button):

Powria o sbake

Recycle bin

Click the H 3-dot button, select Recycle bin to view the
deleted points. When points are deleted, they are moved
to the Recycle bin:

Sec10-Reoyclo bin

| St

It is easy to restore the points in the Recycle bin, or to

permanently delete them.
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Custom Display

Click the H 3-dot button, select Custom display to select

the Point list columns and reorder them for display:

B humm
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Highlight an item, then use the Up and Down buttons to

move it up and down in the list.

CHCNAY

Set point(s) elevation

Click the H 3-dot button, select Set point elevation to
select one, or more, or all points to set the elevation of:

Punrin 1o stake

([ -
aY
oy P
BY o=
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aow

L u

O
O
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Click Next:
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After a Surveyed point’s elevation is

an Entered point.

74

edited, it will change to
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Adjust point(s) elevations

Click the ! 3-dot button, select Set point elevation to
select one, or more, or all points to adjust the elevation of:

Puaniu 16 stake

o I
(i} -

BY w=

ay

BT ue

L

oYy

e

s R
O

ow

Click Next:
Adpesl point elevations
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Cancel

After a Surveyed point’s elevation is edited, it will change to
an Entered point.

Set code to points

Click the I 3-dot button, select Set code to points to add
checkboxes to each point, check the points to assign a Code
to:
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Click Next:

Gl cida 10 Bl

Cancel

highlighted points.

Set antenna height

antenna height of:

L) et b

L

L

av

BYW o
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Select a new Code, then click OK to set the Code of the

Click the I 3-dot button, select Set antenna height to add
checkboxes to each point, check the points to change the

CHCNAY



Click Next:
St ansenmn kerighl
driznna hpe
SHEET MERE [ & |
femimnna hirsgin
Fancasl

Edit the Antenna type and the vertical Antenna height (HI).
Click OK, the antenna parameters are updated, and a new
point elevation is applied to the selected points.

Shift GNSS base

Click the H 3-dot button, select Shift GNSS base.

| P T
LRLY basw
asin 1
durenta lyae

CHCHLY RO
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o
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Use the drop-down list to choose the Base to move. It is
also possible to change the Base Antenna type and Antenna

height along with the new base position.

The new Known point for the selected base can be
retrieved from ~ CAD, making a new measurement at the
current GNSS : Start measurement, picking from

another point in the Point list or hand entering a new
point. To hand enter, choose the position type:

Lerad PR e

[ H FIT R e
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Local Northing, Easting, orthometric Height:
Coooidiftantar |t vl

Lina b Ellee
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or Latitude, Longitude, Ellipsoid Height:
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Click on Accept to apply the new Base parameters which
will shift all the GNSS points that were collected with the
selected base.

Show / Hide GNSS base points.

If the GNSS Bases are shown in the Point list, Click the H 3-
dot button, select Hide GNSS base points to remove them.
Pridtra b Srahi

If the GNSS Bases are not shown in the Point list, Click the

|

| ==

H 3-dot button, select Show GNSS base points to add them
to the list them.
Frimia i ezakn

m__

Sort newest to top/bottom

By default, the point list order is first to last click the H 3-
dot button, select Sort newest to top to reverse the list.

If the newest point is sorted to the top, click the H 3-dot
button, select Sort first to top to reverse the order.

Reset stakeout state

Click the H 3-dot button, select Reset stakeout state to
mark all points as un-staked. This makes them eligible for
staking with Stake nearest operations which automatically
exclude previously staked points.
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Data statistics

Click the . 3-dot button, select Data statistics to show a
short summary of the Points list:

e snptiEtice

Total paevls 38
GhES hase
TS

Sijra iy

[y b

Coimiaod

gl

Switch list style

Click the l 3-dot button in the upper right corner, then
select Switch list style to toggle between the line display
style and the paragraph display style for points.

Line display style:

W b .!

B "

Paragraph style:

s Frinm i ks

! himem 1 1
A JIERGRT .:I
i 3amI
B 1007 wins
i 1 K] i % !

Point properties and attributes

Points in the Point list can have several attributes besides
position, Code, Name and Description. An Enter point type
will have simple properties, while a Surveyed GNSS point
will have many additional Survey properties and Quality
properties.
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Additional Quality properties for a GNSS point

It is possible to assign GIS Fields, Attributes and assign
Values in the field based on the point’s Code:
drrral Cualify =11iIIE B dirmrsia

U b nme g o i

Taighiuieds
"

T piny Aed -

1

MBI A

PoriiGine 4

See [ Building GIS Datasets in LandStar ] on Page 219 for
information on GIS Point Attributes.

Multimedia (Pictures, Video and Sound Recording) can also
be attached to any point:

Fuftan S Tk
& 0
LIE L"TITIT I =]
wlla Misil i

Click the S Multimedia settings button and check all the
photo description checkboxes:
W Tk
Pt e [
[T . ]
Pl e S

Foarn e B

to automatically label photos with the Name, Latitude (B),
Longitude (L), Northing (N), Easting (E) and timestamp
information:

Details: Project (tab) > Point list > Points to stake (tab)

The right-hand tab of the Point list holds a 2" list of points:
Points to stake. These points might be selected points from

CHCNAY

the left-hand Point list. They might be Imported from a

separate file, or they might be snapped from line work in
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CAD. column:

1

Then the next un-staked point in the Points to stake list will
be targeted.

The H 3-dot button in the upper right corner accesses
these settings:
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Coordinate type

m m n Changes between Coordinate display types for the

Once an important list has been generated, Export it for displayed values. See [ Entering / Viewing Geographic and
future use. The Export function: Projected Coordinates ] on Page 15 for additional

Multi-select
Faamind
4 PAMETD [~ dan) - Allows multiple points or all points to be selected and
[T subsequently deleted. Also allows drag-over-past selection
- — of multiple items.
HIRE= (TR Sort
st « Allows reordering of the Points to stake entries:

PiuiTey
Cade
Csenrrptien
LI T
Allows filtering exported points by measurement Time,
Name, Code and Description.

¥ ¥y rYITT

Drag an entry to the right: . .
—t | a

[ I

Highlight one or more lines, then use the Up and Down

button to change the staking order. Click on the Back
Next / Last button is pressed, the button to exit Sort.

point will be marked as Staked in the Stakeout count

Then click on the “ Stakeout button, to directly enter
the Stake point routine. Once the point is stored, or the

L ]

LandStar 8 User Manual 79 CHC W&



Switch list style

Toggle between one row per point and one paragraph per
point displays:

rFrT¥rerUrrYTyry

s
Line list style

Details: Project (tab) > Codes

™ i

>
P iy

»
F 18

b

Paragraph list style

Reset stakeout state

Sets the Stakeout count back to O (zero), which makes the
points eligible for stakeout again.

Codes are used to classify points and include a Code Name; Type: Point, Line; Description; Display symbol, size; Layer; Line
type, width, fill, and transparency. Codes are intertwined with Layers and the entry of a new Codes can optionally generate

a name-matching Layer.

Codes have specific drawing attributes or inherit the attributes from their associated Layer.

Codes can be organized into multiple Groups (Categories).

Tools are available to import, save and share the Code list. The Quick code button assignments are also stored with the
Code list: see [ Quick code panel ] on Page 97 for information about the Quick code panel; see [ Sharing CODES and Quick
Code buttons assignments ] on Page 97 for information on sharing code lists with the Quick code panel assignments.

To manage the available Code list, from the Project tab click
on Codes:

3

> Codes

Praject

CHCNAY

An empty Code list will be shown:
JTICD- D 1)

an

From this menu it is possible to delete codes, edit codes,

create new codes. The n button on the upper right corner
allows
Importing Code libraries.
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Loading code libraries from text files, Carlson FCL files,
Trimble FXL files.

Saving Code libraries for reuse in other projects.

Sharing Code libraries by email, Google Drive or other
sharing methods with other users.

When Importing or Saving code libraries, the Quick code
panel layout is included in the library file.
Edit or Delete an existing code

Click on or slide-right an existing Code row:

13 V- Cniles |

Item options to n Delete or

on the left of the row:
IT - ndes

Edit the Code will appear

Huiete snincied Hermos(?

[

to delete a single Code.

Click Edit to change the properties of a Code.

Create a New Code

Click the New button to create a new Code. A matching

Layer can be built with the new code:

Fl Creste & laper woth The =ame neme

LandStar 8 User Manual

haiew

DeawEg b

=
Thubr g

T i I B
T B

Tk Py

F Crmwn 1 by mvn s s

wafS i -
I.II'I.lIf wrEi
H ks Es ¥

New Code with new Layer

Or a new Code can be created without a matching Layer,
possibly referencing an existing layer:

Warnm
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New Code without Layer
Enter a uniqgue Name for the new Code.
Drawing type can be Point or Line.
The Description is a text prompt for the Code.
The Symbol can be selected by clicking on the Symbol box

then choosing from one of the 100’s of included symbols,
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or imported from a .dxf file. The Symbol size ranges from 1
to 9.

if Color by layer is enabled, then the symbol color is
inherited from the Layer. Otherwise, the symbol color can
be chosen from a color wheel.

¥ Crmpiu 4 e weth e LI nane

If Create a layer with the same
name is checked then the Line type, Line width, Fill color
and Transparency can be entered and a new Layer with the
following properties and the same name as the Code will be
created:

There are several possible Line types: Continuous,
Dashed, Dot, Center, Arrow_Continuous. Possible Line
width: Normal, Thin, bold.

The Fill color and Transparency is for closed polygons
built with Line attributes.

GIS Attributes allow features (like a serial number,
diameter, invert) to be recorded and associated with
objects when acquired. See [ Building GIS Datasets in
LandStar ] on Page 219 for detailed additional information.

Code library functions

Click the n button on the upper right corner:

Import from code library will import an existing LandStar
code library.

Load from file imports a Code list from a custom .csv file, a
Carlson FCL (.fcl) file or a Trimble FXL (.fxI) code list.

The custom file can include any of these field types, in
the listed order:

FEVCE il oty

------

P iy (1) - 115

Save code library saves the current Code library to a named
file.

To cloud pushes a copy of the current Code library to the
CHCNav cloud.

Share sends a copy of the current Code library to any of the
device sharing options, for example as an attachment to
email.

Details: Project (tab) > Layers > Work layers, Map files, Online map

The Layers menu has three tab sections:

Work layers associated with objects: points, lines, polylines, ...
Map files: DXF, DWG, SHP, KML, KMZ, TIFF, MBTiles, JMTiles, WFSDB, JPG

Online Maps: Google satellite, Bing satellite, OSM and others

The Online Maps selection allows downloading map tiles covering the entire project area for offline use. Downloaded maps
are added to the Map files tab and the transparency can be adjusted to make the image more compatible with overlaying
survey plotting.

You can also reach the Layers menu from:
Project > Layers

Software settings > Display settings > Layers

B Gide-bar button optionally available in many survey screens
Available from the Project (tab) > Projects button:
m-wn =
-1
ll."-'.%vr'f.-.. e
-ﬁ"-.—"-l- > Layrs
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Work layers (tab)

ap Mk nlne map
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This tab allows you to edit the properties of all the layers
associated with features.

! button allows you to select multiple layers for deletion.

' click to toggle the layer visibility (show/hide)

Click on the 2 symbol to slide the layer to the right
allowing deletion and editing:

o=

It may be safer to just click on the line which only displays
the edit tool:

_k

Then click on the pencil
selected layer.

to edit the properties of the

LandStar 8 User Manual
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These Layer properties can be modified:

Name: the name of the layer.

Layer color: the color of the layer.

Line width: Normal, thin, and bold are available.

Fill color: if a closed shape (polygon) is defined on the layer,
it will be filled with this color.

Transparency: change the opacity of the polygon fill to
allow other elements to be seen.

Line type: select a simple line style: continuous, dashed,
dotted, center line-dot, line with arrows.

Mabp files (tab)

Use the Map files tab to attach both vector drawings and
raster images from several sources to a project:

DXF/DWG CAD drawings

SHP shapefiles
KML/KMZ Google line and point files
TIFF GeoTiFF raster images
MBTILES Mapbox tile sets often exported by
QGIS
JMTILES Map cache tiles downloaded from
online sources.
WFSDB Downloading WFS maps generates
WEFSDB tiles.
IPG JPG image files with JGW world file.
INS polylines

Once a map file is attached to your project, it is possible to
change the opacity of the image. Click on a Map file, slide it

to the right:

m ."_ﬂl ' ' lrizag e Tmage_ g
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Weadh Ly k Online sap
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Click on the transparency button n to set the layer
transparency:

Tranapare
Canpel 1
then click OK.
Click on the ﬂ button to view the layer:
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0 % transparent

Online map (tab)

The Online map tab allows control of the live online map
backgrounds available from several sources. Selecting a
source will automatically download map tiles as needed to
create background coverage for your visible area and zoom
level.

Once downloaded, the map tiles are kept with the project
forever.

From this menu, it is simple to download background maps
onto your device to eliminate the need for internet data
while surveying.
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Click on a map source, then slide it to the right:

-

then click on the download button u
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Details: Project (tab) > Import

Select a reasonable layer name, Min level and Max level.
Click OK to begin downloading tiles. Converted tiles are
stored in the JMTiles format.

Deramioading

Wait for the download to complete. Before you leave the
Online map tab, uncheck the downloaded map layer:

WMok larpirs P s

) Google irage ;)

The Online map is displayed on top of the downloaded map
and will occlude any transparency settings you make. The
downloaded map will now be listed on the Mabp files tab:

Wark |pvan Cnline map

" Googl img 5

Import data in a variety of formats (Text, DXF, DWG, SHP, KML, KMZ, TIFF, MBTILES (Global Mapper), Imtitles (CHCNav),
WEFSDB (CHCNav), JPG, INS) to the Entered Point list, Control point list, Points to stake list and the CAD view.

The Text file importer allows the generation of custom file formats containing: Name, Code, Northing, Easting,
(orthometric) Elevation, Longitude, Latitude, (ellipsoid) Height, Description, and skipped items. The text file importer
understands: .CSV, .TXT, .DAT, .XLS and .XLSX file formats with comma, semicolon, space and multi-space delimiters.

The format ‘USA: P,N,E,Z,D’ is the correct format for 99% of applications in the USA.

Available from the Project (tab) > Projects tab:

:
L . mport

There are two tabs: Text file and Other formats. Choose
Other formats for .DXF/.DWG, .SHP, .KML/.KMZ, .TIFF,
MBTiles, Jmtiles, WFSDB, .JPG and .INS files.

The most common file type is .TXT with the format:
PointName, Northing, Easting, Elevation, Code,
Description

It is possible to build import file profiles for any text file.

LandStar 8 User Manual
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First choose the Point type to import. Entered points are
design points, Control points are typically site control points
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and Points to stake are placed in the Points to stake list as Clicking on Add format presents a list builder:
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There are several default Format types: "
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The Selected column defines the expected fields and order.

Harmia Bl H [ ea (0 Te0 G0S0a7)
If you attempt to import points with Point names that

Pl LM [* cay) el disdeiad g 3, already exist, LandStar will prompt with replacement Point
names or you can choose to Override (replace) the existing
Mams L H [ty (de-meees ssems | [} points:

T ——
Or you can use Add format to define custom profiles.
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Details: Project (tab) > Export

Export data writes output files in text or standard formats in a variety of styles. The formats ‘USA FULL: P,N,E,Z,C,D’" or
‘USA: P,N,E,Z,D’" are the correct format for 99% of applications in the USA.

Available from the Project (tab) > Projects tab:
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m > Expor

Use the “ Format button to choose or define (see the Import function above) an export Format and filetype.

It is possible to choose the types of points to export:
Survey surveyed measurements.
Enter entered, imported and COGO result points.
Control entered or measured Control points.
Base Base points that were used during the project.

Filter -Measurement time allows a sub-set of points by acquisition date to be exported. For example, only points measured
Today can be selected for output.
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Enabling Filter - Keyword:

—— &
Mt
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allows selection by matching Name, Code, Description or just the points measured with a particular Base. Setting a few
characters for Name will match any Name that starts with the entered characters. For example: Name = ‘P” will match P12,

P101, P240, and Pnt100.
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Click Next to choose a directory location to place, and a Name for the exported file:
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Enabling Share:
Share [

will prompt for an Operating System share method:
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which allows sharing by email, text messages, Google Drive and other supported methods.

OS Sharing is controlled by the Share method setting, see [ Share method ] on Page 28 for additional information.

Other formats Export

LandStar directly exports projects to these additional formats:

DXF CAD Drawing Exchange Files
DWG CAD Drawing files
SHP GIS Shape file
KML Keyhole Markup Language: exports projects directly into Google Maps
KMz Compressed KML, useful for embedding pictures with point and line objects.
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Detailed result

CSV text formatted file containing detailed measurement point information with all
attributes like coordinates, estimated errors, GNSS related information.

Survey report
(HTML)

HTML formatted file containing detailed measurement point information with all
attributes like coordinates, estimated errors, GNSS related information.

Point stakeout
result

Includes target points, measured points, and stakeout errors.

Attribute
data

CSV text formatted report containing measured points, line coordinates, and user-
defined GIS attributes.

Attributes data
(Excel)

Attribute data report in Excel format.

Pipeline survey
report

Pipeline survey report, including the location and burial depth of the pipeline.

Hydro survey
report

Hydro survey report, including measurement coordinates and water depth.

Polish

Cadastral survey reports used in Poland.

RAW

A GPS measurement data exchange file format used in Turkey.

MosGoGeo-Raw

A GPS measurement data exchange file format used in Russia.

Measurement
report

Point survey report for averaged points

Area report

Area survey report, includes both a PDF file and a DXF file.

Verified survey
report

Lists Verified points with all measurement group’s tabulated data.

Star*Net report
(.dat)

.DAT style StarNet import data file.

Star*Net report
(.GPS)

.GPS style StarNet data file.

Trimble JXL (.jxI)

Trimble style XML data file with GNSS vectors for importing into TBC.

LandStar 8 User Manual
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If exporting StarNet or JXL files, it is best to enable Record GNSS Vector under Settings > Survey:
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Details: Project (tab) > Surfaces

Surfaces can be used in Volume calculations and staked for Cut/Fill. The Surfaces manager allows direct import from CASS
triangulation files, HC triangulations files, 3D DXF (.dxf) files and LandXML (.xml) files or surfaces can be created from a
single point or a list of points that define a surface. Breaklines and boundaries are also supported for developed surfaces.
The Surface manager allows granular control of the triangle networks used to approximate a surface.

Once a surface is defined or imported, use the Survey: Stake surface tool to stake them. See [ Details: Survey (tab): Surface
stakeout ] on Page 137 for more information.

The Surface manger is launched from:

CHCHN &Y 90 LandStar 8 User Manual



If no surfaces have been defined yet, the manager list will be empty:

¢ VolumeDemo-Surfaces (1)

' -

Click Open to import an existing surface file:
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Cancel ]

CASS triangulation files are generated by the South Surveying CASS tool. HC triangulation files (.hctx) are LandStar exported
surfaces. 3D DXF are standard .dxf files with 3D points from which surfaces are built, LandXML are .xml files with developed
surfaces.

Click New to generate a new surface from points available in the Points list:
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Surface Tk
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By default, generated triangles are optimized. You can change this behavior by clicking the ! 3-Dot button on the upper
right, then Disable triangle-optimization:

Fiarrs Eealde riongieopEmeiaiem
Leaving it enabled is reasonable for most point sets.

Give the new surface a descriptive Name. Points can be selected by:
F -
Poins

Skt Froarm par
kit Thiwe ieag

Mg 2! pravds

Selecting from the Point list by checkbox, selecting from the CAD view map, or by specifying a Range points:
Mame

100 -5 o

Cancal

If you specify a range of points, you must enter <space><hyphen><space> as the name separator. LandStar names can
include the hyphen (minus-sign) character.

Breaklines can be specified by selecting existing lines from the CAD view. Boundaries can be selected by choosing existing
boundaries from the CAD view. Typically, both will be left unspecified.

Surface stye can be Wireframe (default) or Shade. The surface color can be manually specified or automatically defaulted
to the layer color for the first point.

Click OK to compute a triangular network from the included points, breaklines and boundaries:
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The buttons in the Tool tray on the left allow editing of the developed surface:
L 20 0 of 2D, 3D or Map view. 3D allows tilting and spinning the surface.

[
we Zoom to view the extents of the surface.
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Automatically filter the points used in the network by side length ratio and internal angle ratio:
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The Minimum angle and Longest/shortest ratio settings may change the resulting triangles.
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The difference between automatic and manually optimized surfaces typically is very small.

L l\/lanually add a triangle between two points:
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Manually delete a triangle.
a8 Flip the triangle direction:
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L Manually add new triangles.
=
& Switch from Wireframe to Shaded and choose the Surface color:
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Wireframe Shaded
™o Toggle the Point name and Point elevation on and off:
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to I Delete, Share to CHCCloud, Share to Gmail, Messages ..., ﬁ Change Wireframe/Shading options or @
View.
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Details: Survey (tab) > Map Survey

Available from the Survey, Map survey button:

'@
L Map suréey

Map Survey provides point and line survey with an optional background map.
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By utilizing the Quick access tool button = it is possible to perform nearly every survey and stakeout function from this
single Map Survey screen.

Back

Clicking on the Back button . returns to the Main Survey menu.

Status

The top Status line:
)

Is described here: [ Instrument Select & Status information ] on Page 49.

Point Names

Points are collected and organized by Point Name. The Point Name box: _: | holds the name for the

next point that will be stored next. The Name automatically increments by the Auto increment name interval which can be
found under Settings: Survey (tab) | Store.

Some users prefer to use numeric names only: 1001, 1002, 1003. Some users prefer to use names like WTR1, WTR2, WTR3.
Any format is fine. Names can include numbers, letters, and many symbols other than the space character.

Since it is possible to enter distances, azimuths and bearings using Point Name Math: “1001,1002/3” (one third the
distance from point 1001 to 1002) it may be simpler to keep Names simple.
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Antenna Height

Clicking n opens the Antenna height menu:

Eip LA

oW I

You can enter alternate units, if your range pole is 2 meters and your project units are iFeet or USFeet, enter “2M” which

will convert to “6.562 USft”. You may need to clickthe ~  button to switch from a numeric only keyboard to an alpha-
numeric keyboard.

The Antenna height menu keeps the 10 most-recently-used antenna heights so that you can quickly switch between
standard heights.

Point Code

Clicking in the Code area n ’ | allows you to use a keyboard to enter a point Code. Codes can include
numbers, letters, spaces and these symbols “@#S_&-+"; other symbols are not allowed. As you type a Code, matching
Codes will be displayed in a picklist.
Clicking the down arrow ~ displays a list of known values from the current Code list.
You can use the question mark “?” to separate a Code and Description. For example, entering:

“RBC?Found rebar with cap”
results in a point with Code = “RBC” and a Description = “Found rebar with cap”.

If you enter a new Code, it will be added to the current Code list. Optionally you can automatically add a matching CAD
Layer.

The complete project Code list can be maintained from the Main Project: Codes menu.
Point / Line

Click on m or “ to toggle between storing a point or a line. Once points (vertices) are stored into a line
feature the Line Control panel will be shown on the map screen:

N O X %«
N Switch to the Drawing manager to switch between active lines.

c

Close the current line to make a closed polygon.

CHCHN &Y 96 LandStar 8 User Manual



Break the current line, the next stored point will be on a new line.

-
Delete the last Point or Line segment.

If you are collecting one line or points, you can also switch to another existing line by clicking it on the Map.
Quick code panel

To enable the Quick code panel, click on . then | Code and enable Use quick codes:
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You can also set the number of Quick code pages which hold 9-codes per page. Click the back button to return to the
survey screen.

Below the Point Code box, there is an expandable Quick Code panel area. Click, hold and drag the slider down:
[ ' ——]
to reveal the Quick code panel:

e 1

You can swipe the panel left and right to access multiple pages of codes. Click and hold on a button to change or delete the
associated Code.

When you click on a Quick code button the code is applied, a measurement is immediately made using the currently
selected method (Topographic, Quick or Corner). If Confirm before saving is enabled the measurement confirmation screen
will be shown. The point number is automatically incremented after a Quick code measurement, leaving the controller
ready to take another measurement.

Sharing CODES and Quick Code buttons assignments

From the Project: Codes function, click the H 3-dot button (three dots upper right corner) and Share. This makes a XML
file and the file holds all of the current code library AND the Quick Code assignments. The share button also links to all of
the system sharing options (like GMAIL or MESSAGES).

On the receiving end, you can use the same H 3-dot button and Import from Code Library or you can manually pick the
shared file when you make a new job.

The Code Library contains the Quick Code assignments in addition to the CODES.

Survey mode

Three Survey modes are selectable using the Survey mode button:
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Topographic, usually a 5-second average

=)

Quick survey, a 1-epoch measurement

There are two additional dedicated survey types available from the main Survey menu:

Corner survey, only available for receivers with an e-bubble (i80,iG8,i50)

Control survey  useful for measuring important control points. Utilizes multiple dumps with multiple averages. Will
abort if predetermined tolerances are not met.

Verified survey  useful for measuring verified results in heavy canopy where bad fixes are expected. Uses multiple
dumps, multiple averages, potentially spread over multiple occupations. Post-measurement control of
used measurement averages with variable tolerances.

Start measurement
Click the Start measurement button to take a measurement as determined by the Survey mode.

Lo
Start measurement

At the end of the measurement, if Confirm before saving is enabled a screen that confirms and allows additional attributes
to be entered will be shown.

Information panel
At the bottom of the map screen there is a small semi-circle with an up facing arrow:
Click and drag up on this panel to show the Information panel:
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You can click on the small corner triangles 4 to choose the value shown in each panel. The available values are:
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If you need additional map space, click on the down arrow:
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to collapse the information panel.

Offset survey (hidden point survey)
1" Ottnet survey

Available in Map Survey and Point survey. Allows the measurement of a location that cannot be directly occupied.

These 5 methods allow measuring a hidden point by occupying one or two points, with a variety of offset and direction
methods:

Each method is described below.

Most of the offset methods allow you to take a temporary reference point. Clicking the GNSS acquire button will
display the GNSS measure dialog:

Measure

Artonig hesgtn

Canoel

which allows you to choose an Averaging period and an Antenna height, while showing the current GNSS status (FIX, Float,
DGPS, Autonomous) and horizontal and vertical estimated measurement error.

Offset Distances can be manually entered or measured with a rangefinder -
Elevations of offset points can be entered by:
direct entry of the target point elevation “5602.352".
delta elevation  from the reference point “-2.342” at the target point.
Vertical angle  applied from the reference point towards the target point.
Zenith angle  applied from the reference point towards the target point.
Slope 1:N (ratio) applied from the reference point.

Slope % applied from the reference point.
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Point survey: Distance + Azimuth
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Measure a hidden point which is a known distance and known azimuth/bearing from the measured point.

Pick a Reference point by:
pick an existing point or object (with snap) from the CAD view.
take a GNSS measurement.

choose an existing point from the Point list.

Then specify:

Horizontal distance optionally use a laser - rangefinder.

Elevation by direct entry, delta elevation from the reference point, Vertical angle: applied from the reference
point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

Bearing/Azimuth the direction to offset.

After specifying the offset parameters, click on Result. A new point dialog with the next available point number selected as
the Name will be displayed, click Save to accept the point and add it to the Point list.

Click Result to reach the new point dialog with the computed offset location:
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally
press Save to add the computed offset point into the project Point list.

Point survey: Alignment Offset
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The Alignment offset method allows you to specify a line between two points. The Reference point determines which end
of the line chainage starts at and can be either the Start point or the End point of the line. An offset right or offset left with
a specified or offset elevation is then applied. (See the Turned angle distance for an arbitrary offset angle.)

You can use these methods to specify the Start and End points.
pick an existing point or object (with snap) from the CAD view.
take a GNSS measurement.

choose an existing point from the Point list.
Then specify:
Horizontal station: this is the distance from the Start point or End point along the line to an intermediate station.

(Optionally use a laser - rangefinder to set this distance.)

Elevation by direct entry, delta elevation from the reference point, Vertical angle: applied from the reference
point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.
Offset Left or Right

Horizontal distance the distance to offset left or right.

After specifying the offset parameters, click on Result. A new point dialog with the next available point number selected as
the Name will be displayed, click Save to accept the point and add it to the Point list.

Note: the Start and End points do not need to be named points or in the Point list. They can be temporary measured
points, as needed.

Start point: 1001

End point: 1002
Horizontal Station: 247.77
Offset Right

Offset distance: 69.16
New Point name: 3

New Point description: Offset Point
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Click Result to reach the new point dialog with the computed offset location:
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally
press Save to add the computed offset point into the project Point list.

Point survey: Distance-Distance Intersection
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Distance-distance intersection allows the user to select two points, with a distance from each, to specify a 3" hidden point.
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You can use these methods to specify Reference point 1 and 2:
pick an existing point or object (with snap) from the CAD view.
take a GNSS measurement.

choose an existing point from the Point list.

Note: Reference points do not need to be named points nor be in the Point list. They can be temporary measured points.

Each Reference point has an offset (typically a hand-taped) Horizontal distance. You can optionally use a laser -
rangefinder to measure the Horizontal distance for each position.

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

Two projected elevations are derived, one from each Reference point. The average of the two derived elevations will be
used for the stored point.

Click Result to reach the new point dialog with the computed offset location:
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally
press Save to add the computed intersection point into the project Point list.

Press the Result button to complete the intersection computation, a prevue of the two possible solutions will be shown:
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click one of the Target points to select, the selected intersection will be highlighted red.
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Click the E Green OK button.
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally
press Save to add the computed intersection point into the project Point list.

Point Survey: Turned angle + distance (with skew)

This hidden point procedure allows you to offset a new point, at a distance and azimuth/bearing from a measured point.
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You can use these methods to specify the Start and End points of the alignment line:
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pick an existing point or object (with snap) from the CAD view.
take a GNSS measurement.

choose an existing point from the Point list.

Note: these do not need to be named points nor be in the Point list. They can be temporary, measured points.
Choose which end of the line (Start Point or End Point) to offset from.

The Offset direction can be Left or Right of the line, with respect to the direction (Start to End) of the line.
The offset angle can either be Perpendicular (90 degrees) or Ahead or Behind at a skew angle:

i

|aapa ks L

Perpendicular is equivalent to a 90 degree Ahead or Behind angle:

skew behind 45 deg

The skew angle is with respect to the direction of the line.
Offset distance is the distance from the endpoint. You can optionally use a laser - rangefinder to measure the Offset
distance.

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

Click Result to enter the new point dialog with the computed offset coordinates:
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The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally
press Save to add the computed offset point into the project Point list.
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Point survey: AX + AY + AZ
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Store a hidden point by picking a Reference point, then offset from the point (in the projected coordinate system space) by
fixed values.

You can use these methods to specify the Reference point:

F

pick an existing point or object (with snap) from the CAD view.
take a GNSS measurement.

choose an existing point from the Point list.

Note: Reference points do not need to be named points nor be in the Point list. They can be temporary measured points.

The X and Y offset (typically a hand-taped) Horizontal distance is manually entered. You can optionally use a laser -
rangefinder to measure the X and Y distances.

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

Click results to reach the new point dialog.
|
1

Lerde

Wrih (M)
M 1T ih

Faret ]

TAIOEET 3T USH

Dlwantizn

ST IR0 LEN

s

2thi -

LandStar 8 User Manual 107 CHC W&



The next available Point Name will automatically be assigned. Optionally, select a Code and enter a Description, finally
press Save to add the computed offset point into the project Point list.

Details: Survey (tab) > Point (text) Survey

Available from the Survey (tab) > Point survey button:

o,
]
::'..I

The Point survey function is very similar to the Map Survey function (see [ Details: Survey (tab) > Map Survey ] on Page 95).
However, Point survey has no background map:
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Tools available for use with the Point survey - Tool bar are:

The Map Survey Tool can be Selected to quickly switch to the Point Survey (with background map) function.

Details: Survey (tab): Visual survey

Available from the Survey (tab) > Visual survey button:

N =

> Wil Sudfvey
This survey tool will capture 2 to 4 cm accurate N, E, Z positions for features that can be seen, but not physically occupied.
A series of pictures are recorded, processed and then any number of features can be extracted. The processing and feature
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extraction can be completed in the field or performed later. The vision tasks can be queried for features as needed even
after the fieldwork has been completed.

Features further than 15 meters can be captured, however accuracy is best if the distance from the receiver camera to the
object is less than 15-meters. The path of photo taking greatly contributes to the accuracy of the results. If features can be
seen in oblique photos, just like an optical survey resection, the results will have a stronger solution.

A vision enabled receiver like the i93 is required to use Visual survey.

Click the Visual survey button from the main Survey menu to get started.

or Back returns to the Main Project Survey menu tab.

The current GNSS receiver status is shown on the top receiver information bar _ See [ Status ] on
Page 95 for additional information about the Status bar.

mll'.

shows the task name that the next Visual survey result set will be stored under. You can change the default name to better
represent the feature.

-

Y

For Vil

Fre 00 kzrising

The Survey type selects between Visual Survey which is processed on the data collector and 3D Modeling which stores
pictures in anticipation of processing in the cloud or in external software. Most users will use Visual Survey.

It is important that the Instrument heightm be entered correctly as an accurate IMU initialization is needed to stich
the acquired images together. See [ Antenna Height ] on Page 96.

Click the Record button E then a 3-second countdown will begin:

~

When the countdown completes, begin moving the receiver along the path that you want to record:
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2-pictures per second are acquired. A minimum of 8 pictures are required to process a task. There is a 60-second maximum
per task limit. A 5-second minimum recording time is enforced because the processing software may throw out pictures
that are repeated or algorithmically determined to be defective. Features that you want to capture need to be common to
at least 3 pictures, so it is best to start before the first feature you want to store and continue past the last feature of
interest. There needs to be some high contrast features in each of the pictures, so images like sand on a beach won’t
normally process.

Hold the receiver pole upright while moving. If the tilt exceeds 30-degrees recording will terminate. Try not to catch the
pole tip on the ground as you move, it will trip the receiver and recording will terminate. Try to move in a steady flow while
acquiring pictures.

—
At the completion of acquisition, click the Stop recoding button. Visual survey will save the images to the new visual
task, then ask:

Irnages o oaved. proessT

Laiei

Click Later if you want to process and select points from the images later, click Now to begin processing immediately.
Processing will take 2 to 3 time the collection period depending on the speed of the field controller.

ProiCnlieir

[ s

When image processing completes:

PG g CDFhra bl
mislduia il O diagei
frow 1

Mo

Click Yes to extract features now. If you click No, you can return to the Image list at any time to extract additional features.

The Measure dialog will be shown:
« Job |- Meanure- Tashs
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It is usually best to select the 3™ or higher image (on the top band), zoom into the image (by pinching), place the crosshairs
on the feature you want to save:
Job 1 Meunure- Tashi

ey

The coordinates, with the estimated horizontal error: 2D Q will be shown. If the measurement is acceptable, click on Save

to add the measurement to the project Point list:

Save point
Tvar~e s

~ SATIESL |38 USH

Bt 1 1540790 17T Unn

I a0 omn

Crcnl

Edit the Name, optionally assign a Code and Description, then click OK.
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Sometimes, you might pick a point to measure and receive a Measure failed message when you click the Select button:
- - _— ’. »

- . b -

e |adee

When this happens, select another image that contains the same point. An orange line will indicate the plane of the point
you are attempting to measure to assist in zooming in to the same spot on the new image. Click Select and the measure

should be successfully captured. This procedure binds coordinates to the first image and makes additional locations on that
image easier to capture.

All visual measurements will be shown on all the photos where they are visible:

Visual survey Images list

« Job 1 -images (1)

_—
The E button on the Visual survey function is the same as clicking the === button from the main menu Project (tab) and
displays the Images list. All the Project’s Visual survey tasks are listed.

Click the Delete button then check the tasks to delete to cleanup unneeded tasks.
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You can reopen Visual survey tasks to measure additional points in them.
Tasks that have not been processed will be listed as Unmeasurable. Click on the task, the click Local Process
to prepare the task for point selection and make the task Measurable.

Processing takes about two to three times as long as the recording time. A 15-second image task will take about 30 to 45-
seconds to process.

Details: Survey (tab): Control survey

Available from the Survey (tab), Control survey button:

U

-5
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Ilf " S Coniral sureey

The Contraol survey tool automates acquiring multiple groups-of-averages, automatically resetting the GNSS engine
between groups, and performing statistical combination of the measured epochs.

The intended use of the Control survey tool is to acquire very reliable coordinates under open canopy where the receiver is
expected to never encounter a bad fix. The Verified survey is better suited for locations where bad fixes or the inability to
fix may be encountered.

The Control survey function differs from the Verified survey function:

e Control survey is intended for use in open canopy where there will never be a ‘bad FIX’.

e  Control survey does not allow post collection group selection. If a bad-FIX is encountered, the entire control point
must be recollected.

e Verified survey is intended for use in heavy-canopy where bad FIXs are expected.

e Verified survey will automatically pause if the constellation quality degrades or a bad-FIX is encountered. Control
survey will stop and abort if the tolerance conditions are not met.

It is not possible to add additional measurement groups to a Control survey, it is easy to add additional measurement
groups to the Verified survey.

Control survey operation

Click the #===i=== hytton on the main survey menu:

[
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When you first enter the Control survey, first click the Options s button, the settings will be shown:
- back-1-Settings
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Number of passing measurements to acquire. Each group is separated by a GNSS engine reset and the Wait after fixed
time.

Each group will include Point per measurement group points.

Each point will include Number of epochs per point epochs. (An average of averages is collected.)

Groups with a horizontal range greater than Group horizontal range tolerance will be remeasured automatically.
Groups with a vertical range greater than Group vertical range tolerance will not be remeasured automatically.

If the receiver reports a Hrms value higher than the Epoch maximum Hrms, collection will wait for a lower Hrms.

If the receiver reports a Vrms value higher than the Epoch maximum Vrms, collection will wait for a lower Vrms.
Wait after fixed is the time that collection waits after the receiver acquires a fixed solution after the receiver is reset.
Max PDOP is the maximum Position Dilution-of-Precision allowed before collection is paused.

Between each measurement group, the GNSS engine is reset. This forces the receiver to completely reacquire a new
position. After the receiver reacquires satellite tracking, resolves ambiguities, receives corrections, and computes a FIXED
solution, group collection waits an additional Wait after fixed time before starting to acquire epochs. This is intended to
allow the receiver to further stabilize to a more accurate value.

Percent of pass is a confidence interval specification for the statistical reliability of the final result.

After configuring the Control survey specific settings, enter (or accept the default) Point name and Code:
87

Double-check the Instrument height:

The IMU is always disabled during a Control survey.

At the bottom of the map screen there is a small semi-circle with an up facing arrow:
e
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Click and drag up on this panel to show the Information panel:

-
SeiuFid Jdd e LI
i 4
ik I 10T
O &
] - Rl
B - e

See [ Information panel ] on Page 98 for details on how to customize this panel.

L
Finally click the Begin survey button to start acquiring measurement epochs. The Control survey will start following the
rules established in settings. Information on the progress of the Control survey is updated continuously:
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At the conclusion of the Control survey a detailed report on the measurements is saved to the job folder:
/storage/emulated/0/CHCNAV/LS7_Projects/_jobname_/Control report/pointname_yyyymmddhhmmss/

Two files are created. An .HTML report and a .CSV detailed result data file.
The completion dialog will be shown after the reports are saved:
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Cancel

Click Open report to view the report:
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The report includes a list of every measurement with deviations from the final averaged coordinate in both projected
(N,E,Z) and geographic (L,L,H) coordinates.
The final computed position is added to the Point list with a unique point icon:

&

Details: Survey (tab): Verified survey

Available from the Survey (tab), Verified survey button:
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E Verified survay

The Verified survey tool automates acquiring multiple groups-of-averages, automatically resetting the GNSS engine
between groups, performing statistical and graphical analysis of the results to reject bad-FIX and average good-FIXED
measurements.

The intended use of the Verified survey tool is to acquire very reliable coordinates under extremely heavy canopy where
the receiver is expected to encounter many bad fixes.

The Verified survey function differs from the Control survey function:
Control survey is intended for use in open canopy where there will never be a ‘bad FIX’.

Control survey does not allow post collection group selection. If a bad-FIX is encountered, the entire control point
must be recollected.

Verified survey is intended for use in heavy canopy where many bad FIXs are expected.

Verified survey will automatically pause if the constellation quality degrades or a bad-FIX is encountered. Control
survey will stop and abort if the tolerance conditions are not met.

Verified survey makes it easy to add additional groups later, perhaps over several days.

Verified survey allows inspection and post inclusion/rejection of groups.

=" =
B8 ]
.
] ot
- s ] =
Verified survey generates real-time horizontal and vertical plots that show acquisition progress.
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Plots are also available for post analysis of the included measurement groups.
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Verified survey operation

¥ =
|

Click the === pytton on the main survey menu:
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The Verified survey screen has a group summary area:

L 32 Padirin: T371240
Hrmy D 0040 LiEH Vi i Q08 USSR
PODE 1 464 [T e |
Mo DO N V s SO LR

H P 0008 UBAL V Bange O 0% UED
W MBS NI USH [ FIN0GOT SA5 USh
Elerwaliint D68 L4

The drag bar at the bottom of the summary area can be moved up and down as needed to view the entire summary.

The Group shows current group / initial number of groups. The current group will be larger than the initial number of
groups if you decide to collect additional measurements after the initial collection.

Points is the current number of points / target point count, for the current group.
Hrms Vrms are the current horizontal and vertical estimated errors reported by the receiver.
PDOP is the current Position Dilution-of-Precision reported by the receiver.

DIFF age is the correction latency (the number of seconds since a valid correction was received by the receiver) reported by
the receiver. Typically, it will be less than 3-seconds.

H o is the standard deviation of all the included horizontal epochs taken for the current point name.
V ¢ is the standard deviation of all the included vertical epochs taken for the current point name.

H Range is the horizontal range of included measurements taken for the current point name:

L] FE e )

V Range is the vertical range of included measurements taken for the current point name:
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When you first enter the Verified survey, first click the . Options button, Survey settings will be shown:
Daglay  Toaks WY E-Bub

Survey method
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Nominal Number of measurement groups to acquire. Each group is separated by a GNSS engine reset and the Wait after
fixed time.

Each group will include Point per measurement group epochs.
If the receiver reports a Hrms value higher than the Epoch maximum Hrms, collection will wait for a lower Hrms.
If the receiver reports a Vrms value higher than the Epoch maximum Vrms, collection will wait for a lower Vrms.

DIFF age is the maximum correction latency allowed before collection is paused. Typically, GNSS measurements with higher
differential age have lower accuracy.

Max PDOP is the maximum Position Dilution-of-Precision allowed before collection is paused.

Between each measurement group, the GNSS engine is reset. This forces the receiver to completely reacquire a new
position. After the receiver reacquires satellite tracking, resolves ambiguities, receives corrections, and computes a FIXED
solution, group collection waits an additional Wait after fixed time before starting to acquire epochs. This is intended to
allow the receiver to further stabilize to a more accurate value.

Note: Show E-Bubble: enables the E-Bubble on the display screen. This is only applicable to receivers with an E-Bubble or
an IMU like the i50, i80, i70. 190, 193, i73, i83, iG8, iG9. The E-bubble is not related to the IMU which is forced inactive for
Verified survey.
After configuring the Verified survey specific settings, enter (or accept the default) Point name and Code:

Plarme: RINIEE

Code

Double-check the Instrument height:
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The receiver IMU is always disabled for Verified survey, it is important to carefully level the receiver.

¥
Finally click the Begin survey button to start acquiring measurement epochs. The Verified survey will start following the
rules established in settings:
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Click the @ button while points are collected to display scatter plots for the horizontal and vertical measurements:
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At the conclusion of the last automatic group, click the Edit last point = button to display the results of the Verified
survey:
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Select the 2" tab Average to view the results of each collected group:
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Drag the top section right and left to reveal the report columns for the measurement groups:
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Enable and disable group contributions to the average by checking and unchecking the Hand V ™.
Use the H Res and V Res values to find bad FIXes and remove them from the final computed point.

Sort the groups by clicking on the sort icon . at the top of each column.
The bottom portion of the Average tab has three panels.
Switch between the panels by swiping left and right:
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These panels reflect only the included measurement groups, they automatically update as groups are included and
excluded in the group table.

Adding additional measurement groups to a Verified survey

After a Verified survey operation successfully stores a result into the Point list, you can add additional measurement
groups.
Reoccupy the mark, then return to the Verified survey screen and either type in the same Point name or click on an existing

Verified survey point then click on d Begin. LandStar will verify that you want to add to the existing point:
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If you have already collected the Number of measurement groups specified in the Verified survey options but would like to
automatically collect several additional observation groups, return to Options and set the Number of measurement groups
to the new desired total.
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When you click on - Begin automatic group collection will continue until the new desired number of groups has been
reached.

Verified survey screen details
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Clicking on the Back button - returns to the Main Survey menu.

Status

See [ Instrument status ] on Page 49 for detailed information on the status and information screens.

Point Names

Verified survey points groups are collected and organized by Point Name. The Point Name box: - 1207

holds the name for the group that will be collected when the Start measurement " button is pressed.

Unlike other survey modes, the Name does not automatically increment, this facilitates collecting additional groups into an
existing averaged point.

Antenna Height

Clicking n opens the Antenna height menu. See [ Antenna Height ] on Page 96 for additional information.
Point Code

Clicking in the Code area “ ’ | allows you to use a keyboard to enter a point Code. Codes can include
numbers, letters, spaces and these symbols “@#5_&-+"; other symbols are not allowed. As you type a Code, matching
Codes will be displayed in a picklist.
Clicking the down arrow ~ displays a list of known values from the current Code list.
You can use the question mark “?” to separate a Code and Description. For example, entering:

“RBC?Found rebar with cap”
results in a point with Code = “RBC” and a Description = “Found rebar with cap”.

If you enter a new Code, it will be added to the current Code list. Optionally you can automatically add a matching CAD
Layer.
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The complete project Code list can be maintained from the Main Project: Codes menu.

Real-time plot

S e B

While groups are being collected it is possible to display real-time result plots. These plots show all of the enabled

measurement epochs. (You can disable groups in the Edit Point, Average tab.)

When showing the map screen, clicking the @ button will switch to the combined horizontal and vertical scatter plots:
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clicking the 5 button will switch to the vertical timeline plot:
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will return to the point display map:
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On these plots, the blue ellipse and background are 1-sigma, and the green ellipse and background are 2-sigma indicators.

Start / stop measurements

Click the Start measurement button to begin acquiring epochs for the next group.

L
= Begin measurements

After measurements have started, the button changes to:

e

Stop measurements

Clicking Stop measurements aborts the current measurement group after a confirmation.

Information panel

See [ Information panel ] on Page 98 for additional information on the Information panel:
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Details: Survey (tab): Point Stakeout

‘Staking out a point’: using assisted navigation to move to a point’s known coordinates so the location can be marked by a
stake, flagging, paint, whiskers, or other monument. Point stakeout provides a horizontal position and the deviation
(cut/fill) to a target elevation. After setting a monument, typically the ‘set’ location is stored as an ‘as staked’ position for
verification.

Offset staking allows you to stake a point that is offset from the selected point. There are several methods to specify an
offset in LandStar.

There are several ways to begin the stakeout process. From the Survey (tab), Point stakeout button:
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Then manually click in the Point to stake box and select a point to stake. The Stake point menu has many of the same
features and buttons as the Point survey menu.
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Clicking on the Back button . returns to the Main Survey menu.

Clicking icons on the top receiver information bar _ displays status information about the currently
connected receiver. See [ Status ] on Page 95 for information on the receiver information bar links.

The Point to stake box displays the Name, Code and Description of the point that is currently being
staked. If the Name, Code and Description are too long to be shown in the box, click and hold inside the box to expand
them:

1,50 MW C Bec 22

Clicking on the - button displays the Point list or Point to stake list allowing an alternate target point selection.

Clicking n opens the Antenna height menu. See [ Antenna Height ] on Page 96 for details on entering and selecting
the Antenna height.
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The Name box u"'h L d displays the Name that will be assigned to the measurement that will be collected when

the Begin measurement ~ button is pressed. The default staked Name is controlled by Settings: Stakeout (tab): Point
name prefix.

The Code box “ " lists the Code that will be associated with the new measurement. Clicking “ displays the
full Code list. Clicking the - opens the keyboard and allows you to type in the first few characters of the desired Code.

Clicking the ~ button allows picking the code from the MRU (Most Recently Used) list.

The Target Information panel can be swiped left and right:
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The left panel shows the distance forward/reverse and left/right based on the direction the Android device is facing. The
right panel shows the North/South and East/West distance.

The Staking control buttons = include:

e
L5

Cancel stakeout operation.

o

North reference:

4

toggles the Navigation compass on and off:

The compass shows the current direction of travel, the target and a North reference.

Collapse the Staking control buttons.

A simple Scale bar * “is shown in the upper-right corner of the map.
The Stake next, Auto-nearest, and Stake last controls T allow switching to the previous , next
points from the Point list or Points to stake list. The Auto nearest AR toggle, when depressed, will

automatically switch to continuously staking the nearest point to the current position.

The Information panel T — can be expanded to display real time coordinate
information. See [ Information panel ] on Page 98 for details.

Storing the results of the Stakeout

Clickon — Start measurement button to measure a point at the current location.
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The stored point will include the stakeout offsets and cut and fill value from design (Staked) point to the measured point.

Auto description for staked points

When you stake a point, the description of the new staked point can be automatically populated, or it can be left blank for
the operator to manually fill out.

To control the Auto description, go to Software settings > GNSS > Stakeout (tab) > Auto description >
DL e ALY SEstIPLOY
Ao Sewciiption ]

Click on the > button:

L Bls Sascrplan

Move the slider to the right to enable Automatic descriptions:
£ o descriplion
I BLILE [T [
o et
ks P g [ ifs
inke M Mars
B e

Highlight an Item line, then use the “ Up and “ Down buttons to change the order of items.

Highlight an Item line, then use the entry box at the bottom to modify the Prefix, click the Update button to commit
change.

The i OneOR On/Off checkbox enables / disables the highlighted item.
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Visual Stakeout

If the current device is a visual receiver like the CHC i89 and i93, an AR (Augmented Reality) button & will be shown on
the map screen. Click on this button to enter the AR mode.

Once activated the AR button will change color: " toindicate it is enabled.

Your data collector must be connected to the receiver by 5 GHz Wi-Fi (not Bluetooth or 2.4 GHz Wi-Fi) for the Visual survey
and Stakeout functions to work.
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In Options » on the Stakeout tab, under miscellaneous there are Distance to switch to Visual Stakeout (Near) and
Distance to switch to Visual Stakeout (Far) settings. Setting the Near distance to 8 to 25 feet is reasonable. Setting the Far
distance between 50 and 300 feet or more is reasonable. Your settings may depend on site terrain and personal
preferences.

If you are further than the Far distance, LandStar will show the map screen with optional map backgrounds. If you are
between the Near and Far distance, LandStar will show the front facing camera. Once you reach the Near distance from the
stakeout point, the bottom facing camera will be shown. As you move closer to the point being staked, the view will
automatically zoom in to better show the target point on the ground.

v
—
i

»

o @ 311

Map screen Front Facing camera view Bottom facing camera view

A virtual pole is overlayed on the image (usually on top of the data collector bracket and your hand) to assist visualizing
where the pole point is. The number of blue arrows is proportional to the distance to the target.
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The distance, cut fill along with the AX, AY or forward/left/right (depending on the panel settings on the map screen) are
updated continuously:

L
Click on Start measurement button to measure a new point at the staked location.

Click on |£| Close (top right corner) to return to standard non-visual Point stakeout.

Click on the Back button (top left corner) to return directly to the Main menu.

Additional methods to begin staking out a point
There are many other ways to initiate a point stakeout operation.

You can begin Point stakeout from the Point list.
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Slide the point you want to stake to the right, then click the Stake button “ The Stakeout point function begins
immediately with the selected point as a target. Next and Last buttons will move through the list where stakeout was
started.

You can build a Points to stake list:

B
it i
B I
[
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Q

The Points to stake list is on the right-hand tab of the Point list.
Points can be directly m Import and m Exported to the Points to Stake list.
Once staked, the stake icon P will disappear and the point won’t be available for staking from this list.

This staked status can be reset using the n Reset stakeout state option at the top of the menu.

To import points, click m Import:
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Points to stake: sets the destination for imported points.
Point type: where to import a file to (Points, Control points, Points to stake).
Format: normally choose the “USA FULL: PN,N,E,Z,C,D” format with .CSV extension, which includes the Name, Code and
Description for each point. This format best matches the standard Export function.

Points to stake > Export file dialog:
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Oftentimes the same points will need to be staked multiple times: pre grading, post grading, post compacting, post paving,
post sealing. There may be a time savings by saving a Points to stake list using the Export button which allows future

import.

You can specify the Path and Filename and file Suffix (extension).

The normal order for the USA matches the USA FULL Import format (above):
Name, North(N), East(E), Elevation, Code, Desc

Click the Export button to write the Point to stake list.

From the CAD view you can directly stakeout a point or object end, mid or intersection point:
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From CAD view, (1) click on a point/object to select it. Then (2) click on Stakeout.

Offset Staking a Point

LandStar supplies several methods to offset-stake a point:
Distance + Azimuth: offset a distance in a specified grid direction.
Alignment Offset: offset at right angle (left or right) from a point, using a second point as alignment.
Turned angle + distance: offset at arbitrary angle (skew ahead, skew back), using a second point as alignment.
AX+AY+ AZ:grid offsets from the reference point.

To begin Point stakeout with an offset, enter the Point stakeout menu.

Ifthe < "™ Offset stakeout tool is not available in the Tool tray, click on Setup button  , then on the Tools tab
highlight and Select the Offset stakeout tool. Consider dragging it to the top of the tool tray if you plan to use it often. Click
Back to return to the Point stakeout menu.

i |

Click the <* Offset stakeout button, then select the Method:
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Distance + Azimuth Alignment Offset Turned angle + Distance

Use one of these methods to specify the Reference point:

pick an existing point or object (with snap) from the CAD view.

take a GNSS measurement.

choose an existing point from the Point list.

avr

L O LR

Delta X, Y, Z

Note: Reference points do not need to be named points nor be in the Point list. They can be temporary measured or Any

snapped points.

Distances are entered directly, or you can optionally use a laser - rangefinder to measure them.

Elevations can be entered directly or as a A Delta elevation from the reference point, by Vertical angle, Zenith angle, Slope

(1:N) ratio or Slope (%) percentage:

oy

T
Degm |1,
[T =

Details: Survey (tab): Line/Arc stakeout

Available from the Survey (tab), Line/Arc stakeout button:
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Line/Arc stakeout allows the selection of a line, arc, polyline, object to stake. The line can then be staked to the nearest
point-on-line, endpoints, node-points, random and even stations along the staked object. Offsets can be added by Left,

Right, Ahead, and Behind. Visual staking is supported for receivers with internal cameras (like the i89 and i93.)

A variety of Tool buttons can be customized on the left edge of the survey screen to allow for quick access to additional
functions and settings.
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To enter a Line/Arc stakeout without a selected line, there are a variety of selection methods.

Click on ! to select a line from the Line / Arcs list - -

Click within the Line name box: - Ito enter a Named Line/Arc. This will auto fill a pick-box with

matching line/arcs.

Click directly on a displayed line on the map to select it:

*II.‘.I}l

Once you select a line to stake, additional Line / Arc stakeout functions and information will be shown:
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The Status bar is described [ Status ] on Page 95.
The Staked line box m shows the name of the target line/arc for the current staking operation.

The Instrument height box_ shows the current Hl and can be clicked to modify. See [ Antenna Height ] on Page 96
for additional information.

. . ) : .
The Augmented reality = button will enable and start the Visual line stakeout operation.

ar
turns the IMU Tilt correction on and off.
stores a measurement at the current location.
»
When in the Station and Offset staking mode, the arrow keys move the target station forward and

backwards along the current line using the Station interval. Click the
station to your current location.

button to advance the target to the nearest

o

When in the If you are in the Node staking = mode, the arrow keys move the target station forward
and backwards through the Node list. Midpoints of line segments are included as nodes in addition to the endpoints of

each segment. Click the " button to advance the target to the nearest node to your current location. The Node list
“ button displays a list of all nodes on the currently staked line.
When actively staking a line or arc, the Line staking menu will appear:

® 4 B X

[FEL":]

cancels the current line stakeout.

Hirfe g8 20T

chooses the North reference for map and offset distances.
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toggles the Staking compass on and off:

4

ON Dist Tolerance Off

Clicking = reverses the direction of the current line, arc or polyline.
When a target is active, select between four status display by swiping left and right:

Distance, target station, forward/back, left/right, cut/fill, current elevation:
TR T RN R ]

Distance, target station, north/south, east/west, cut/fill, current elevation.
g [ i 1BH B All=0I61s
LT 1% LrEn a

Distance, target station, offset (-left), cut/fill, current elevation:

1 A LR
iy LR
1T N LSTh

Distance, target station, distance from start, distance to end, cut/fill:
legs 41 5 LISF T KD D1E
18 kSRR 3.4 LA

Activating Visual stakeout results in the currently selected status display being shown overlayed on the real-time image.

The Station 0.000 USh shows the current station along the selected line/arc/polyline. Click it to directly enter a

new target station. If you enter a non-even-station-interval value, clicking Next and Last will apply the station interval to the
current value.

The Line Stake method button shows the current staking method. Click it to change the current line staking method:

Station and Offset Right/Left/Ahead/Behind.
" To line with Offset Right or Left. Random or nearest point on a line.

Node (segment end and mid-points) with optional offset Right/Left/Ahead/Behind.

Line / arc stakeout settings
Station and Offset

I
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Select the method from the 3 radio-buttons at the top.

Station & Offset runs through the line, arc or poly-line segment at specified Station intervals.
Start station is the chainage to apply to the beginning of the line. It typically is set to O.

The Station interval is the chainage to move ahead or back along the selected alignment.

Offset can be Left or Right at a 90° (Perpendicular) or skewed Ahead or Behind the target point at an arbitrary angle
referenced to the staked line.

The Offset distance can be entered using unit overrides.

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

To line

'hlf
Pl
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Select the method from the 3 radio-buttons at the top.

To line continuously adjusts the target location to the nearest point on the selected line, arc or polyline to the current

position.

Start station is the chainage to apply to the beginning of the line. It typically is set to 0.
Offset can be Left or Right at a 90° angle referenced to the staked line.

The Offset distance can be entered using unit overrides.

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

Node
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Select the method from the 3 radio-buttons at the top.
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Node runs through the line, arc or poly-line segment endpoints and midpoints.
Start station is the chainage to apply to the beginning of the line. It typically is set to 0.

Offset can be Left or Right at a 90° (Perpendicular) or skewed Ahead or Behind the target point at an arbitrary angle
referenced to the staked line.

The Offset distance can be entered using unit overrides.

The Elevation can be selected: by direct entry, delta elevation from the reference point, Vertical angle: applied from the
reference point, Zenith angle from the reference point, or Slope (1:N or %) applied from the reference point.

Details: Survey (tab): Surface stakeout

Available from the Survey (tab), Surface stakeout button:

Surface stakeout accepts a surface to stake, then displays the cut or fill required to move the receiver up or down to the
design surface. The delta is updated continuously as the receiver moves around. Surfaces can be defined by a single point;
by three or more points (technically two-points would work, however an unintentional tilted-plane will result); importing a
CASS triangulation file, a 3D DXF File or a LandXML file.

You can either use the Project > Surfaces tool to predefine a named surface, or you can define the surface when Surface
stakeout is initiated.

When you enter surface stakeout, if no surface has been previously selected, you will be prompted to Open / import an
existing surface file or create a New surface. Clicking New will bring up the New surface dialog where you can Name the
surface and choose one, three or more points to define a surface.

From the Surface stakeout list: Click Open to open an existing surface:

+ SortSrake-Surfaces (1)

Open
LA rianagubaaon S
HI migngulanion Tie
0 OEF | gad

LDl | ol

Canoe

ﬁ Click New:
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then selecting a single point:

For a Surface named TargetSurface:

S
gl 2
Aamdn
[ -

CHCNAY
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Will show the surface stakeout map screen
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The Status bar is described [ Status ] on Page 95.

The Staked surface box - shows the name of the
target surface for the current staking operation. Click in

[Iar-;m'.-iurla:z

the Name box " lto manually enter a

new surface name.

The Instrument height box _ shows the current
HI and can be clicked to modify. See [ Antenna Height ]
on Page 96 for additional information.

The Surface stake status box:

INecahizn wm
£ Sk LM AN1E 5 LER

Shows the current elevation, the design elevation and
the cut or fill. Fill will have a green background, Cut will
have a red background.

Click on the &l Panel button, in the Tool tray, to display
a large cut/fill panel:

See [ Panel (surface stakeout) ] on Page 47 for additional
information.

L
Click on Begin measurement to store a new
measurement. Points stored from the Surface stakeout
menu are collected in a surface staked list and can be
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exported using the = Export Surface staked report Click the Options » button, then select the Surface

button. Two files are written to a user selected folder: stakeout (tab) to change the stakeout settings:
.CSV containing: Name, Northing, Easting,
Design elevation, Elevation, DeltaH, T— i
Date_time TR ey
al
txt containing: Name, Northing, Easting,
Design elevation, Elevation, DeltaH, I""""L_'
Date_time wei du

Voice (Sound) prompt enables a ding-ding-ding sound
when the cut/fill delta is less than the Tolerance.

Tolerance determines when the sound is active.

Display cut/fill in fixed solution only disables cut/fill
display when the receiver is not fixed. This prevents
float, DGPS and Autonomous height measurements from
being erroneously treated as valid heights.

Details: Survey (tab): Area survey

Available from the Survey (tab), Area survey button:

Padeis B afdy

Area survey allows the collection of polygons representing the edges of a region. During collection either 2D or 3D area and
2D or 3D perimeter length are displayed. Once a region is complete, it will be displayed with 2D/3D area and perimeter.
The areas can be exported to a PDF report showing the area and DXF drawing file.

When you enter the Area survey method, an area and length information bubble is shown at the top of the screen:

a toolbar with an Undo and Accept region button is added to the map screen:
L=

and a Region list tool is added to the Tool tray:
la
Click the Start measurement button — to take a first point measurement using the averaging time determined by the

Ll
T

Survey mode d Topographic or Quick survey.
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Continue taking measurements at the corners of the region until the last side is pending. On a rectangular building this will
be after the 4™ measurement:

Ei*'!@hﬁ'

r
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= AT
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e

As each corner is acquired and as you dynamically move, the information panel will update with the Area and Length.

5
The Next point
You can click on the "

The Undo button

™
L HIEHE

or

' langt

display shows the point count of the next vertices.
to switch between 2D and 3D.

h . . .
will remove the previous vertices.

After storing the final vertices click the Accept region “ button to complete the current region. The Area properties dialog

will be shown:

CHCHN.AV
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The Type is always set to 3D polyline.

You can set the Name as desired.

If you leave Code blank, then the Border color, Line width, Fill color and fill Transparency will control the default (blank)

code and all regions will share the default selections.

If you specify a Code then the Border color, Line width, Fill color and fill Transparency are applied to all regions with the

same Code.

Note that the default Transparency is 100% or NO FILL.

The checkboxes determine which text labels appear in the center of the region.
The Text line is rendered under the last line of area/perimeter text.

Once you complete a region, it is not possible to edit or add points to the region.

You can edit these properties by clicking on the region boundary line, then clicking the Properties

tray.
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Clicking the Region list ® button in the Tool tray displays the Regions list:
L o Breailii- Regeem

T

You can Delete or Export selected regions from this list. Slide a region to the right and click on the =k button to enter the
CAD view and center the selected region on in view.

If you export a region or a group of regions, two files will be created. A .DXF with all selected regions as closed polyline:

and a .PDF with one region per page:

Details: Survey (tab): CAD View

Available from the Survey (tab), CAD view button and from the Tool tray of many survey methods:
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> Calrvew

CAD View switches to a CAD style interface with a rich set of drawing, editing and measuring functions. Also available from
the Tool tray and called by viewing shortcuts throughout the LandStar program.

Araalidl - CAD viaw

O RD S
-]

O o 3000

-

The Current position cursor shows the current GNSS or prism position on the map. You can change this icon’s style and

color from Settings e Miscellaneous: GNSS position symbol and color.

The CAD view Tool tray is fixed and cannot be edited. The arrow points in the direction the PDA is pointed, not the receiver.

The imported CAD Hide/Show button i toggles the visibility of CAD objects that are imported by reference. The DXF
import button = allows you to search the device for .DXF and .DWG CAD file types to import. You can list the attached

L5

files from Layers > Map files (tab) using the Layers button E , see [ Map files (tab) ] on Page 83 for additional information.

The ™ Hide / Show button toggles all point and line work display on and off. This allows quick inspection of your current
position over a background map or drawing.

The Full view ** button zooms out to show all drawing elements.
e regens and reindexes the drawing which may result in faster updates.
T
£% pans the map to place the current GNSS or prism location at the center of the display. Toggles ON and
OFF when clicked.
Toggles Follow (rotate) ON and OFF. When ON the CAD drawing is rotated to match the direction of the
PDA. This function uses the internal compass of the PDA.
Action bar

At the bottom of the screen is an Action bar. If there is no point, line or feature selection:

If a point, line or feature is selected (by clicking or with the . Snap tool) then the Action bar changes:
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Action bar: Data

Clicking on - Data:

Delete: select one or more objects or a rectangular area to delete.

Export DXF: export the entire CAD drawing to a .DXF file.

Layers: display the layer manager.

Off other layers: click an object, it’s layer will remain visible, all other layers will be hidden.
Layer off: select any object, its layer will be hidden.

Save point: click a DXF object; all points on the same layer will be saved to the point list.

Explode: all blocks loaded as DXF layers will be exploded.
Action bar: Draw

Before clicking n Draw on the Action bar, click and hold the - Snap tool:

Sl 1 objee]

A A AR A A AN

- -

and make sure the snaps are set to allow point selection. Then when you click on n Draw:

and choose a drawing action, you will be able to select the desired features.

. Create a new Point. Click on an object endpoint, intersection as determined by Snap to create a new
point.
. Create a Line segment. Click on the first and second point or a pair of snappable features to create a

single segment 3D line.
When a line is created, the Line dialog will be shown:
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Enable Display line dimensions and the new line will have Length and Bearing annotations added at the
center:

The text annotations are not connected to the line, they are separate static text fields.

Create a Polyline. Click on several (more than one) points or a series of snappable features to create a
polyline.

3-point Arc. Click on three points or snappable features to define an Arc.
Center + radius Circle. Click on the center point, then enter a radius to draw a circle.
2-point Circle. Click on two points to draw a circle.

3-point Circle. Click on three points to draw a circle.

Layout — plot deed. Select a starting point, then enter a series of metes-and-bounds descriptions to
describe a traverse (typically around the perimeter of a parcel.) This function includes an advanced
curve calculator and allows non-tangent arc descriptions. See [ Details: Tools (tab): Plot Deed ] on Page
201 for a detailed example.

Click to add Text (starting at the lower-left text corner) at any clickable point or snappable feature. The
size of the text is proportional to the scale. If you zoom in and draw text, the text size will be small. If
you zoom out and draw text, the text size will be large.
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Action bar: Measure

Clicking on H Measure:

Allows measurements between clickable features and objects.

= Inverse returns the distance and bearing between two points or a point and the { endpoint, midpoint,

nearest point } on an object, like a line. Click and hold the . Snap tool to configure the object snaps
to help choosing points.

= Multi-inverse returns the distance and bearing between a series of points or clickable features. The
results are presented in a table that lists the total length and the incremental traverse bearings and
distances.

E Angle computes the included and excluded angle between three points or clickable point features.

ﬂ Area computes the included area enclosed by a series of points or clickable point features. After the

last point is added, the total perimeter and enclosed area is displayed. Optionally, the selected region
can be added to the Area list with a Name, Code and attributes which will be displayed on the map.

To edit the region, click on it, then select - Properties. Alternatively go to Area survey, click on the
Region list button. Area regions can be exported using Project > Export > Other formats (tab) and
choosing Format = Area report.

Details: Survey (tab): Site calibration

Available from the Survey (tab), Site calibration:

Sile calibrabon

Site calibration allows modification of the underlying coordinate system so that Measurements (GNSS points) best match
record (Known point) data. Horizontal and vertical calibrations can be combined or handled separately. Site calibration
makes the GPS receiver use local coordinates.

Site calibration makes the GPS receiver display and use local coordinates instead of the default projected coordinates
which are typically State Plane Coordinates. This allows following an existing survey honoring measured distances and
bearings.

“i= |f there is only one point to calibrate on, it may be better to use Project > Single point localization to
establish local coordinates, at ground. A single point localization can have a Geodetic (True North), match the
underlying State Plane Coordinate system (the Projected system) or have an arbitrary rotation. See [ Details:
Project (tab) > Singe point localization ] on Page 68.

Prior to performing a site calibration, you may want to enter points for the Known point (Local) positions. If you only have
meets and bounds (distance and bearing calls); use the Tools > Plot deed tool to convert distance and bearings to Known
point (Local) coordinates. Then you can associate some GNSS measurements with these Known points to build a
Calibration.

A localization consists of a list of Point pairs. Each pair associates a GNSS position with the Local Known Point Coordinate. If
the Known points are well represented by the GNSS locations, then a calibration with low residuals can be computed and
activated.

Points don’t need to be entered prior to performing the calibration, they can be entered while building a new calibration.
GNSS measurements don’t need to be stored prior to performing a calibration, they can be occupied while building the
new calibration.

It is also possible to import calibrations from other field tools (.loc files) directly.
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Click on Site calibration from the Survey menu to enter this menu:

m

| werticsl sfjustrem
| Barfare ey El

T
If a calibration has already been defined, it will be recalled and displayed. If this is a new project, the empty calibration
screen shown above will be shown.

Click Add to enter the first GNSS point — Known point pair:
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The GNSS location is entered at the top, the Known point (Local) is entered at the bottom. Both values can be recalled from

the Point list or hand entered. The GNSS point can be measured as using the current position of the connected GNSS
receiver.
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Clicking Save & Continue will save the current point pair and allow entry of another point pair. When you have entered the
final point pair, click on Save to return to the Site calibration menu:
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Each of the point pairs will be displayed with the GNSS point number, the Known point number, the Horizontal residual and
the Vertical residual. Use the checkboxes to control each point pair’s contribution to the Horizonal and Vertical solutions.

Slide a Point pair line to the right to Edit and Delete the pair:
du E [rre——— Lk 2 [Y] ey

LandStar allows three types of Vertical adjustments:

e g gy e m——

Inclined plane  used when the polygon connecting all the calibration points fully encloses the entire project. DO NOT
use the Inclined plane with fewer than 4 vertical control points. DO NOT use Inclined plane without a
GEOID if the project is large enough to have significant GEOID separation changes over the project.

Constant Adjustment adjusts the vertical measurement plane (Ellipsoid if no GEOID is loaded, Orthometric if a GEOID is
loaded) up or down to best fit the vertical calibration points.

Surface Fitting ~ fits a Quadratic surface fitting with nodes at the entered calibration points. Typically used when many
elevation calibration points are available spread over the entire project. Like the Inclined plane method,
this is best used when there are calibration points that enclose the project.

Note that it generally is better to always include a GEOID file in your coordinate system and then allow the vertical
calibration method to work with the GEOID adjusted, orthometric heights.

Click the n button at the top-right to:

Toggle between the Guide mode which provides more prompts for calibration point entry and the
Simple mode.

Export the current calibration configuration to a file. This can be used to share a calibration with
another job or another crew.

Import a complete calibration system. Carlson .LOC files are supported. Two points will be added to the
project for each imported calibration point with the imported point names. The primary point (like
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10002) will have the Lat/Lon/Ellipsoid Height from the localization file, the secondary point (like
10002_1) will have the local coordinates (Northing, Easting, Orthometric height).

Click the Graph view button to display a preview of th:
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The current calibration scale factor is shown at the bottom.

This value depends on the underlying projection (typically a SPC Zone in the USA), Grid scale factor (location dependent),
the Height above Ellipsoid and the precision of the known points. A Scale Factor lower than 0.999 or higher than 1.001 is an
indication that something may be wrong.

Click m Results to view a summary of the resulting transformation:
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When you are satisfied with the calibration, click on Accept, then OK the calibration:

Horz. sdjust successful
Vert. afjust socoessiul

Accept the new datum
transformation parametons
now!

No
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The resulting Horizontal adjustment will be fully described on the Project > Coordinate system > Horizontal adjustment
(tab):
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The computed Vertical adjustment will be fully described on the Project > Coordinate system > Vertical adjustment (tab):
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Clicking the n button allows you to share, Lock, Export and Load the complete system:
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Create QR code displays a QR code that another user can scan to share the coordinate system:
heightilii1- 1-08 code

Scan QR code activates a QR code scanner which will read the complete coordinate system.

You can add password protection to the Coordinate system. Choose Lock:

Lorked

Canal

then enter a password and click on OK.

Once locked, the coordinate system parameters are hidden:
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Export writes a Trimble DC type file which can be shared or Loaded as needed.

Details: Survey (tab): Base shift and CORS shift

Available from the Survey (tab), Base shift or CORS shift:
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Base shift and CORS shift are nearly identical functions. Base shift works for a single base while CORS shift works for all
future bases and is targeted towards CORS network corrections where the BaselD may change over time, receiver

initializations and traveled distance.

Base shift

Suppose that you return to a project on the second day, and it is not possible to deploy a Base at the same location as the
first day. You can set it up at a new, random location using an autonomous position.

However, when checking in (using Point stakeout) on a previously surveyed point 1001, there is a substantial difference
between the Rover’s current reading and the previous reading:
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Base shift is a simple way to fix this issue.

CHCNAY

From the Survey (tab) click on Base shift, then click on the

m Calculate button:
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With the receiver occupying point 1001, click the
Measure button, then Start acquiring a GNSS position:
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Click the Point list “— button and choose Known point
1001:
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Click OK to accept this point pair.

The Base shift menu will be shown with the required base
offset to match the previous measurement:
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Click on the m Accept button.

Confirm the base shift by clicking YES:
[ Accipt base shili 1

pararmeles?
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o S ey P 1 el

The new base location and any measurements that you

have already made with the new base will automatically be
shifted:

GNSS Bace base_ Y and
dependon ponts woro
shifed,
open pointa?

No

If you click on YES then the Point list will be displayed,
otherwise you will return to the Survey tab of the main
menu.

Now, with the Base shift active, if you stakeout the check
point 1001:
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the offset will be minimal.
If you have multiple rovers on the project, you can share

the Base shift using QR codes. Click the Bl button near the

top right corner of the Base shift menu:

¥ Gedhi e
Creaie QA code

Scan (H code

Click Create QR code to build a barcode that can be Scan
QR code by other rovers.
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Removing Base shift
You can remove the Base shift by setting the recorded shift to 0,0,0.
From the main menu Project (tab) > Point list slide the The Edit Point listing will show the N shift, E shift and H shift

shifted base to the right, then click on Edit pencil: for the base:
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Manually change the N, E, and H shifts to 0.0, then click
Save.

CORS shift

CORS shift is nearly identical to Base shift however the shift is applied to all subsequent measurements made with any
online server.

Because CORS Network connections don’t generate individual bases in the Point list, a new Virtual CORS base is built and
applies to all subsequent CORS based measurements:
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this CORS base will be shown in the point list:

and can be edited in the same fashion as the Base shift.
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Details: Survey (tab): Sideslope stakeout

Automates staking a vertical profile perpendicular along a centerline (line or polyline). The profile can have multiple profile
strings (segments with varying slope and width) and is mirrored on both sides of the centerline. The centerline might also

be used to grade a slope against a building foundation.

To begin, first define a polyline in CAD view (not the Lines/Arcs manager on the Project tab). An existing polyline from a DXF

design file can be used.
Start the Sideslope stakeout operation from the Survey
(tab), Sideslope stakeout:
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Landstar will prompt you to select the polyline:
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Click on the polyline to stake. Select the Sideslope profile to
use:
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If the correct profile does not exist:

5E51-Eidesiopes

Click on New:
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Name the new Sideslope profile, enter a Horizontal and
Vertical Offset if needed, then click Save&Continue. Enter
the first string segment of the profile:
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Select Up/Down/Horizontal(flat), the desired Slope (if not
Horizontal) and the applied Width or Height. Click
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Save&Continue to enter another String:
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Enter the String’s parameters, then click Save to complete
String segment entry and visualize the Sideslope profile:

Click Back to return to Sideslope stakeout:
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The navigation bubble shows:
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To top distance up to match the top of the

string profile.

I'n fap ol curreni ginng

t
|

Radial Cut distance to the profile elevation in the
radial direction.

Outward horizontal distance out at the current
elevation to intersect the profile target
elevation.

Station the current centerline Station.

Up/Down distance to move Up or Down to meet
the target profile height.

Offset Offset distance Left or Right from the
centerline+offset.

Pl 1

Click = and "~ to toggle between Profile view:
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A
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e
L
And Plan view:
i
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Click @ Stop Centerline staking and select a new

Centerline and Profile to stake.
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Click Left/Right to toggle the profile from the Left and
Right centerline+offsets sides.

Click L Text display to control the items shown on the
Profile view:
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The Sideslope target box:
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Changes the staking target between:

Slope: the nearest point on the Sideslope
profile.
-N-: the N’th inflection point on the

Sideslope profile. 1 is at the centerline
offset by the Horizontal and Vertical
Offsets.

Use the . Start measurement button to store a staked
point at any time and place. If Auto Descriptions [ See Auto
description for staked points on Page 125] are enabled then
the point description will include the station, offset and
cut/fill to the profile line.

Details: Survey (tab): Foundation stakeout

Foundation stakeout automates the design and staking of sloped pit walls around a foundation base. At a distance offset
from the foundation base, a sloping surface is defined which intersects with the undisturbed ground surface. The top edge
of pit, wall slopes and building bottom can then be staked and excavated.

To begin, first build a surface that encompasses the entire working area, the surface should extend past the expected top
edge of pit. Then build a closed polygon for the foundation exterior, typically this will be imported from a CAD drawing.

For the example below, the original ground surface has been generated from undisturbed, pre-excavation ground shots:

The example exterior foundation polygon is a 12 x 30 foot foundation wall, approximately 4 feet below existing grade.

From the Survey (tab) click on Foundation stakeout:
L]
— B
Bl
i stakne

LandStar 8 User Manual
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The current project will be shown:
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Click on the Select a foundation prompt, or the u
Foundation select button:

The, likely empty, list of existing foundation definitions will
be shown, click on New to create a new foundation
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definition:
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Name the new foundation description. Click on the
foundation polyline (orange line), then select Left or Right
so that the black offset line is on the outside of the orange
foundation polyline. The Left/Right selection will depend on
the design direction of the polyline.

Enter the default Offset and Slope for the excavated walls.
Optionally adjust the foundation Elevation if needed. The
Offset and Slope can be individually configured for each of
the line segments in the next step.

The green diagonal lines are the inflection lines for the pit’s
wall sides.

Click Next:
R Ppraris gy
it
300 LIEnN
R O Y [ -
[} Iiiterd -
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If the Surface to use for the undisturbed ground level is

specified, the top of excavation limit will be computed and
shown. Click on each of the foundation polyline segments
to highlight the segment red, then edit the Slope from that ,‘, e R e
individual segment if needed.
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Staking the top-of-excavation limit.
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Slide the Foundation to the right to edit it. ’ | o
vy a
o Check the Foundation then click OK to begin staking. :
Click on a Foundation element for staking directions and
information for that element. The selected design element
will be highlighted in red: .
i e

Staking inflection lines at the pit corners.
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Clicking the " Store measurement button will store a
point. The description will follow the Auto description rules
VR AN set in settings. See [ Auto description for staked points ] on

s ML oy Page 125 for information on Auto descriptions.
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Staking the foundation base + offset line.

Details: Survey (tab): Continuous survey

Available from the Survey (tab), Continuous survey:

i ; ﬁ
|II_.§'.5.-—.:\-.'JI_,. Coninucus
i survry
Continuous survey allows automatic collection of measurements based on traveled distance or incremental time.
Measurements can be triggered by Time, 2D distance traveled, 3D distance traveled or 2D delta and height delta.

The Continuous survey method shares the same map-based collection tools as Map survey. See [ Details: Survey (tab) >
Map Survey ] on Page 95 for a detailed description of the many survey method screen elements:
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When you first enter Continuous survey, first click the Options » button, these Survey method settings for Continuous
survey will be shown:
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The Survey method will automatically default to Continuous survey. Typically, you will only want to Store fixed solutions
only, however it is possible to disable the Accuracy check to allow FLOAT and DGPS solutions to be stored.

The Auto increment name interval should usually be 1 which increments the Point name by 1 after every measurement. If a
conflict with an existing point is encountered, LandStar will advance to the next available point number.

Four delta methods are available:

Time will store a measurement after the Time interval delay:
LT
Thme il

7.0 GEcgiiad

Distance 2D will store a measurement after the horizontal position changes by more than the specified distance:
L
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Distance 3D will store a measurement after the horizontal + vertical (3D slope distance) position changes by more than the

specified distance:
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Distance 2D or delta H will store a measurement after the horizontal position or vertical height changes by more than the

specified distance:
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Clickthe * Start measurement button to immediately store the first measurement and start checking for movement or
time to trigger additional measurements.
The Start measurement icon will changeto ™ Stop measuring when measuring is active. It is not possible to leave the
Continuous survey screen without stopping measurements. The Back buttons will not operate until measurement
collection is stopped.

Details: Survey (tab) Cross-section survey

Available from the Survey, Cross-section survey button:

Crods-pection
BUFVEY

Cross-section survey allows you to quickly survey points at evenly or randomly spaced cross sections along a centerline
alignment:

This measurement collection tool displays your location From the Survey page, click on Cross-section survey, then
relative to cross-sections enabling you to quickly navigate click on the alignment selector:

to the left-offset, centerline and right-offset points at each

station. Extra measurements on and off the cross-section f 3

lines may also be stored. : j_ﬁk!.-

In addition to the stored points, station and offset o .

information is available for all measurements collected

using the Cross-section survey, including points stored at 2 =

random stations: L

BEGTM, 438 . 008 1
B 11U
230011148 627
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116749, 1114, 351
-8B, 1118, B8R
8,937, 1118, £33

6,364, 1117, 408

1887, 1111, 535
15,559, 1111655
0, 1110, B

along with a DXF file that details every cross-section.

Getting Started with Cross-section
Surveying

First identify the centerline alignment you want to survey. It
is possible to survey between two points, but it may be
easier to visualize the centerline if you use the CAD view to
add a line between the endpoints. You can also use a
polyline, arc, circle, or alignment as the centerline.
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The project list of Lines/Arcs will be shown, it may be

empty:

& TATTIEET-Lines) Arow{l )

Click on Add, then pick a centerline source:
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If you have already defined a line, click on From map, then
click on the correct line, then click on OK:
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Enter a name for the line, or accept the default name:
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then click OK.
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If you have selected a line, you will have an opportunity to
edit and approve the Start and End points:

Click on Save, you will return to the Line/Arc list.

Select the new line by clicking in the right-hand circle, then
click Next:
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You can now click the option button:
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Select the Cross-section survey (tab):
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To set the station interval and left and right cross-section
width.

Use horizontal transition points: add a cross-section at
each centerline node.

Station interval: the distance along the centerline to place
cross-sections.

Along offset tolerance of cross-section: RED prompting
when the station exceeds.

Left length of cross-section: width (offset left) on left side
of centerline.

Right length of cross-section: width (offset right) on right
side of centerline.

Midpoint tolerance of cross section: left-right tolerance for
the middle point on centerline.

Real time station as point name: build the point name from
the actual station “K0+000.048”

Target station as point name: built the point name from the
ideal target station “K0+000.000”

CHCHN.AV

Either Real time station as point name, Target station as
point name or standard station incrementing can be
selected.

Click the back button to return to the Cross-section survey
screen.
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l—f . You can directly enter the station to stake or
use the previous station < and next station > buttons at the
screen bottom to move forward and backwards along the
centerline by the entered Station interval. Clicking the
Nearest button will add a cross section on the centerline at
the station nearest your current position without regard to
the selected Station interval.

Your current position will be shown as a blue circle 4
with a black navigation line the nearest point on the
selected cross section. The actual station (along the
centerline) and the offset will be shown:

=

SInKD+010.624

OMeat 7 622 USHE  Aloag 10.624 SN

The left and right offsets are shown as an orange target

line. Typically, you will use the Start measurement to
store the left, right and the centerline points. If the
centerline station has not yet been measured, you will be
prompted:

You may measure as many points as necessary at each
cross-section.
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The © button selects the stored point type: Topographic and a .TXT file:

(typically 5-second average), Quick (typically 1-second) or
Corner.

The P button allows you to measure a remote (hidden B 11
point) using offsets. BBIT, 1118,

Once you have measured each cross-section line, you can

-
use the = Cross-section export button to write a DXF file
that has a cross-section detail showing each measurement,
at each station:

detailing every stored cross-section.
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Details: Config (tab): Instruments profile

Instrument profiles

=

MTLATYTEE
ke
combines the Bluetooth/Wi-Fi Connection information:
- ]
[ M
[ErEEE LN
e T
with one of the Instrument configurations:
e s

. |

GG o o SMER haas
to form a complete instrument definition.
If the Instruments profile function is not shown, look under the = function.
Instrument profiles can be quickly selected and applied using the E Instrument select button at the top of most

menus.

Depending on the application, a named Instrument profile may be more convenient than separate connection and profile
operations. This is especially true when you have a Rover that is used both as NTRIP Network Rover and a UHF Rover.

From the Config tab of the main menu, click on Instruments | Click New to create a new Instrument profile:
profile:

Instrumenis

Iﬁ GRES o

- ;
[ i
F Irstrumnenis .

=TI piahile

>
Tzisl sisdicon
The existing, possibly empty, list of Instrument profiles is

Cano
shown:

Select the correct instrument type. For this example, we
€ P dmiremes pfie will configure an NTRIP Rover using the PDA internet

connection:
I Lanad St

Mifres St THE TLEN 8
Hndl T E3
Trpe AT -
A=l ik -
Ciripdicnd e Wi -
kpihiirm |pgs DTN M “
]

B awsmanans ]
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Configure the connection information, the instrument
should be on and ready to pair by Bluetooth or Wi-Fi. This
dialog is the same as [ Details: Config (tab): Connect to
instruments ] on Page 169.

When the configuration is complete, click Next.

.3 .- Ismirurmeiils geelile

Select the Rover type (NTRIP shown above). This is the
same as [ Details: Config (tab): GNSS rover ] on Page 171.

Click Next:
| Hatn las pERETS

Rl
P, perd T -
Diesrraman P

nmnn I',.I'I:|I" LTI

L]

2m

Wit
RS VNG MDY T TR =

L @i g

marEE il

CHCNAY

Enter the network configuration information. Click Next
when complete:

Flrarhm maak

1211 Qa
Poghbsn rmapsa hragusney

An [~ |

Complete any additional configuration items.

Click “ Save to save the Instrument profile or
click m Save & Accept to save the profile and

immediately apply it to the receiver.

Once profiles have been defined, from the Config tab of the
main menu, click on Instruments profile:

=

L=
-ﬂ- InElrumeris
m s> pofile

This list of Instrument profiles will be shown:

A M FLAIN
M S | o MO )

L=
e Neg i
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Select S check the desired profile, then click You may also use the E Instrument select button to

| oo | to apply the profile to the instrument and activate Instrument profiles. See [ Instrument select ] on

. ) Page 49 for additional information.
begin operation.

Details: Config (tab): Connect to instruments

LandStar supports a very large list of RTK Instruments, Generic NMEA receivers, the Internal GPS receiver in the PDA and a
position Simulator.

This is partial list of devices:

CHC M5, X900+, X91+, X6, iBase, E90, E91, M6, i50, i73+, i73,i70, i83, i80, i89, i90, i93
Y i80, Z3, X91+
Champion Pro
Prince iBase, i90VR, 190, i80, i70T, i80Air, i80Pro, i50, i30, i30 IMU Tx, X91
ELMIZ elNav, M3, i70, i70Pro
Horizon Kronos C3

ComNav GIGNSS, G7GNSS
TopoMap T10, T20, T20 plus
iGage iG3S, iG4, iG5, iG8, iG8a, iG9, iG9a, IGV
eGPS M5, eGPSM6, eGPSM7, eGPS20T, eGPS20TL
Datronix D1, D20
GeoGenie NX, PRO

LandStar connects to GNSS receivers, Total stations and Peripherals (Laser Rangefinder, Pipeline detectors, Echosounders)
by Bluetooth. Most modern GNSS receivers also support a Wi-Fi connection.

Visual receivers like the CHC i89 and i93 require a highspeed Wi-Fi connection to utilize the cameras.

From the Config tab of the main menu, click on Connect to et iEtrumeit
instruments:
pre
e~ i L “
= L
0 ([T ire “
Connact 1
s B -, Insinaments Wil . “
Cirraci e T Lty -
LML e (s =) B -
0 cocis roanen =
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Brand

Select the Brand of receiver you are connecting to:

The list of available Types will update, select the correct
type:

0 AT rd Sk MG

O s (A

RTK is correct for most external receivers, LandStar will
automatically negotiate the difference between CHC RTK
and SMARTGNSS receivers. Internal Android device location
will use the GPS receiver built into the tablet. Others
(NMEAO0183) expect GGA, GST, GSV, GSA at any interval.
Performance will improve with GGA at 1 HZ or faster.

Choosing Simulation allows entry of the spoofed position:

Tem muma Feghaw
firens FHIr '
Ty Trmifme “
Lt (8 W GIAT TISTE N

=B FRE ] LT
Loiegiis o PN ) B0 LTRSS W

Pamaghe {H| 1RAT Gl s

The simulated position can be loaded from the Point

listor * CAD.

When simulation mode is selected, this warning will be
displayed on all main menus:

EArmiaa e e, OO VDL BITYEY

CHCHN.AV

Model

Each Brand will have list of Models:

L

Select the Model that matches your device.

Connection type

Choose the correct Connection type:

Wi-Fi is required when using a Visual Stakeout or Visual
Survey receiver like the i93. Bluetooth may be preferable
for simplicity. If a Bluetooth PIN code is required, LandStar
will ask for its entry. Some PDA devices may require
bonding from the operating system’s Bluetooth menu.

Antenna type

When you select a Model, LandStar will automatically select

an Antenna type. Click the n button to override the
default selection.
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Slide an antenna definition to the right and click on edit to
modify the standard definitions.

It is also possible to manually enter a new custom Antenna
definition, click on Add to make and edit a new entry.
Antennas are defined in LandStar with the following
convention.

Arrirnra tpps
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Corresponding to an antenna definition:
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Details: Config (tab): GNSS rover

Radius=%s Diameter = 0.4436 / 2 = 0.222
To phase center (SHMP to L1PC) 0.3740 -
0.2753 = 0.099

To the bottom (SHMP to ARP) = 0.275

Target device: Bluetooth

If the Connection type is Bluetooth, when you enter the
Connect instrument menu, LandStar will automatically
perform a Bluetooth search. If the automatic search is

unsuccessful, click on Then use the device
operating system’s Bluetooth menu to look for the receiver
and to pair with it. When you return to LandStar, the new
device will be available.

Target device: Wi-Fi

If the Connection type is Wi-Fi, click on the current Wi-Fi
connection:

| I m_guTET (::: >

then use the device operating system to connect to the
GNSS receiver. The default password for most CHCNav
receivers is “12345678” if a password is requested.

Connect
Once all of the connection settings have been made, click

on the NG .

Connacied ingbruimam:
GHE5- T D&SEEE

Cancal

If the connection is successful, LandStar will return directly
to the main menu and voice “Successfully connected”.

If the connection is not successful, make sure the receiver is
turned on. Only one controller can connect by Bluetooth to
a receiver at a time. You may need to go to the operating
system Bluetooth menu and ‘Forget’ the device and add it
again.

GNSS rover configures the connected device as a Rover and includes the UHF Radio / Internal modem / PDA connection

settings to provide RTK corrections.

From the Config tab of the main menu, click on

- i
Confy [
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The list of known configurations will be shown. You can
check a known configuration, then click Accept and the
receiver will be configured.

Slide an entry to the right

Satel TR 4R1
Privisaid: SATE
LU B
Chanss |
Frsjeerny 431

then click on Edit to modify an existing configuration. It

is also possible to Delete, Load from Cloud, Share a

configuration. If you receive a shared connection profile,

put the .hcwm file in the system folder:
/storage/emulated/0/CHCNAV/Config/workMode/

and it will appear in the Profile list the next time you click

on GNSS Rover.

There are 5 primary configuration types:

NTHP
o AP
Mo

we

ppo

NTRIP is a network server that requires a Username and
Password. APIS is the CHC cloud service for sharing
corrections between network connected receivers. Radio
uses the device’s internal UHF radio. TCP is a network
server that does not require a Username or Password, it is
also known as DIP: Direct Internet Protocol. PPP is a
satellite correction service like RTX, PPP activation is
configured elsewhere.

CHCNAY
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Set the Name to a description of the radio profile. The
Name is arbitrary. It is recommended to include the
Protocol and Frequency in the profile name.

The Radio configuration includes the Protocol, Channel
bandwidth (Step value), over-the-air Baud rate, radio
Channel, Frequency (set the Channel programming in the
receiver), Sensitivity (normally high for Rovers), the FCC
callsign, and FEC (may not be available for all radio
protocols.)
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Set the Name to a meaningful description of the network.
The Name is arbitrary.

Internet access can be:

If the GNSS receiver has an activated cellular SIM card

inside the receiver, then Receiver network can be selected.
Otherwise, use the internet connection of the PDA network
(the PDA is the Android device that LandStar is running on.)

Domain/IP is the network address of the server. It can be
entered as a name like “turn.utah.gov” or as a dotted IP
address “165.245.87.9”

Port is the internet port that hosts the server. Typically, it is
2101, however other ports like 8000 are also in use.

It is possible to enter a list of Servers and pick the

Domain/IP and Port from the list. Click on
Select a server to view and edit the server list. Each entry in
the list has these data items:

Add nerver
hismie
T
DoamainilP
ILET1 g St
Prori

24D

Camel

Mountpoint selects the type of correction to receive from

the server. Click Get Mountpoint to

LandStar 8 User Manual

download the server’s unique list. Then use the
Mlourapent
drop down list to select the best Mountpaint.

Username and Password are both case sensitive.

When all the settings have been entered, click on Save to
save the profile or Save & Accept to Save the profile and
immediately apply it to the connected receiver.

TCP

Buslid-1-TCP

Hwramrk
SR neeTre n
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Set the Name to a description of the network. The Name is
arbitrary.

Internet access can be:

If the GNSS receiver has an activated cellular SIM card, then
Receiver network can be selected. Otherwise, use the
internet connection of the PDA network (the PDA is the
Android device that LandStar is running on.)

Domain/IP is the network address of the server. It can be
entered as a name like “turn.utah.gov” or as a dotted IP
address “165.245.87.9”

Port is the internet port that hosts the server. There is no
standard port for TCP/DIP connections.

It is possible to enter a list of Servers and pick the

Domain/IP and Port from the list. Click on
Select a server to view and edit the server list. Each entry in
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the list has these data items: When all the settings have been entered, click on Save to
save the profile or Save & Accept to Save the profile and

Add mirvar
immediately apply it to the connected receiver.
T
Ty
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Details: Config (tab): GNSS base
GNSS base configures the currently connected device as a Base configuring Internal UHF Radio / External Radio / Receiver
Cell Network profile settings and does the Base setup putting a coordinate in the receiver.

First connect to the Base receiver using Config (tab) > Connect to instruments. It is important to have the actual device
connected so that LandStar can interrogate the device and offer the correct radio and communication options.

Hint: Make sure you are connected to the Base and not the Rover when configuring the Base.

From the main menu, Config (tab) click on GNSS base: Click on | e New to create a new Base profile.
Choose a correction message transmission method:

Imimmnal i

. Emeg il
If you have never configured a Base, an empty Base profile
list will be shown: FeCigid [l e
- BaallEI- GNEDS haye =

REcawir Lol PO
bl s

Details on each of these methods follow.

Internal radio

Internal radio uses the radio built into the Base receiver to
transmit corrections. LandStar will retrieve the current UHF
Radio settings from the Base and use them as defaults.
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Name the Base profile with a meaningful complete name. It
will have greater future value if it is easy to pick from the
list. Decimal points and spaces are not allowed in the
profile name.

Set the Differential format to the highest protocol shared
by the Base and Rover.

If both receivers have Trimble OEM boards, sCMRx is
appropriate. If you have two CHC receivers like the i93
CHC516 protocol may be best. Otherwise, favor RTCM3.2.
None of the other protocols support all satellite systems
and signal tracking, they should not be used.

LandStar 8 User Manual

The radio Protocol and Step value (channel bandwidth)
should be set as desired, however SATEL_3AS is typically
the only supported protocol that supports 9600 baud over-
the-air in 12.5 KHz channel bandwidth which is a
requirement of most USA FCC licenses.

Typically, the Baud rate is forced by the Protocol and Step
value (channel bandwidth). Higher Baud rates are better
and 9600 is the minimum that will dependably support full
constellation correction streams like RTCM3.2.

Selecting a radio Channel will determine the Frequency. In
the USA, end users are not allowed to edit the Frequency,
they must choose a Channel from the list of pre-entered
licensed frequencies.

Sensitivity is best set to Low.
Click the button to the right of Call Sign to check your

FCC Call Sign.
Bat FOO Call Sign

st a

WO IR

Cancsl

The FCC information is configured by your dealer and is
stored in the receiver. Status should be ON, 15 is the
minimum Interval in minutes, the Message should be set to
your FCC ID using upper case letters. See the receiver’s
User Manual for instructions on setting the FCC
information.

FEC (Forward Error Correction) is best turned OFF as it adds
30% additional overhead to every correction message.

Set the Elevation mask to a reasonable value like 5
(degrees).

Turn ON Start at known position unless you want to pick or
enter a known location. Turn OFF Start at known position to
automatically read an autonomous base position for every
setup.

Clicking Save will save the Base profile and return to the
Profile list. Clicking Save & Accept will save the Base profile
and begin the Base setup procedure. See [ Base setup
procedure ] on Page 177 to continue setup.
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External radio

External radio sends correction messages out the receivers

RS232 Serial Port.
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Name the Base profile with a meaningful complete name. It

will have greater future value if it is easy to pick from the
list.

If both receivers have Trimble OEM boards, sCMRx is
appropriate. If you have two CHC receivers like the i93
CHC516 protocol may be best. Otherwise, favor RTCM3.2.
None of the other protocols support all satellite systems
and signal tracking and they should not be used.

Set the Baud rate to the highest speed supported by your
external radio. This typically will be 115,200 baud. Slower
speeds can significantly increase the radio latency and
reduce the carry capacity of the radio. The RS232 protocol
is fixed at 8-data bits, No parity, 2 Stop bits.

Set the Elevation mask to a reasonable value like 5
(degrees).

Turn ON Start at known position unless you want to pick or
enter a known location. Turn OFF Start at known position to
automatically read an autonomous base position for every
setup.

Clicking Save will save the Base profile and return to the
Profile list. Clicking Save & Accept will save the Base profile
and begin the Base setup procedure. See [ Base setup
procedure ] on Page 177 to continue setup.

Receiver Cell Network

A Base configured as Receiver cell network pushes the
correction stream through the internal Cell modem to a
specified Domain/IP Address and Port. The protocol is Raw
Telnet. There is no security. The Base does not need a

CHCHN.AV

Static, Public IP V4 address because the corrections are
pushed to a remote static address.

BaE003 Hiatay

Ricetadr podl et

| Dt i
Differentisd {ormad

ATCK 2 E
CormanilP

main] us

Part

51

Elswnnann matk

] L]
Sl AE raeen LOST0nN |

Use the APN button to check the receiver’s APN
(Access Point Name). In the USA, if you change the APN,
you must cycle the modem or receiver’s power to reset the
cellular network.

If both receivers have Trimble OEM boards, SCMRx is
appropriate. If you have two CHC receivers like the i93
CHC516 protocol may be best. Otherwise, favor RTCM3.2.
None of the other protocols support all satellite systems
and signal tracking and they should not be used.

The Domain/IP and Port must be correct.

Set the Elevation mask to a reasonable value like 5
(degrees).

Turn ON Start at known position unless you want to pick or
enter a known location. Turn OFF Start at known position to
automatically read an autonomous base position for every
setup.

Clicking Save will save the Base profile and return to the
Profile list. Clicking Save & Accept will save the Base profile
and begin the Base setup procedure. See [ Base setup
procedure ] on Page 177 to continue setup.

Receiver cell network and external radio

Receiver cell network and external radio is a combination of
Cell network and External radio sending corrections
simultaneously over both links.
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If Start at known position is OFF, then LandStar will do a “

short average and start the Base with an autonomous

o Always enable Store the point into the Point list unless the
position.

point already exists in the project’s Point list.

Double check the Antenna type and the Antenna height.
Consult your receiver’s User Manual to determine the Slant
Height Measurement Point if you choose Type = Slant H.

The Base Coordinates can be entered and displayed in
several formats.

If starting from a NGS OPUS solution, favor a Geodetic
(Latitude, Longitude, Ellipsoid Height) position:

REE FRAME: MAD_B3{2001){ EPOCH: 20110 000d) m
X: -1587264. 765(n)  ©.011(n) -1587
¥: 4561961, 616(m)  @.815(m) 4561
] 4153956, B4 (| ) 2. 0lE(m) 4153
LAT: 48 53 B.48523 a.sezin)(a) 40 5
E LON: 258 &8 5%. 74784 a.085(a) 58 48 5
WLON: 169 11 4.25296 a.e05(m)(B) 109 11
EL HGT: (c) 1714.672(m)  @.02%(m) 1
OATHD HGT: 1728, 884 (.} @.87%(m) [NAVDEE [Compu

The best measurement entry format is:
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If working in US Feet or International Feet be sure to enter
an “M” after the Ellipsoid Height, as shown above,
Elevations are always in Meters on an NGS OPUS solution.

You can manually type in the point Name and Coordinates;
use the = Point list button to recall a point from the

project Point list; use the = Start Measurement button to
read the current GPS location or pick a point from ~* CAD.

Set the Description to a meaningful note, finally click OK.
LandStar will configure the Base and corrections will begin
to be transmitted.

Details: Config (tab): GNSS static observation recording

Receivers can store static observation data for processing in desktop tools like CGO2, online tools like NGS OPUS and be

used for UAV post-processing.

GNSS static recording allows control of the receiver’s recording settings.

From the main menu Config (tab):
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Set Start logging to ON, if set to OFF it is not possible to configure any of the logging parameters.
Set Data format to HCN.

If you would like the receiver to automatically begin recording when it is turned on and is tracking satellites, set
Automatically log when the receiver is turned on to ON.

Choose an appropriate logging Interval. 1-second is usually great for all applications. When using OPUS, the interval must
be 30-seconds or less and divide into 30 seconds evenly: 1, 2, 5, 10, 15, 30 are all acceptable.

Elevation mask sets the minimum satellite height about the horizon to record data. 0 (zero) is a good choice for all static
applications and is recommended by NGS for CORS station recording.

Logging duration sets the length of recording files. 1440 minutes equals 24-hours and will produce a new file every 24-
hours. The file begins when the receiver is turned on, not at midnight.

Station name is included in the resulting HCN and RINEX files.
Antenna height is usually the distance from the receiver’s ARP (the bottom of the receiver) to the GM (Ground Mark).

Antenna height measurement method can be Vertical, Slant H or Antenna phase center. For NGS OPUS and most other
application Vertical is the best choice.

RINEX will write a RINEX 2 or a RINEX 3.0x file, in addition to the HCN file. It is possible to convert an HCN file into either
RINEX 2.11, RINEX 3.02, 3.03, 3.04, 3.05 or 4.00. It is not possible to convert a RINEX 2.11 file into any other format. There
also may be a rate limitation when RINEX is enabled.

Details: Config (tab): Instrument info

The Instrument info tool provides extensive information about the currently connected receiver.
From the main menu Config (tab) click on Instrument info:

i |

/]

L i - Insirumant infg

The Instrument info, Quality, Sky plot, Satellites, and GNSS Base tabs are duplicates of the [ Status | screens described on
Page 95.

Details: Config (tab): Activate instrument

Receivers can be activated with a permanent code, a temporary code that expires after an evaluation period or be
geofenced with different options based on location. Activate instrument allows the user to enter a new activation code.

From the main menu Config (tab):

A& gl
>  matrument

If you have a new Activation code, record the current code then enter the new code, click Activate.
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Details: Config (tab): Update

Receivers have firmware sets for the main board, the OEM GNSS engine, the cellular modem, and the UHF radio. It may be
possible to automatically update the receiver using online resources.

From the main menu Config (tab):

o W8
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Details: Config (tab): Advanced

Advanced functions include:

NMEA output for the Bluetooth channel, the RS232 Serial port, and a special Raw TELNET port (1212) accessible via the
Wi-Fi port.

Receiver Elevation mask setting.

Position output frequency.

OEM GNSS engine reset.

APN for the cellular modem.

NFC/Wi-Fi function that allows easier connection to some receivers by Wi-Fi or Bluetooth.

From the main menu Config (tab):

ﬁ""ﬂ 5 ddvanoed
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NMEA Output
Clicking NMEA Output:
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Then choosing Serial port:

Bap0UZ-1-HMEA Dutpul
[ Wit o™
:| i |l el '.:}:"""' o
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Elevation mask setting

BEevabion mesk satiing

Liwesiion mask

Canoel

Press Get to retrieve the current Elevation mask setting
from the connected receiver. Modify, then click set to send
to the receiver.

Position output frequency

Famdion oirtput hegquency
[ &
ol il
LT

il
0 | i}
Cancel

Press Get to retrieve the current Position output frequency
from the connected receiver. Modify, then click set to send
to the receiver. This is the coordinate update rate from the
OEM GNSS board and may not be supported for all
equipment.

Reset GNSS Board

Eenwi GRS Beard?

Mo

Click YES to clear the GNSS board’s ephemeris and then
reset the GNSS Board. This forces a full reacquisition of
signals and position.

A reset may be beneficial when verifying solutions under
heavy canopy and this sequence is automatically applied
during the Verified and Control survey methods.

Cellular modem APN (Access Point Name)

This option allows you to change the cellular modem APN
(Access Point Name), Dialing number string, SIM Username
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and SIM Password: In the USA, normally the Dial number is *99# and both the

Username and Password are blank.

Arreun poish In many markets (like the US) it is necessary to power off

das orty aits the modem, wait 40 seconds then turn the modem back on

[ after changing the Access Point Name (APN). Enable the

eI Cycle power... option to automatically turn off the cellular

eamasna modem, wait 40-seconds, then turn the modem back on
again.

Famss s

Ciche powe on ool mpders il

tphe about &) secoTeE, LA L |

L L Rl

Details: Config (tab): NFC / Wi-Fi

Some receivers include NFC transponders. It may be possible to read the Bluetooth ID, MAC and PIN and the Wi-Fi SSID,
MAC and password via NFC. It may also be possible to modify the Wi-Fi settings with this function.

From the main menu Config (tab):

LandStar prompts to hold the NFC reader on the PDA next to the NFC icon on the receiver:

Haizp th: NFC Il ol PDA
close o the receimer NFC
Rabviel wahhibis ks g i P,

If possible, the NFC transaction will download the Bluetooth ID, PIN and MAC; and the Wi-Fi SSID, Password and MAC.

On some devices it is also possible to modify the Wi-Fi SSID and Password.
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Details: Tools (tab): Map adjustment

Map adjustment allows vector maps (DXF, DWG, SHP, KML and KMZ, WFSDB files) to be georeferenced with multiple affine
points. This adjustment tool will not work with raster images like .TIF, .PNG or .JPG raster files.

From the main menu Tools (tab), click on Map adjustment:

- +
Tooln  J§ -dr::;r?m

Use the drop-down box to choose an imported vector file:

Add control points to associate Map points on the vector map with Known points, in the survey:

— g T
i i [

1 bindel 5 e wh
i | F]

¢ F oWl R UEn
] . = 11
A FHY
b | o el 'LETY
[ iR1

NTSETT Tl LA

LandStar 8 User Manual 183 CHC W&




Once three or more control points have been entered, residuals will be shown:

v v

| B LIA S A1l es -
| 37 var e Z'i'J"n\ ez

| BN S 0T N,

| TG 2 TN TR
| Y 4% 2Emand N 2% s
| 2T Ath g ¢ g

Finally, click Next to complete the Map adjustment.
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Details: Tools (tab): Volume computation

LandStar will compute the Volume, surface area and cut/fill
balance of two surfaces or a surface and a reference

elevation, then and create a Volume report:
WL T

From the Main menu, click on
¥ |-
WL . vomes

A list of existing Volume calculations will be displayed:

o

LandStar 8 User Manual

Click on New to create a new calculation:

fhemayd |5d [*]
1241 el Pl Low
i

Bhwied
rimw T

g Reaiprw

Fruad Limlam n

Enter a uniqgue Name for the Volume calculation. The
calculation will be kept with the job. It won’t be possible to
edit the definition, however it is possible to change the
Units and then view the results again as needed.

The Cut swell factor accounts for the increase in volume
when compacted undisturbed soil is excavated and swells
to fluff (air pockets) in the loose soil.

The Original surface (Base), typically the pile bottom or pit
edge, can be defined by several methods:
i 1

Fylr—n n i wras |

Latli s dHmr=—e |

Frie=aw =

Pylp e ey

S e T4

Reference elevation A single elevation that is used as the
Original surface.

The elevation of the single point
specifies an Original surface elevation.

Reference point

Reference level  3-Points used to manually define an

Original surface plane.

Surfaces difference Manually define two surfaces: Original
surface and Final surface. This provides
the greatest computation control.

Stockpile/Pit Automatically computes an outside
boundary of the specified surface which
is used as the Original surface, then
computes Cut/Fill from the remaining
points in the surface. Ignores the
volume between the boundary and the

inside points.
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For example, let’s compute the pile volume for a gravel pile.

o B3 s
a0

*
mz‘m.ﬂm

ou® o213 W
e
| PPl e
= o ..,’"
1"
pAL e13 eus oo
o0 WWene
el
el ®

o

L A4

Points 101 through 113 define the

perimeter and points

200 through 225 are randomly collected over the pile

surface. The pile is about 55 feet w
height at the center.

First, we define two Surfaces:

ide and rises 3.5 feet in

= Valumelemo Surlsces | 1)
{ i
Cmres 2T WED Gy 10 e 70010 g
st Firber s 4
i ZTM B aa pws 4 1H B0
[Fi2,] =h
|
| PlleBagiom
|

| Sslem TI1SHEE S OH eed TINS5
fasrerm mhaE

P AIE AT lwd w4000 F]
En G- |

&

PileBottom includes 13-points around the edge of the
gravel pile [ See Details: Project (tab) > Surfaces on Page 90
for additional information on adding Surfaces. ] All includes
all the points, both the edge and center. Setting up the

Volume computation:

Hatir
T LY L i
Cun wwndl farime
1

| et
il e defitan
Oviganisl Siiiface
]
Fird Sarises

1]

Cadevilaiinn direcom
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CHCNAY

Pile Bottom:
e doy
5
® L, P 2 o™
4138004
ot
LRTTeT) o™
ann
112
® s
e &

e i g AL gss
ALTS 367 AN s

All surface:

wm o .
o Comadenom %N
o, o> anim
0%’&,:;”'
.8, %@

. &7 Cuisi s 0
TRIS .z”“ » ®anm
1l .
Canns e °

.4.\15.!" .IHS »

Choose Calculation direction = Original to final, finally click
on Calculate to compute the differential volume, build a
differential surface. Click Export Report to write a PDF.
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Results tabulation:

Prasect
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Surface visualization:

ValumeDemo-Result

Fin
LI Qe o £
Yargs

[ tomsew ]

Cmt
dax Yoira

Exported PDF:
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== e
= ===
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Click on then switch to

" )
LN L R
r-n
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- , use one-finger to tilt and

rotate the image, two-fingers to move it:
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Details: Tools (tab): Area computation

Area accepts an ordered list of points and computes the area enclosed by them. The points can be selected from the Point
list, from the Map or entered as a range of points.

F th i Tools (tab), click on Area: . . .
rom the main menu Tools (tab), click on Area Select from library (Point list)

* [ | Select from library displays the Point list with checkboxes.
: — Points are selected in the order they are checked:
Toala > Mg Tisoda Tawl- Poinis
Add

N [ et o

o - —

k] P Teai Jh,—

Aprge ol poeen BE n Q

ml
Enter coordinate Bk =
v

It is possible to hand enter points, one at a time, or in =
conjunction with other selection methods to build the area &= .
point list: L=

Fin= 1 u

] -

[ stared

e Grid (NLH] [ ]

Rk (M) i

Baut (5] Crontem Select from map

Eewlion Cronfame Select from map shows the CAD screen:

ToolaTeat-CAD view

ar
@4 o]
|8 =TI
i o
,.‘.tn i e
I 3 S
.::“ . ;u
. o |
-' ,' ./;
!
T e
& | L.
| &
8 .
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Then click on points, one at a time, in order, to select the 11 - 18 NOT: 11-18
area’s perimeter:

Comma separate point Names “11,13,15,17”

Once an ordered set of points for the Area list has been
selected, click on OK:

Tl Test Af s

Click on OK to complete the perimeter selection: |“ E

View The area summary results will be shown:

| T pemsrTEET 21036 TR NS

30 perriein 31508 D Lk

0 e BELZIT Arres

0 e B5Z THE hores
Farizcmisl detasce units

Pl 1S iy} ﬂ

Aram stz

Acres |

Carcd

Modify the distance units:

L

Ve | LES Sy

T S N T B

And the area units:

Range of points

1 by

Range of points accepts a comma separated list, or hyphen

separated range of points to include in the Area list: iy L
Mame oy M
Avea
Ti:-10 [+ ]
e
Cancel i

Because LandStar Point names can include the hyphen as needed.

character, you must space separate the range hyphen from
the point names:
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Details: Tools (tab): Inverse

The Inverse tool computes distance and bearing between two points or a series of points (Traverse style).

Consider the corners and quarters around this section:
al s s

»

» - i—ﬂ-_ \ L] ‘._
) ! — (™ -
O
f 5 z \ »
) A
L " 7
| S o |
4 ]gv;' \ j

From the main menu Tools (tab), click on Inverse: Click the [~ ] Move up button, and point 12 will move to

Al the top line:

M > i . G T

Invsering from 11 to 12:

Then enter 16 as the B point and LandStar will compute the
East Quarter to West Quarter distance:

u e
s ENES [ERE] B

| Pintamcs G0 :':ti;___"_.:::ll: | Bite - n
Einlaecs (30} B4 498 UEN Danlamae (01 :::;'",:n':
{ Boaring M 1EE119AT W { Cantance (30 B0 5B 1N
: Wops R {19319} Niarieg 5 AP SLOY A0 W
| Wertl mnge 4332 2% :-.m A -1 i)
| L BETG:2T-F0d | et N 1 A T
N Ta&L BT LEH [, TR T
. T A TS LEH | an FI-51 1Sh
&l bnwsom ML LN A= (R AL ET pll, .1
| &Eieamsns 57 5az mn

The distance is shown in both USFeet and Chains.Links with “

State Plane Grid Bearing N 120 14 W.
Itis also possible to Inverse in the CAD View, see [ Action

bar: Measure ] on Page 146.

Details: Tools (tab): Angle conversion (DMS.s <> D.ddd <> GON)

The Angle conversion tool is useful for converting Degrees Minutes Seconds to decimal degrees, decimal minutes, decimal
seconds, radians and Gons and vice-versa.

From the main menu Tools (tab) click on Angle Conversion:
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Select Degree, Minute, Second, Radian or Gon as the primary secondary unit. Then enter an angle in DMS at the top or the
secondary unit at the bottom. As any value is modified, all other values are recomputed:

e -] & A5

&) Degras | T8 70454 -
i Mimas  1EFE QP SEADN000

O Becond  SESTE FESCOMH00

) adian & 4FENITTEEY

™3 Gawhi PO Ve b

Details: Tools (tab): Parameter calculation, 3 or 7- parameter

Parameter calculation accepts matched sets of GNSS points (with underlying Lat/Lon/Height data) and Known points
(projected values). After selecting a transformation style, verifying residuals, and computing best-fit translation coefficients,
the translation can be entered into the current project’s coordinate system.

From the main menu Tools (tab), click on Parameter
calculation:

LandStar 8 User Manual

The Parameter calculation dialog is shown:

|
E=
I I jlmameminis -
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Select the transformation type:

] pEETHEL

! p e e i)

Ipmpreiery

Then click on Add to create GNSS Point — Known Point
pairs:

| | SSES e
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At least one control point pair is required for 3-parameters
calculation, at least three control point pairs are required
for 7-parameters calculations.

Tyge
T -

CHCNAY

Click on Calculate:
Accent the new detum

waneformetion pidamelers now?
AnTingis Wily®
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If the translation is acceptable, click on YES. If LandStar is
not happy with the residuals, a warning message will be
displayed:

Hirgivial iideduil maoiirds
LLLE L R o

i 4

Largs rensiual. Acoap
airpeay?

iz ¥

Click YES to continue anyway. The transformation will be
installed into the project’s coordinate system. The
adjustment can be viewed from the main menu Project
(tab) > Coordinate system > Datum transformation (tab):
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Details: Tools (tab): Point to line distance

Computes the nearest point on a line to a specified point. Returns the Station, the Offset distance left or right, the nearest
point can be saved to the Point list or directly staked out.

From the main menu Tools (tab) click on Point to line distance:

% Enter A: 17, B: 15, C: 16, then click Calculate:
[ oA
o5 Paint 1z line P bmtdin
> dat .4 119
. . . . Slakim
Consider this section 16 with all corners and quarters -
PhhE R LEE
found:
— - - 3 P v
S ._/—c..“’“-—— —— oo 2
1 r \ ,-‘ . Lo 3 T
TN R >
A . : e [}
) ; ! SaTROWE B IR
) Bt 5]
| 16 = 10 u 43 R il L
. { '; - Ew=givm
',_r-’ A \ e CLEC R e
1/" L -y /. [ ey ra—— T
| [hem=ryremn
4 ,“. B ATA SRS SET LR N S ad ) LA
_?p ,—-.—J_‘h'—'— . 3
! Cancal
How far off the line from the southwest corner 17 to the
northwest corner 15 is the west quarter 16? The intersection point is computed with the Description:
“16 to line 17”-15 STA 2666.941 USft R 5.443
USft
1L
W’:I" ABE - Click Save to save the computed point to the Point list. Click
" \
perpeedousr Barance '//.' Stakeout to stake it out directly.
e owt 1o bewe &R ]
A
]
e
e
e [ > |

Details: Tools (tab): Offset distance

Offset from an origin point at a Grid bearing, a specified horizontal and vertical distance. Compute a new point and add it
to the Point list or stake it out directly.

From the main menu Tools (tab) click on Offset distance:
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> [l digtance

*
Toals

Consider this section 16 with all corners and quarters
found:

O

~

4/

Y i S0
Lw
P7f~~<3ﬂw_~* l“

Place a point at the midpoint between the south quarter 18
and the east quarter 12.
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Enter point 18 as the Origin (A). The Horizontal distance
should be % the distance from point 18 to point 12. Enter

“18,12/2":
o aanie detence (A7

jl Al

=

when the cursor moves from the window it will compute

the Distance:
shueiranisd dislance (RIF)

THTA TS LH

CHCNAY

Now enter the Bearing as the computed bearing from the
south quarter 18 to the east quarter 12 “18,12”:

Brriy
= 3

% 1L1LE

Tl i pemisia
when the cursor moves from the window it will compute
the Bearing:

Drigin (A)

Horronie Ssincs [AF)
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Set the Vertical distance to 0. Click the Calculate button:
[Ty

[He = &)

[

L]

BTN D R
il ()

SRR e LAl
Elpryinem

SEEjd Ak LEN

el i

Cancal

Click Save to save the computed point to the Point list. Click
Stakeout to stake it out directly.

Viewing the CAD map:
(WS

The calculated point COGO_2 is in the desired location.
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Details: Tools (tab): Deflection

Compute the angle of a point offset from the endpoint of a line to the line.

From the main menu Tools (tab) click on Deflection:

> - Deflectian

Consider this section 16 with all corners and quarters found:
e B .

b
"
Tu

- L

-

?vr-~43€b~—“

What is the angle of the line from the northwest corner 15 to the north quarter 14 from the line between the southwest

corner 17 to the northwest corner 15?

L s ASC LA
trhr edmotion
sngn froem AR ws B
s

©
- 12
T o IER

LIEERTER ]

[_owe ] omwes

The quarter is 44 minutes north of the perpendicular of 17 — 15.

Details: Tools (tab): Rotation

Rotate a point around another point, a specified angle. Create a point at the new location.

From the main menu Tools (tab) click on Rotation:

+ WA
e - Rotation

LandStar 8 User Manual 195

CHCNAY



Consider this section 16 with all corners and quarters
found:

— 7 ﬁ'_';’._—‘)'g—’—v . 3

Qo= x

Rotate point 16 around point 17 one half the bearing
between 17 and 18.

Set A to the southwest corner 17, B to the west quarter 16:
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Details: Tools (tab): Intersection

Enter the rotation angle as % the angle from the southwest
corner 17 to the south quarter. Enter “17,18/2":

BiLalicn arybt
LA . o

Tab ™ outof the entry box and the effective rotation

angle will be computed:
Dptaiien wups
A4 N S0 Bl

Ll eFihiisida

Click Calculate:
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Cancsl

Click Save to save the computed point to the Point list. Click
Stakeout to stake it out directly.

Checking the computed position on the map:

~ ey [N N6
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/
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COGO_3 isin the e‘xpectéd location.

Intersection accepts point pairs defining two lines, the intersection of the lines between these points are computed. If

there is no direct intersection, the lines are extended.

From the main menu Tools (tab), click Intersection:

.L'_- 1

&
Tooln  [REREERI
CHCNAY

Compute the mid-section intersection of the north-south
and east-west quarter lines:
" - i

e
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prees
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Enter A - 16, B- 12 (east west quarter line); C- 14, D - 18
(north-south quarter line):
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Click Calculate:
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Then Save:
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Finally check the stored point.

Compare the projected northwest section corner
determined by the extension of the lines from the
southwest corner to the west quarter, and the northeast
corner to the north quarter:

_L o J:;“-—.——r

't
¢

Enter A-16,B-17; C-13,D - 14:
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Click Calculate:
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then Save. Check the stored point:

dFORBRDP® &
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Details: Tools (tab): Bisect angle

Place a point on the line bisecting an existing angle, specifying the offset from the center vertices.

*

Fools 5, Beect angle

Consider a power line with a series of poles (4, 5, 6, 7, 9)
making a right turn:

o . (= ]

A

|

¥

8

E‘ -
Set an anchor 24’ behind point 7 on the line that bisects 6,
7, 8.

From the main menu Tools (tab) click on Bisect angle. Enter
A-6,B-7,C-8.Since we want the anchor outside of the
included angle, enter “-24” as the projected segment

CHCNAY
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Click Calculate: Click Save. Verify the projected point in the CAD view:
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Details: Tools (tab): Divide line

Divide line will divide the distance between two points into even segment lengths (By distance) or a whole number of
segments (By segments). Point protection can automatically Skip points that already exist at the same location as the
calculated points.

- first point name. Check Skip points that already exist at the
“‘ - same location, even though there are no points between 1
Taala > Divida line and 2 to overwrite:

551 Divids lina

Given two existing points 1 and 2, divide the line between
them into 14-equal length segments.
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From the main menu Tools (tab) click on Divide line. Set the
Start point to 1 and the End point to 2, choose By segments
and enter 13 as the Number of segments. Choose P1 as The
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Click Calc & Save, then view the results in the CAD view.
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Details: Tools (tab): Point average

Choose several existing points to average. Show the residuals for each added point and allow adding and removing points
from the average before storing a new Point average.

From the main menu Tools (tab) click on Point average Click on Add:
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The Point average screen is shown:
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Click Select from library, then check all the points to
average:
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Click on OK:
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The ranges for N, E and Z are quite high.

Click on the - H Res sort order button to sort the
horizontal residuals from largest to smallest:

1 |"'_I

aam
Bamd

Lyarrms

T LT

1 Jrmsiediy Fieh sk

B Sai LT LR
= s T
W & i 8 i ueh
i LT
T A iR [P R, ]

Uncheck the H and V checkboxes for the top three highest
residuals. The Range drops to reasonable values for N, E
and Z.

Details: Tools (tab): Plot Deed

Slide the bottom panel right and left to view the stats:
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Horizontal scatter plot:
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Click OK when the point selection is acceptable:
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Enter a Point name, choose a Code if desired, enter a
Description and click on Save to store into the Point list, or
click on Stakeout to immediately stake the computed point.

Plot deeds from legal descriptions. Directly enter a Metes and Bounds survey or a Bearing- Distance traverse using lines and
curves (arcs). Includes a Curve Calculator and provisions for arc tangent bearings or cord bearings.

There are two ways to enter Plot deed:

LandStar 8 User Manual
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1) From the main menu Tools (tab) click on Plot deed:

IIIII>“NWN

) From the CAD view click on Draw, Layout:

- CAlrvew -, >.

Select the Layout mode:

Larpoiil imode
= Sawe Poitis aau biaea

(01w ady st
O Sawe iy lawn

e [

Cirndisl Fira]

Points and lines may be easier for visualizing a complex
description. Enable elevation to keep a site elevation,
disable Elevation to place the description at a design
elevation of 0.0. This will cause issues when using a robot,
so it may be best to hold an approximate site elevation.

Specify a starting point:

HldQ oD @

9 0o

Click on any existing point, or enter a new point from the
Project > Point list > Add prior to entering the Deed Plot

CHCNAY

function:
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From the first point, specify the first
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to start at an assumed project position like 10,000, 10,000.

call as a Line or an Arc:
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by choosing the Drawing target:

Lira

e

Deed plot line entry
Select Drawing line:

Enter the Bearing, typically using Quadrant bearing
notation see [ Entering Azimuths/Bearings ] on Page 14 or
with the Bearing button:

iwrwing  |Line

P

From compass of PO,

From 2 gasine

| HF ]>
The Bearing selector also includes +/- 90° option for turning
right-angle corners.

Enter the Distance:

Override the default project horizonal units for a
description with mixed units like Chains or Links. See [
Entering distances ] on Page 14 for examples.

Specify an Elevation:
Eleitli (1 o0 ush

o
(iwewtamn
= Ehpvation
vertizal asdgle
L
Eope [1H)
Bl [
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The new line will be plotted on the CAD screen in red:
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If the new segment looks correct, press the . Add button.

Continue entering description calls until the boundary or
layout is complete.

Deed plot curve (arc) entry

Select Drawing Arc:

Ehrmwing  Arg

If the description specifies a non-tangent Chord bearing,

Enter the tangent Bearing:

ST O ] [ =

il T 137

click on the [ ¥ | Bearing selector:

g 6 3 A

3

Chord heating
Froun confepesy o PLOA

Fiom 2 poinin

[ HE ]>
To change to Chord bearing entry:

il m

TEEITI N
The Bearing selector also includes +/- 90° option for turning
right-angle corners.

N TS oy i

Enter the arc Angle:

ERETEN] e 0
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The Curve calculator will help convert the curve values The new curve (arc) will be plotted on the CAD screen in
found in the description to an Angle + Radius: red:

Curve Calrslaing ¢« HunmtsvileDeed-CAD wew

[Pl
N a

Canrel

If there is a Curve radius, enter it first, then follow with the
Arc length or Chord length. Only one is needed to compute
the arc Angle. Click OK to save the Radius and computed
arc Angle.

If the new segment looks correct, press the ! Add button.

Continue entering description calls until the boundary or
layout is complete.

Plotting deed descriptions, a complicated example

The Deed plot function is best described with a complicated example:

A part of the Southeast Quarter of Section 23, Township 6 North, Range 1 East, Salt Lake Base and
Meridian, U.S. Survey: Beginning at the East quarter corner of this Section 23, thence South 89°36' 25"
West 1446.81 feet along the quarter section line, thence South 6°59' 51" East 565.86 feet, thence South
4°54'27" West 66.0 feet; thence Easterly along a curve to the left with a radius of 206.57 ft., an arc

distance of 110 feet, a chord bearing of N. 79° 39' 08" E and a chord length of 108.70 feet to the True
point of Beginning.

Thence Easterly along a curve to the left with a radius of 206.57 feet, an arc distance of 50.3 feet, a
chord bearing of N. 57° 20' 25" E and a chord length of 50.13 feet; thence Northeasterly along a curve to
the left with a radius of 2683.29 feet, an arc distance of 100 feet, a chord bearing of N. 49° 23' 04" E
and a chord length of 99.99 feet; thence South 46°54' 35" East 225.64 feet to the Northerly line of Snow
Basic Road; thence South 43° @5' 25" west 92.25 feet; thence Southerly along a curve to the left with a
radius of 164.61 feet, an arc distance of 263.10 feet, a chord bearing of S. 02° 41' 56" E and a chord
length of 235.98 feet, along said South line to the center of an existing road, thence two courses along
the center of said road as follows: South 41° 30' 42" West 58.98 feet and South 11° 46" 15" West 211.33

feet; thence North 86° 17' 37" West 152.24 feet; thence North 0° 17' 53" East 606.33 feet to the place of
beginning.

This description has a Point-of-Beginning (Initial Point or POB) at the East Quarter of Section 23, then 4 calls to the True-
Point-of-Beginning (TPOB) followed by 9 calls that close back to the True-Point-of-Beginning.
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Plotted over an orthophoto, this is the complete description:
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It is usually best to plot the initial calls leading to the True-Point-of-Beginning as one connected polyline. Then build a

second polyline, starting at the end of the initial calls; around the closed parcel. At the final course LandStar includes a
Close button which will add a (hopefully) small segment representing the closure-error needed to complete the polyline

into a polygon area.

Because description calls are typically only specified to the nearest arc-second, there will always be a small closure error
which represents the loss of precision. A closing segment of excessive length is an indication of an entry blunder or a ‘bad’

description.

Summarizing the calls from the description above into a table:

LT T e
Point of Bsgireming
[E1.0]

Lire

Lams

Arg

Trus Point of Bsginming
AFL
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Lire

Lams

A
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LErw
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o bad Bl

B i

O s s W B

Bearing

zadrant

bEaing
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06, 59EL
¥ad, 5437
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343,515

B4l a2
E11.481%
&BE,1TET
1848, 1TRE

Length

446 . 81
12108 1
66, B

I3k . 6
92,325

EB.98
¥11.33
183.24
6. 37

Rafiiis

296, 57

L
2883, 29

184,61

Arg distance Dond begring

118,
1O

Lo . 23

263.18

Choegd 10 Trgs Poied of Beginniag

Cord
pzadranl
beear ing

157.280%

157. 2805
149, 1304

The quadrant bearing shortcut entries see [ Entering Azimuths/Bearings ] on Page 14 and distance entries required for

curve entry are bolded.

Starting at an assumed position 10,000, 10,000. Step-by-step instructions for entering this description follow:
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From the Tools menu, click on Plot deed:
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Bl a4 &
tite Plereeon Asvghe
e s
4 . »
&r P
Partmetet  Podm bie  Offset dstance
CRCUAIN ot
L L K
Owtection Woert e
Cumcte b FAat dewnt
B & 4
Canitatte Natwr Wive
ra v o x
Pick Point 1 by clicking on it:
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set the To point as 101:
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Enter Course #1: Line S 89:36:25 W (389.3625) 1446.81,

Click the . Add button, enter Course #2: Line S 06:59:51 E
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Click the . Add button, enter Course #3: Line S 04:54:27
W (304.5427) 66.00:

Ihiviimstr | WA (B |EON

[resinn

el Wi
el i —
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Click the . Add button, switch to Drawing Arc with Chord
bearings:

Enter Course #4: Arc: 206.57 110.00 N 57:20:25 E
(157.2025); use the Curve calculator to compute an arc-
Angle from the given Radius and Arc Length:

Curve Caloudator

Makia  J0 570 LUER

Lt - 71HEUSh

Chord T TO6 LEH

Anghi 303007 AR

N Frenrria
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Click OK, then:
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Click the . Add button, then click the . Stop button to

end the initial calls at Point 104:
I| - | :
l

i -]

0o NSy ORDM S

Click on Point 104 then edit its properties, change the
Description to TPOB:
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F— [P P WA Enter the Radius 206.57 and the Arc Lenth 50.3:
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Click Save to accept the change.

At the bottom of the CAD view, click on - Draw, then . Click the . Add button, enter Course #2: Arc 2683.29
Layout: I 100.00 N 49:23:04 E (149.2304):
Crorv Calcadmiar

Rpddum 170G L

. . R Lengen 150 SN ]
Again, choose to Save Points and lines:
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Start entering Course #1 of the parcel boundary: Arc ) Lu: "
206.57 50.30 N 57:20:25 E (157.2025). Choose Arc = ] 4
[>] gz
then click on the Curve Calculator s
Eurve Calcultor b
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Click the . Add button, enter Course #3: Line S 46:54:35 E
(246.5435) 225.64:

@ J— L S

Click the . Add button, enter Course #6: Line S 41:30:42
W (341.3042) 58.98:
1

Click the.Add button, enter Course #4: Line S 43:05:25 - R : A
W (343.0525) 92. 25: : . &

" &

=]

=t

Lo

.

L

Click the . Add button, enter Course #5: Arc 164.61
263.10502:41:56 £ (202.4156):
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Click the . Add button, enter Course #7: Line S 11:46:15
W (311.4615) 211.33:
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Click the . Add button, enter Course #8: Line N 86:17:37
W (486.1737) 152.24:
e

i (

@ y E
= ﬁ?

£

)

.

L |
e

HEET

|z iy

lipnim= s LF Wil

[LEC LTS kNS [P

e

Bl |

aBL RN

Details: Tools (tab): Transformation

Click the . Add button, enter Course #9: Line N 00:17:53 E
(100.1753) 606.33:
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Click the . Add button, finally click on the . Close button
to draw an ‘extra’ line segment from the final Point 209 to
the initial parcel Point 104. The length of this extra line
represents the description’s closing error:

O DloeX g

With a polyline and point set that fully describes the
property boundary, it is now possible to perform a Site
calibration on a few points, or to move, rotate, scale the
computed description to grid coordinates.

Translate, rotate, scale points and objects based on a multi-point alignment or manually entered delta-offset, rotation and

scaling values.
From the main menu Tools (tab) click on Transformation:

II!II>Tnmhmmm

Choose the Transformation mode: If a fixed translation distance is known or can be computed as the distance as a vector
between two points, Manual entry is applicable. If you have several points, perhaps a parcel boundary based at 10,000,

CHCNAY
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10,000 which you would like to align with a few found GNSS points, then Align matching points will probably be better

suited.
Align:
ALKTH METC Db [IDiefT -

Manual:

Eariial mrivy - 1

| 1 rns ar o poae
Hawrth [M]
DO LB
Eawt LY
| TN LS
| hrasen
Hrdatrm
00 B2 S0 DIEHE R0 - I

Md PP ihbddd b

. .
Align matching points

Click the Add button, then enter coordinate translation
pairs with the Source on the top and the Target on the
bottom. The Target coordinates can be directly measured

-
by clicking the Start measurement button:
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Clicking OK will return to the Transformation point list,
clicking OK & Next saves the current pair and readies for
new pair entry.

LandStar will compute a best-fit transformation between all
the transformation pairs. If less than 4-vertical control
points are enabled, LandStar will use a Vertical Constant
adjustment method. If more than 4-vertical control points
are enabled an inclined plane adjustment is utilized. If you
use an inclined plane, you should try to have point-pairs
that surround all of the points in use. If you don’t really care
much about elevation, only leave one vertical point-pair
selected.

Large residuals highlighted in red are an indication that the
pairs are not well matched and an indication of blunder:
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B
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H
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However, some applications like fitting a record 80 chain x
80 chain section to measured section corners; may be

CHCNAY

expected to have higher residuals and be acceptable:
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Point pairs can be held for Horizontal and/or Vertical by
(=]
using the =+ method checkboxes. When transformation

pair entry is complete, click Next to view the resulting
transformation:
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A reasonable rotation angle, a scale factor that
approximates the Grid-to-Ground scale factor, and a
Translate Z equal to the average project elevation are an
indication of a well-formed transformation. Click Next to
continue, then choose Library list or Objects from map to
select points/objects to move. If points have connecting
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lines to move, choose Select object from map:

| Sedecs poatEa o e’

& GSelec atjecn from map

Then click Next.
Highlight the points and objects to transform:

.- Trs2 -CAD view
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Manual Entry

Select Manual entry as the Transformation mode, then
enter a base point for the Rotation and Scale. Enter the

Rotation directly or click the “ Rotation calculator
button to Calculate the rotation based on an existing Old

LandStar 8 User Manual

If the selected area has points or objects that you don’t
want to include, click on them after the selection and they
will deselect.

Click OK after selecting an area or points to transform.
Choose to Overwrite or Save as new points with an optional
name Prefix:

| T crprmrne poais

B Savw as new 2oams
Prola 7

Click Next:

Trunsdormatsom reault

Pointa; 4 Lines: 1

[ 4

Once transformed, surveyed type points are converted to
calculated COGO points. A summary count of transformed
Points and Lines is shown. Click OK to return to the Tools
menu.
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azimuth and desired New azimuth to align to:
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Click “ to align the rotation with two existing or entered
points:
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If the Rotation is manually entered, preserve as much

angular accuracy as possible to ensure that distant points
align accurately.

CHCNAY

Click Next to set the Scale value:
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Click Next to set the North, East and Elevation deltas, click

thelarge * Delta computer to compute the Translate
deltas from two points:
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|

Bl ] iy

[ 00E) R

AT levarian
11 M0 LIS
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Click to compute the delta between two existing
points:

T3 - Tridmila s

Harih (M)

[= 1 i1

| Tii i

Parth (M)

B (X}

Click Accept when the deltas are correct.

Click Next to continue, then choose Library list or Objects
from map to select points/objects to move:

L Tedecs poecks o kbvmy

l:.'l- Beter objeci from map
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If points have connecting lines to move, choose Select
object from map:

- Trs2 -CAD view
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Then highlight the points and objects to transform.

Click OK after selecting the area or points to transform.
Choose to Overwrite or Save as new points with an optional
name Prefix:

[ ] oversrne pomis

| B Save s new SoaTs
| Pl 7

Finally click Next. A summary count of transformed Points
and Lines is shown:

Transdormmatom reult

Poipta; d Linas: 1

[ =]

Click OK to return to the Tools menu.
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Details: Tools (tab): Area subdivision

Subdivide an existing closed polygon into two parcels. Supports: parallel by two-points, perpendicular by two-points and

hinge-point.

If you are starting with points with no polygon, use the CAD function Draw > Polyline to click through the enclosing
boundary corner points, then close the polygon with the Close option.

From the main menu Tools (tab) click on Area subdivision

e
Amp
>  ibdatnian

The CAD view will be shown, pan/zoom to view the
enclosed parcel, then click on the polyline to select the

polygon:

@
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The enclosed total parcel area will be computed and
shown.

CHCNAY

Click Next:

Fgrait by ¥ poeany

Choose the Method:

Parallel by 2 points: select two points and an adjustable
trim line will move parallel to the line through the two
points.

Perpendicular by 2-points: select two points and an
adjustable trim line perpendicular to the line through
the two points will be shown.

Hinge point: select a single point and then adjust a trim
line through the point.
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Then click Next:
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The selected parcel will be cut in half (two equal sub
parcels) constrained by the selected Method. Click inside
the sub parcel that you would like to specify the size of
(parcel 2 above), then click Next.
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Details: Tools (tab): Calculator

A simple Calculator for simple computations.

From the main menu Tools (tab) click on Calculator

:
LLEL . Calcuasar
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The resulting sub parcel size can be specified by direct
Value input or Percentage of total Area type. Enter the
desired value, click on Calculate to display the result. When
satisfied with the subdivision, click Next.

The resulting split point will be computed:
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It is possible to directly Stakeout the point or Add it to the
project Point list.
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B { & Coleulaber

] 7 | *
0
Notes:
v root (not square root)
144v2=12.0
A
power
4173=64.
DRG

toggles between Degrees and Radians

Details: Tools (tab): Ruler

Displays a ruler that shows centimeters only.

B
> Ridsr

Notes:

E] Calibrate the Ruler by setting the length of 5 cm.
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Building GIS Datasets in LandStar

GIS attributes can be assigned to Codes, and then the Codes are associated with Points at the time of collection. When a
Point is stored with a Code that has GIS attributes, the user will be prompted to enter values for the GIS attributes.

After GIS data is collected, a standard Shapefile (.SHP, .SHX, .DBF, .PRJ file set) can be exported for use in other mapping

products.

Begin by setting up a Code with associated GIS attributes.
From the main menu Project > Codes > New:

| e [

Fuires

(=T

Drasing type

Froami -
C=prrprion

Fam Hpgran

Sarmbal '
I.!.1-l.|: i1 b

U

-0 by |

Laymr

5 |
QS Anfitaiim *

The Code name is FH with a Drawing type of Point. The text
Description is Fire Hydrant, which is only used as a prompt,
it is not included in the data set. A Symbol with a display
size and Color can also be specified. The Layer is used for
CAD drawings and DXF output, it typically will match the
Code Name.

Measurements that are collected with this Code will be
grouped into a shapefile named FH_Point.

Click on GIS Attributes:
IS Adiribigieg b
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then click the n New attributes button:

it attiibuts

T g bl iy

g lumai

Rk #il (AL

Set the attribute Name to TagNumber (GIS attributes
should not have spaces in the names for compatibility with
external tools.)

The attribute can have these field Types:
r

TR TRATER

The fire hydrant tags all begin with H-, so we can set the
Type to Text, and set the Default value to H- to simplify the
operator’s data entry.
Enabling Required:

Beruirerd L
forces the operator to enter a TagNumber before they can
continue storing the measurement.

Next enter a Text attribute named Color. We only expect to
find Red or Yellow fire hydrants, but include an Other just in
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case. then click the 5 Start measurement button, wait for the
m measurement to complete:
e
L L
Tripe —.t
Tt
Dtaui

when the measurement is ready to be stored, the user
must enter the information associated with the FH Code:

e > N P
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Teghems: . o F
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Qi * T el ot -
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Also include an integer NumPorts (the number of holes that
water comes out of) and three attributes to hold the sizes
of the ports in inches:

TagHumbser ~

Tewrt Dwlwai i et

cotr N

Tem Delpan Cries -

HumPerts 'S The m From previous button duplicates the

e | Frompoint |

— attributes from the previous point. The From
- point button allows attribute duplication from an existing

I ramibey Delmait 4
point with the same code.

Pori2Gize ~
i ke Delpon - After the operator enters all information, and optionally
S — adds Multimedia (Pictures, Videos, Sound recordings) they

click Save to return to the Survey screen, ready to collect
the next measurement.

I rermbm CwlwiA

A shape file set can be Exported from the Project at any
time.

Every Code in a Project can have a separate unique Feature
list.

Now, when in any Survey function, the operator can select
the Code FH:

FH

2l '-E‘

il @

[y
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From the main menu > Project > Export menu, select the
Other format tab:

Trxd Ale
Foerrrai
ir LV
T b2 = Oeoi it -

B ey

=
e T ] i bumn

Set the Format to SHP, choose Coordinate format from:

Ll COThiTET e

YWESAE L'l on cooe e

Adjust the Filters, then click Next:

£ Finkbidlisraninry- Export

Filg aarie

ity 20230 04 20 TRSD

Ea

O BE°

o il alorsge

o i ¢ e e

§ Up

Ik ager wrsawirds O Tosedgadshyeni

| wolums 2023-09-04-18-46-14
ierEagE preamEl LT rsniz e aiga gl
e 1T ORF-0al T0-d6- 14
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Navigate to the destination folder for the Shapefile set.
LandStar will made a new folder named:
Projectname_YYYY-MM-DD-HH-MM-SS

In the new folder:

b | R e [EEE—T Ra sl Fopeydter pmbeey S0 e P 1B B2

Lo, cram Romiigag
Fourty y iali, Prass il
E=vrmy crom Fras gy
Erwrey crem Fremakbe
| oy ¢ o, o i
" ra Puaapg
TP Bl i
| P By
Fri_Fomirag
Fil Pupiisa

there will be a .SHP, SHX, .PRIJ file for each used Code in the
project. All the points without associated codes will be
combined into the Empty Code_Point.xxx files.

In addition to the defined attributes, each file holds extra
columns. For this example:

PT_NAME Point Name

PT_CODE Point Code

PT_REMARK Point Description

PT_LATITUD Latitude in DD.dddddd

PT_LONGITU Longitude in DDD.dddddd

PT_ALTITUD Ellipsoid Height in meters

MEDIA photo, video, sound three
comma separated filenames

TagNumber operator assigned fire hydrant
tag number

Color operator selected color

NumPorts operator entered number of
ports

Port1Size operator entered port sizes

Port2Size

Port3Size
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How to: Install, Update and Provision LandStar

There are two methods to download the latest version of LandStar:

1. Install the CHCNav Installation Manager from the Google Play Store. See [ Downloading and Deployment] on Page

6 for step-by-step instructions.

2. Directly download the latest version from the iGage website: www.iGage.com

Direct download from iGage.com

To directly download the latest iGage verified version, click
on this link:
https://igage.com/out/LandStarDistribution/LatestVers

ion/index.htm

then download the .apk file in the directory listing.

You may also open a browser on the Android device and
navigate to www.iGage.com:

0 % igage.com & @ i

$Gage ﬁ -

Find the link to Out on the top tool bar and click on it:
El = Igage, Comy s #— EI

<3

Click the link LandStarDistribution:

=<3
Click the link LatestVersion:

Iailex ol LandSiariisirilvesin Laes1 Ve o

Nammn

-

W] Lomadfim 802 TOUISES sy ee sop

The .apk file in this folder will be the latest version. Click on
it.
The file will begin to download:

0O %5 Guge com é O

(\"f.rh:.jngm-
Y e PRS- AN

After the file downloads:

b Fib tervdnagitied 5

Click on Open.

LandStar 8 User Manual

If this message is displayed:

& Chrome

FOf YO 30U RY, YOUX [NONe
TRy a) slowed o

Nl ushnown apeed from the
SOUTER. YOu Can Change Thie 0
Setimga

Click on Settings:
Install unknown apps

¢

Chrome

Allow from this source @D

Slide the Allow from this source to the right.
w LEneEStar
i o aaid B oahielal Bl gt

Click Install. Then wait while LandStar is installed and
deployed.

R ™
i Laencitar
nitaiing
.
Finally, when the install completes:
& LandStar
A iANLEe
|
CEava jims
k
Click on Open. Allow all requested permissions:
r
W

Aloe Lenctiar i pend
sl MrtiNestions T
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https://igage.com/out/LandStarDistribution/LatestVersion/index.htm
https://igage.com/out/LandStarDistribution/LatestVersion/index.htm

AFow LanaStar to
neceas s dovice's
location?

e iy o —
Ly S e

Do) -

Adirey LiandBue ie friski
s merage phone
CEbET

i

i |

r

Alow LandGtar 10
scCout PICADS, videos,
MRC, DT IO O ths
device?

) G —

. 4
Wait while LandStar initializes:

LandStar "8

The initial splash screen may take over a minute to
complete.

CHCHN.AV

Choose the menu structure:

i) Classw syl Simple tipe

| oK i
While the Simple style is simple, it does not match any of
the descriptions in this User Manual. It might be best to use
the Classic style while learning to navigate LandStar. Click
the Do not confirm next time checkbox, then click OK.

When prompted to download localization package files:

Mo bocalizatien pockage i
inmtallad, dovwenlzad?

Ho

[ =

Click on Yes.

S Localization packsges

Click on the appropriate country.
Dowwiload the kecalration
package?

ko

Confirm the package download, click Yes:

Downloadimg

il
It will take several minutes to download the package. The
package contains special projection zones, GEOIDS, local
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settings.
Locallzotion pachages
 STITITEE UAIN G
i ira ] R I
L

PRV ] LEE By
e e el Bank
!
After the download and installation is complete, a w/

green checkmark will display next to the package. Click
Close (at the bottom) to continue.

=
Predgarita
Click the Projects button,

]

Click the New button at the bottom to create a new
project:

Aslounng peomeed

Cooridiale dyatein

Codas lihinry

e
3|
>

Froject metbngs

Enter a Name for the first project, then click the
Coordinate system more button:
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| Brnedcuit RTCM {10E1=102T7]

Click on m Pre defined:

— Pra defined coordinate sy

Hegrm Lirnke] Silnlen -
hren WADEIEON) [ ~ |

[ Tunid (Sl C

| e ctrat &

Litah {Baith

| itah [Saath)

| arrani

Wi Mo

| warginim {South

;'-"."'llrl‘lln-ﬂflr."qm -

T
Set Region = United States (or your local), Area =
NAD83(2011), then drag up / down to find the appropriate
zone for your project. Additional information on Coordinate

systems can be found here [ Details: Project (tab) >
Coordinate system | on Page 64.

NOTE: If you are in a special state or county zone,
click on:

- KA [ w ]
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then choose a specific special area: Drag over to the right-column Vert. adjustment and select a

Geoid file:

HADER FE1) -

hrew
LESA COUNTY

AR GEDD 80
LERA, COUNTY I

LN og!
LERA COLNITY ki

TGGO7_0GR)_STALCY g
LSS, LR W00
2000 g
LESE, DOFUKTY W WISDRE
GaoetZ1 T IMmranints OG0
LERA STATE ki
ezl MR g OG0T
Lean ATAFE GR
OeocetlIaUs 000

LFSE, Tovridoran
Goont11 IWocoras CLI

L GecidAmka' 70 COD
. Cancel | GeetAmarcanliense | 28000
With the correct zone selected: GatesGLAMY 2N CTD)
GeoiP et 130 COD J
LUtah {Caniral} o -
. | A RT3 1 Change the Coordinate system Name to include a reference
. to the selected Geoid:
Brosdeasi RTCM {1021~ 1027 0

Mime | NADE] Litah Cemml G18@
i Har edutmenil
Type Mo adjustmen B
Gaoia e Geeatrniaiis ot [
Gipiy

Wlnan B lrew -

fripire]

Click Next.

Click OK.
Frojict g b
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Click on Project settings > then Units >: At a minimum, consider setting Azimuth display mode =
Bearing, Horizontal and Vertical distance = iFeet/USFeet,

R Area unit = Acres, Volume unit = Cubic Yards, and Station =
it T B amEIRAS Ex K0+00.00.
:mm” - Click Back, then spend a few minutes looking through
]
o the Decimals settings and GNSS settings. Additional
il e sy information on Settings can be found here [ Software
S e ] settings ] on Page 28. Configure as you would like the new
s s - ok on: TN
Syl - job defaults to be, then click on: e Save as
default so future jobs will share these settings.
LukfLon dmpley mods
o =3 Finally, click Back, then OK. A new project is available to
Firrironial dinfescw work on.
e = Activate LandStar using the licensing instructions found
T P here [ LandStar 8 Licensing ] on Page 7.
LE L ESoT o= ] -
e wni
bt E2
Valime i
Caibvc Yards [~ |
L]
El =00 0D -

How to: Moving data to the data collector

The easiest way to move data to the Android data collector may be to email it to the account associated with the device.

1001, 866349, 305, 1907554544, 4530 66, SW
1862, 871614,146, 1987634.252, 4521.98, WW
1803, 871569.611, 1912911.454, ATES.67, NE
1804, B66202.324, 1912866852, 4726.1B, SE
1005, 871591.788, 1910272852, 4606.77, W)
1806, 868930,964, 1912889.154, 4749,08, EQ
1807, B866320,724, 1918215.695, 4628.22, 50
1808, BGR9A1.721, 1987500_481, 4517.50, W

which has been sent to the Android device as a file attachment.
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Open the email in the Android device’s mail client:

+ - -

Saction Extenor cov file »
o

m ] w1
(=L

T

b mm (D

& Saplp & By | S Pl

= o

Click on the 3 Download button to download the file into
the Download folder on the Android device. When the file
has been received there may be a completion notice:

Sl nnbiler e i B
Drrarizami rnmyasis

In LandStar, on the Main menu Project (tab), click on

Points:
L]
= .-
Frope 5 B

The current Points list will be shown:

Fairma Frain do alaie

LandStar 8 User Manual
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Click on the m Import button at the bottom:

UBA: PRNELD [~ dut)
LA UL PNMELEED & et
LPSA: FWOALEF " o
. HEVE o)

LA FULL. PWMELCD (" ]|

LA PULL PHMLEED (4. shes)
KISk PNELD [* )

Mo B LH [ cye) (1 D0 0O00T)

Mo B L [ cav) o2 oddandad]

O0C 0000 O0OWOO0

Harrw AL [ caw) |dernm mn wnmsa)|

Click on OK:

Use the File selector to move to the Download folder,

located under Internal storage:

[+ I

o Miurnel slornge

' [Parert filide )

Highlight the SectionExterior.csv file, then click Open, the

import result will be shown:
L 1T e T T

Imporied 2 points
nuctmRi by

e
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Click OK, the imported points will be available in the Point
list as INPUT type points:

& UHFGureeyT-2-Potets (1)

Fromm in sk

FFEFFFEFFEFEPE

How to: GNSS Network Rover Internal Cell Modem

Step-by-step i93 Visual RTK receiver configuration as Network Rover using the GNSS receiver’s internal Cell Modem, with a
Wi-Fi connection from the Android device to the receiver.

The GNSS receiver connects directly to the cellular network and brokers corrections from the CORS server directly. Results
are then passed to the data collector via Wi-Fi. The internet connection of the receiver may optionally be shared with the
data collector.

]
u :
=> => => -<=Wi-Fi=>

CORS receiver Server in Cloud Cell Tower GNSS receiver Android PDA

Internal Cell Modem Method

Insert SIM card

Turn off the receiver.

Insert a cellular SIM card in the receiver:

Use a nano-SIM, gold contacts down, diagonal slot inserts first on left.

Turn the receiver ON. Wait for the receiver to fully boot.
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From the Main menu, click on the Config (tab) then
Insturment profile:

o
mginaEneTi
> pmlk

The existing, possibly empty, list of Instrument profiles will
be shown:

Click on New to create a new profile:

Irerumesain
Lre
(R o s =
Tolgl paior
[ e

Click on GNSS Rover:

CHCNAY

Configure the receiver:

Fatm P (i Pl e [=]
Fhara [mt] -
Ty WTE -'
(L 1 -'
Corrwilan el WP -
Arrerna bepr Lo E] KOHI -

g L] <j .

Enter a unique profile Name. Select the Brand, Type and
Model. Antenna type will automatically fill to the correct
antenna based on the Model.

If the receiver is a Visual receiver, choose Connection type
= Wi-Fi otherwise Bluetooth may be used.

If the Android device is not currently connected to the
GNSS, click on the Target Wi-Fi device:

. o
internat

1 @
Wi-Fi &
w» UIE"".":’E..“ i

- GHES-370408F

#liT] | V& R EET AT

When the i93 device serial number appears as GNSS-
serialnumber, click on the receiver entry to connect.

If the receiver is not listed or has been ON for more
than 10-minutes without a Wi-Fi connection, click the
receiver’s left button twice to turn the receiver Wi-Fi
back on.

After a few seconds, the PDA will connect to the head:

GNSS-3704057

LSS R 0

=rme
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then:
GNSS-3704057

Srnettms 13 Swes Ot t
Don’t worry if a message noting that there is no internet
connection is displayed:

‘ G- ATTW0E T Ras i amism
i frr- o

Do not tap the ‘Tap for options’, let this Android warning
box expire automatically.

Click the € Back button to return to LandStar from the
Internet menu. The Target should now be the Rover
receiver:

Fiares ¥ ] RS P Tl e o
T WTE -
BAnle i -
Coonetbin (e W4 -
Erapiuis ube Caiowd il -
[ )

B st s b

Click Next:

LandStar 8 User Manual

The device type dialog is shown:

HTRF
MTRIF peveacy PR ﬁ
APIS

- I )

e Bl e

& 0

Select NTRIP, then click Next:

If the CORS server is a TCP server (also known as
TCPIP, DIP: Direct Internet Protocol, or Point-to-
Point) use the TCP service profile. See [ TCP ] on
Page 173 for additional information.

Configure the Network settings:

[t

|
e N ] -

Dwregr. 1P
LRty g e

Ferl

P an peroed

Fe g Comveinn dils

Set the Network = Receiver network to use the cellular
modem in the i93 receiver.

Enter the Domain/IP for the network, either a domain
name or a dotted IPV4 address can be entered.

Set the NTRIP Port (usually 2101.)
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Click APN to set the Access Point name and SIM card
connection values.:

Acceyn o
dad com miin
Bial numba
FEOE

Unampms

Chpcler paree N O iDiedas W)
iephe mhoan 40 spcond . UG [
regquess & |

Set the Access point name. The SIM card provider will
supply you with this value. Some common values may be:
ATT Broadband

Verizon VZWINTERNET
T-Mobile fast.t-mobile.com
Data Activation Center dac.com.attz

UsS Cellular internet

Union Wireless SMART.COM

Dial number = *99# is correct for most markets. SIM card
Username and Password are typically left blank.

In the USA, if the APN is changed, the Cell modem power

must be cycled OFF then back ON to reset the local tower.

Enable the Cycle power... option, then click on Set.
JoBOO1-APN

CHCNAY

Wait 40 seconds for the Cell modem to restart, LandStar
will countdown to zero and return to the Data link
parameter settings:

: 1l0ls BeF il AL

P =

Fermsidiema N “

| lissiiaes

| Pasnmonrd

BpiraraTret cormerion Ses

Click on Get Mountpoint to download the
mount table from the configured server.

Wait (it should take 2 to 15 seconds) for the mount table to
be downloaded:

The mount table will be displayed:
Select mowetpoint

NETERTOMA

CEE_ETTRLY

(Sl ) e ]

ROLG_WTars

ALCHCada

SLC1_SCMRN

TREELIME

LA ATCMED

LALIZ BOMRY

Select the desired mountpoint (typically a VRS RTCM32 or
RTCM33 mountpoint will be best).
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Enter the Username and Password for the NTRIP server:

RSR— B

Deremia1P
| bhrngsge oen
Forl

BlniAlfwirt
| cremvs-hb TR [+ ]
| Umsrrses

rrawi st 1]
: Paaymed

Wi grerrdd T b plida

Retransmit correction data will transmit the network
corrections to the internal UHF radio, Wi-Fi, Bluetooth or
via the Serial port. Retransmit is typically disabled.
Additional information on Retransmit can be found in the
next section [ Retransmit correction data ] below on Page
233.

Click Next:

N N T

Retransmit correction data

Click Save & Accept to save this new profile and configure
the receiver. After a moment, the receiver will be

configured.
— —

Settiny ug marirarmee|
Ll
S -
If the network Username and Password are valid then:
r
| Secossshul, check details?

L]

L

will be shown. Click No to return to the main menu.

See [ Status ] on Page 95 for additional information on the
Status bar.

This Instrument profile can be selected in the future by
clicking the Instrument select button:

w U |

0P Mt e

O ol )

N .

A0 TURN Nt Moy 000
A0 TURN N Bover Bee ST

B} Pos LI 451 02

And clicking the Accept button.

When a Rover uses a NTRIP or TCPIP network correction source, it is possible to retransmit the correction stream from the
Rover to other nearby Rovers which effectively shares a network subscription.

LandStar 8 User Manual
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Many CORS network server agreements specifically prohibit sharing; however, it can be a simple method to utilize a
receiver as a network repeater on top of a hill where there is good cell reception, then push corrections down into a valley
to a working Rover via a UHF link.

Be sure to connect a UHF antenna to the receiver so the radio range will be maximized.

= ﬂ

To retransmit via the internal UHF radio in the Rover, enable Retransmit correction data:
Rerans={ Comechen [mn q
Ta
Higag=3
Protisssd
UATEL 148
Chasee aratmalii
128 £ Kir
Hmiiit

B

[HITL

Lisir dhafirtiad

Fipiescy

i) IR 4}
o .
Set the To = Radio, choose a Protocol, radio Channel bandwidth, over-the-air Baud rate and the frequency Channel to use.
Click Save & Accept to connect the Rover to the network and begin retransmitting.

How To: GNSS Network Rover PDA Modem

Step-by-step instructions for configuring the i93 Visual RTK receiver configuration as a Network Rover using the data
connection of the PDA (the Android data collector.)

Because the Wi-Fi connection of the Data Collector will be used to connect to Visual receivers (like the i89 and i93) to
utilize the highspeed cameras, the data collector needs to have a cellular connection.

This method is also known as DCI (Data Collector Internet).

The data collector connects directly to the cellular network and brokers corrections from the CORS server sending them via
Bluetooth or Wi-Fi to the GNSS receiver.

PDA (DCI) Modem Method

<= Wi-Fi=>
CORS receiver  Server in Cloud Cell Tower PDA / Cell Phone GNSS Receiver

Turn the receiver ON. Wait for the receiver to fully boot.
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From the Main menu, click on the Config (tab) then
Instrument profile:

“ mginaneTis
> ke

The existing, possibly empty, list of Instrument profiles will
be shown:

Click on New to create a new profile:

Irariamasain
[ r
RN i
Tripl i
T

Click on GNSS Rover:

LandStar 8 User Manual

Configure the device connection:

PR Fl] (1] Pl e [=]
Thara oK -
Frjm KTE -'
Wil l -'
Lot b WH -_
Arrerme lepar Lo KOHI -

g i <j .

Enter a unique profile Name. Select the Brand, Type and
Model. Antenna type will automatically fill to the correct
antenna based on the Model.

If the receiver is a Visual receiver, choose Connection type
= Wi-Fi otherwise Bluetooth may be used.

If the Android device is not currently connected to the
GNSS receiver, click on the Target Wi-Fi device:

* -
internat

T :
Wi-Fi L &
- UIE""I'GEJ = 41}

- GHES-3704087

i) | Ve AREITET T

When the device serial number appears as GNSS-
serialnumber, click on the receiver entry to connect.

If the receiver is not listed or has been ON for more
than 10-minutes without a Wi-Fi connection, click the
receiver’s left button twice to turn the receiver Wi-Fi
back on.

After a few seconds, the PDA will connect to the head:
GNSS-3704057

ety b =g (“'

EImm
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then:
GNSS-3704057

ornetimd 15 Swice Ot t

T e

Don’t worry if a message noting that there is no internet
connection is displayed:

‘ G- ATTW0E T Ras i amism

Do not tap the ‘Tap for options’, let this Android warning
box expire automatically.

Click the €
Internet menu:

LR ¥l GRS Rl pemm o
Hinril (R0 -
Tppme nE -
[LES ™ i “
Cimrimihin e W14 “
ErapInLs fubs CHiowd il -

B sy i

Click Next:

CHCNAY

Back button to return to LandStar from the OS

236

The correction type selection will be shown:

HIRF
LTEI gy vacw L ﬁ
AFTS
@ ]
e Euwcdens ™
F
-] L

Select NTRIP, then click Next:

If the CORS server is a TCP server (also known as
TCPIP, DIP: Direct Internet Protocol, or Point-to-
Point) use the TCP service profile. See [ TCP ] on
Page 173 for additional information.

Pia erfenak ‘-

| DemmsiE

it agage Lum

Fail
2
Fharmzmimi
s
Pigaminil
1§
dgiermne wily crewsscy i CORSHTEF] @l

Set the Network = PDA network to use the cellular
connection of the Android device.

Enter the Domain/IP for the network, either a domain
name or a dotted IPV4 address can be entered.

Set the NTRIP Port (usually 2101.)
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Click on Get Mountpoint to download the
mount table from the network server.

It should take 2 to 15 seconds for the mount table to be
downloaded from the network server:

"-"i

The mount table will be displayed:
Select mounytpoint

AT RTONG

CEIIE_F1T M3

P HFCME

BELG TR

ALET AT

SLC1_ BCAAA

TREELIRE

LA AT

LA BOURN

Select the desired mountpoint (typically a VRS RTCM32 or
RTCM33 mountpoint will be best).

Enter the Username and Password for the NTRIP server:

R ——
Nétmre s

(Lt ]

Dwrrmini i
Lorr g 1T
Pl

Bl g1

GHES WHE WAl FICHT

Linsrams
oY
Puavwond

Ay i rrrmncalty s b OISR EHT ‘

Click Next:
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Configure the advanced Rover settings:

Ehrsnine rrseh

1d -]
Fon i ufpeni fredparscp

il -]

Click Save & Accept to save this new profile and configure
the receiver. After a moment, the receiver will be
configured.

1
Suttiny up matrameei

Carwl
S -
If the network Username and Password are valid then:
Secorsrhil, cheok details?

L]

L

will be shown.

Click No to return to the main menu.

See [ Status ] on Page 95 for additional information on the
Status bar.

This Instrument profile can be selected in the future by
clicking the Instrument select button:

Y 0P Mt e
. L -") L °
o o -
? A0 TURN Nt Moy OC)
boow »
? A0 TURN N Bover B G505
by ; L "
? F) Pose LHIF 45 000

b

Cancel

And clicking the Accept button.
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How to: GNSS Internal UHF Base

Step-by-step RTK receiver configuration as a UHF Base using the internal UHF radio and a Bluetooth connection to the

receiver from the Android device.

Because the base does not utilize any Visual features, a high-speed Wi-Fi connection is not necessary, the Bluetooth

connection may be utilized.

In the USA an FCC license is required for UHF Base mode.

Be sure to connect a UHF antenna to the receiver prior to operating as a base.

e

Configure a reusable Instrument profile for the Base

UHF Base profiles allow a Base receiver to transmit corrections to one or more Rover receivers via UHF radios.

Setup the Base on a stable tripod, attach external power if longer term operation is expected. Turn on the receiver.

From the Main menu, click on the Config (tab) then
Instrument profile:

=

TIRIILETYTEE
> T

The existing, possibly empty, list of Instrument profiles will
be shown:

L kL) - I=afesrnaits prehie

Click on New to create a new instrument profile:

LandStar 8 User Manual

Irasmuamasain

Crra

Click on GNSS base:

d&E aatipiarits pelike

Heimr ity

i T T (= LR e

Q
4]

Match the Brand, Type and Model to your receiver. For the
i93: Brand = CHC, Type = RTK, Model =i93. The Antenna
type should automatically match the correct antenna for
integrated receivers.

Since a Base won’t need high speed data transfer for
camera images, a Bluetooth connection will be fine. Set

CHCN.AV
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Connection type = Bluetooth. If the receiver is not available

in the Target list, click ' Search to find nearby
devices.

When the correct receiver with Bluetooth name = GNSS-

serialnumber is listed, select it o then click Next:

Select Internal Radio:

(L TREE L)
= o
B b wd s =2l

. [Tyl i Fa
Sl sl .

E1 Timowsm vel Aeramb

Heviatt | el dflaib + palFibd a0
T a——

then click Next.
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The Base settings dialog will be shown:
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If all the Rover receivers on the job will be recent CHC
receivers (currently i83, i89, i93, iBase) that support the
CHC516 format, select Differential format = CHC516;
otherwise select Differential format = RTCM3.2:

CHCNAY
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Typically, Protocol = SATEL_3AS, Channel bandwidth = 12.5
KHz, Baud = 9600 and FEC = OFF is best for operation in the
Us.

Set the Transmitting power = 1 W for small sites, 2 W or 5
W (if available on your receiver) will provide better radio
coverage for large sites.

The Channel setting selects the Frequency.

The FCC Call Sign must be broadcast every 15 minutes for
legal operation in the US:

Hel FLC Call 3ign
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Since we are making a general profile, set Start at known
position = Enabled. If the profile is used at an unknown
location, the GNSS Measurement button can be used to
read the current GPS position if needed. If you would like to
always use an autonomous position, set Start at known
position = Disabled.

Always set Start logging = Enabled for Base setups, the
observation files can be submitted to OPUS to obtain or
verify the true Base position. Set Data format = HCN and/or
RINEX = RINEX3.0x to generate suitable files for NGS OPUS.
Interval = 1 Hz is best for processing UAV data against.
Logging duration = 1440 minutes (24 Hours) is reasonable.
Setting the Station name = device_serianumber or a short
Point name helps identify Base and Rover data.

The default Antenna height is best entered as the Vertical
height from the Ground Mark (GM) to the bottom of the
receiver threads. Slant heights can be confusing as there is
a possibility of multiple Slant Height Measurement Points
(SHMP):

Measurement line on Receiver Band.
Top or Bottom of Receiver Band.

Tape hook on offset plate attached under the Receiver.

CHCHN.AV

When all the settings are correct, click on Save & Accept.
The Base Start dialog will be shown:
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Set Add the point to the Point list to Enabled if the receiver
will be read or the location will be snapped from the CAD
drawing.

If you know the Base location coordinates, you can enter
them directly in Northing, Easting, Orthometric Elevation or
Latitude, Longitude, Ellipsoid Height format. See [ Entering /
Viewing Geographic and Projected Coordinates ] on Page
15 for information on coordinate entry and reference
frames.

If the Base location is available in the Point list, click to
recall the point coordinates. Be sure to read the section [
Start from Point list or Previous position ] on Page 241 for
important information on using Base positions in the
Project Point list.

If the Base location is available in the CAD layers, click
to snap the Base position point from the CAD drawing.

To read the current GNSS receiver position (read GPS) click

Measure GNSS to use the current autonomous GPS
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position:

Meosure

S 10s 2 A6s

Arttening hoght

Make sure the Antenna height is correct. Then click on
Start. A receiver not fixed warning may be shown:

Mol Fined, confinue 1o stnie?

Abnil

Click Continue.

A warning about the Hrms / Vrms may be displayed:

Csrrent accuracy sxcends
the peeset tolerances,
waiting for betier accuracy.

Abort

d

Click Continue. The measurement results will be entered.

When the coordinates are correct, click OK:

s P

Lanewd

Start from Point list or Previous position

Click on the Point list button to retrieve a position from
the Point list. By default, previous base positions will not be

LandStar 8 User Manual
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After the Base is configured, the Instrument profile list will

be shown with the new profile:
L LR T L i

a

I

This Instrument profile can be selected in the future by
clicking the Instrument select button:

Then selecting the desired profile from the GNSS Base list:

q U B 40 222

0

When the Android data collector is connected to a Base
receiver, this message:

@ = -

GMEE bawm rresde, &0 rert oee b nre

will be displayed to warn you that you are NOT connected
to a Rover and you should not use the current connection
to store coordinates.

After 10-seconds, the corrections TxRx LED:

should begin to blink amber once each second.

CHCN.AV



available in the list:
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Click on the H 3-Dot button (upper-right corner):

sate type

Mt newpct

Reaet Tiabert vigte

Click on Show GNSS base points. Every previously used Base
point, including CORS network bases will now be shown in
the list:
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Select the previous Base position, or a previously surveyed
or computed point, then click on OK.

How to: GNSS Internal UHF Rover

If the entered position is significantly offset (more than 100
meters or 328 feet) from the receiver’s actual position, an
error message will be displayed:

r al

It is not possible to continue with the base setup with a bad
position. Receivers are unable to numerically generate
corrections if the position is wrong.

This is a common error that occurs when:
Design coordinates are in a different projection than
the LandStar project coordinate system.

Design coordinates are at a O elevation, as shown
above.

The wrong point is chosen from the Point list as a
known starting coordinate.

A negative longitude is entered as a positive longitude.

Easting and Northing are exchanged when hand-
entering a projected position.

If you want to start the base with a position that does not

closely match the actual position, use the Measure
button to start the base with an autonomous GPS position.
Then use the Project: Single point localization to perform a
Site calibration and make the receiver match the desired
coordinates. More details can be found here [ Details:
Project (tab) > Singe point localization ] on Page 68.

If the Base position is acceptable, LandStar will set up the
Base and correction broadcast will begin.

After 10-seconds, the corrections TxRx LED:
f

" ...

should begin to blink amber once each second as
corrections are sent to the radio.

Step-by-step i93 Visual RTK receiver configuration as UHF Rover using the internal UHF radio. The highspeed Wi-Fi
connection between the receiver and the Android data collector is used so that Visual survey functions are avialable.

CHCHN.AV
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Be sure to connect a UHF antenna to the receiver so the radio range will be maximized.

— ﬂ

From the Main menu, click on the Config (tab) then
Instrument profile:

INITETIMTE
> =it ]

The existing, possibly empty, list of Instrument profiles will
be shown:

Ll eSrumernis pirtis

Click on New to create a new instrument profile:

il g
[ e

Click on GNSS Rover.

LandStar 8 User Manual
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Set the Brand = CHC, Type = RTK, Model = i93. If you are
going to use the Visual stakeout or Visual survey
functionality of the i93, you must set the Connection type =
Wi-Fi.
Antenna type should automatically fill to the correct
antenna based on the Model.

The current Wi-Fi connection of the PDA (the Android data
collector) will be shown as the Target. Click the current
connection (IGAGE above) to view the Android device’s
Internet connection menu:

+* 3
internet

N &
Wi-Ei [ »

- G .:E. =l

- GHES-370408F

] | Ve RRIRET A&

When the i93 device serial number appears as GNSS-
serialnumber, click on the receiver entry to connect.

If the receiver is not in the list or the receiver has been
ON for more than 10-minutes without a Wi-Fi
connection, click the receiver’s left button twice to
turn the Wi-Fi back on. (Most CHC receivers disable the
Wi-Fi to save power after 10-minutes of non-use.)
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After a few seconds, the Android device will connect to the m

receover: HTER
GNSS-3704057 ;..
hacteyg b eyt @ - r - [
: Mums
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Don’t worry if a message noting that there is no internet
connection is displayed:

. MR- AT 0E T nas i amiEm

Do not tap the ‘Tap for options’, let this Android warning
box expire automatically.

Click the € Back button to return back to LandStar from
the Internet menu.

Note that the Target Wi-Fi connection is now the GNSS “ “

receiver: . .
RESEE U select Raclo, then click Next.
- R 1B R 1 BT5 B Configure the receiver radio parameters:
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Click Next:

Set the radio Protocol, Channel bandwidth, Baud,
Frequency and FEC to exactly match the Base receiver
settings.

The message type is automatically determined and
matched by the receiver.

Set the Sensitivity = High which will maximize the radio
range on some devices.

As the Rover will be receiving corrections, not transmitting,
disable the FCC Call Sign.

Leave Retransmit correction data = Disabled.
Click Next.
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Additional Rover parameters: Set the Elevation mask to a reasonable value, usually

m between 5 and 15 degrees. Set the Position output

Clesalze b frequency to the desired display update rate.

Click Save & Accept:

Prsibon i frepesey
ES Wait while the receiver is configured:
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It will take a few moments to configure the device.

Once corrections are being received, LandStar may note:

GHNE5 hase coordinates hawe
changed

The TxRx LED:

should blink once each second if corrections are received. If
the receiver is FIXED, the LED will blink green; if the receiver
is not fixed, the LED will blink amber.
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